Manual Guide - Notebook Series | & |l

Thismanual coverstwo notebook series, and this document contains two manuals with information relating to both notebook series. The main difference
between the two notebook seriesisin the appearance asillustrated below. Within each notebook series there are different models (entitled Models A &
B) with different design styles differing in color, general appearance and features supported. Note that your computer may look slightly different from
those pictured throughout either manual, or below. See Appendix D at the end of each manual for full specification details. If you need any assistance
you can contact your distributor/supplier for further help.

Notebook Series | Notebook Series Il
Feature
Model A Model B Model A Model B
15.6" / 39.62cm HD (1366 * 768), | 14.0"/35.56cm HD (1366 * 768), HD+
; : [ : 3. 1600 * 900) 16:9 3.6mm or 3.0mm 15.6” / 39.62cm HD (1366 * 768)
Displa . . 16:9 Panel (Thickness: 3.8mm) ( : _ ,
ype 2 15.6" / 39.62cm FHD (1920 * 1080), For Design | Only: Thick Backlit Panel
16:9 3.4mm thick Backlit Panel Multi Touch Screen
USB 2.0
B One USB 2.0 Port Two USB 2.0 Ports One USB 2.0 Port Two USB 2.0 Ports
. Full Size Isolated Winkey Keyboard . Full Size Isolated Winkey Keyboard
Keyboard A4 Size Isolated Keyboard with Numeric Keypad A4 Size Isolated Keyboard with Numeric Keypad
Model
Appearance







NOTEBOOK SERIESI

V14.1.00






Preface

Notice

The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.

©November 2014

Trademarks
Intel, Pentium and Intel Cor e are trademarks/registered trademarks of Intel Corporation.
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R&TTE Directive
Thisdeviceisin compliance with the essential requirements and other relevant provisions of the R& TTE Direc-
tive 1999/5/EC.

Thisdevice will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Lux-
embourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland,
United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slov-
enia.

ErP Off Mode Power Consumption Statement:
Thefigures below note the power consumption of thiscomputer in compliance with European Commission (EC)
regulations on power consumption in off mode

« Off Mode <0.5W
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CE Marking

This device has been tested to and conforms to the regulatory requirements of the European Union and has at-
tained CE Marking. The CE Mark is a conformity marking consisting of the letters“CE”. The CE Mark applies
to products regulated by certain European health, safety and environmental protection legislation. The CE Mark

is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his
product in the European market.

This product conforms to the essential requirements of the R& TTE directive 1999/5/EC in order to attain CE
Marking. A notified body has determined that this device has properly demonstrated that the requirements of the
directive have been met and hasissued afavorable certificate of expert opinion. As such the device will bear the
notified body number 0560 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product.
Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.
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FCC Statement

(Federal Communications Commission)

Y ou are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limitsfor aClass B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonabl e protection against harmful interferencein
aresidential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, thereisno guarantee that interference will not occur in aparticular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

« Connect the equipment into an outlet on acircuit different from that to which the receiver is connected.
» Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
And

2. This device must accept any interference, including interference that may cause undesired operation of the
device.
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FCC RF Radiation Exposure Statement:

1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator

and your body.

N\ A/
L&
Warning

Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.

If your purchase option includes both Wireless LAN and 3G/4G modules, then the appropriate antennas will be installed.
Note that In order to comply with FCC RF exposure compliance requirements, the antenna must not be co-located or operate
in conjunction with any other antenna or transmitter.

Important Notice - 3G/4G & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3G/4G module and the Bluetooth/Wireless LAN mod-
ules at the same time as this may disrupt radio frequency, and cause interference. When the 3G/4G module is powered on,
make sure that the Bluetooth/Wireless LAN modules are powered off.
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IMPORTANT SAFETY INSTRUCTIONS

Follow basic safety precautions, including those listed bel ow, to reduce therisk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.

4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may
explode. Check with local codes for possible special disposal instructions.

5. This product is intended to be supplied by a Listed Power Unit according to the model's requirements:

Full Range AC/DC Adapter - AC Input 100 - 240V, 50 - 60Hz, DC Output 19V, 2.1A (40W) minimum.

This Computer’s Optical Device is a Laser Class 1 Product

Vi



Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions.

1.

Preface

Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

Do not expose the computer
to any shock or vibration.

surface.

Do not placeit on an unstable

Do not place anything heavy
on the computer.

Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-

aged.

Do not expose it to excessive
heat or direct sunlight.

Do not leaveit in a place
where foreign matter or mois-
ture may affect the system.

Don't use or store the com-
puter in a humid environment.

Do not place the computer on
any surfacethat will block the
Vents/Fan Intakes.

Vi
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Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other
strong magnetic fields. These can hinder proper performance and damage your data.

Follow the proper working procedures for the computer. Shut the computer down properly and don'’t forget

to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

Do not turn off the power
until you properly shut down
all programs.

Do not turn off any peripheral
devices when the computer is
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance
on your computer.

VIiI

Take care when using peripheral devices.

Use only approved brands of
peripherals.

Unplug the power cord before
attaching peripheral devices.




Power Safety

The computer has specific power requirements:

* Only use a power adapter approved for use with this computer.

* Your AC/DC adapter may be designed for international travel but it still requiresa
steady, uninterrupted power supply. If you are unsure of your local power specifications,

consult your service representative or local power company.

» The power adapter may have either a 2-prong or a 3-prong grounded plug. The third
prong is an important safety feature; do not defeat its purpose. If you do not have access

to acompatible outlet, have a qualified electrician install one.

*  When you want to unplug the power cord, be sure to disconnect it by the plug head, not

by itswire.

* Make sure the socket and any extension cord(s) you use can support the total current

load of all the connected devices.

» Before cleaning the computer, make sure it is disconnected from any external power

supplies (i.e. AC/DC adapter or car adapter).

cord if you are wet.

Do not plug in the power

Do not use the power cord if
it is broken.

Do not place heavy objects
on the power cord.

Preface
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Power Safety
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines and

power cord).

You must also remove
your battery in order to
prevent accidentally
turning the machine
on. Before removing
the battery discon-
nect the AC/DC
adapter from the
computer.
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Polymer Battery Precautions
Note the following information which is specific to polymer batteries only, and where applicable, this overrides
the general battery precaution information overleaf.

» Polymer batteries may experience aslight expansion or swelling, however thisis part of the battery’s safety mecha-
nism and is not a cause for concern.

e Use proper handling procedures when using polymer batteries. Do not use polymer batteries in high ambient tempera-
ture environments, and do not store unused batteries for extended periods.

See a'so the general battery precautionary information overleaf for further information.
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Battery Precautions

Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.

Do not remove any batteries from the computer while it is powered on.

Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even
if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly
resultinfire.

If you do not use the battery for an extended period, then remove the battery from the computer for storage.
Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.

Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-
ified service personnel.

Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries
may explode or leak if exposed to fire, or improperly handled or discarded.

K eep the battery away from metal appliances.

Affix tape to the battery contacts before disposing of the battery.

Do not touch the battery contacts with your hands or metal objects.

SN
ALK

Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,
under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
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Cleaning

Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing

Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

*  When the power cord or AC/DC adapter is damaged or frayed.

 If the computer has been exposed to rain or other liquids.

 |If the computer does not work normally when you follow the operating instructions.

 If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
» If thereisan unusual odor, heat or smoke coming from your computer.

S
&
Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before restoring power to the system.

Also note the following when the cover is removed:

e Hazardous moving parts.
* Keep away from moving fan blades.

Xl
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Travel Considerations

Packing
Asyou get ready for your trip, run through this list to make sure the system is ready to go:

Check that the battery pack and any spares are fully charged.

Power off the computer and peripherals.

Close the display panel and make sure it's latched.

Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.

The AC/DC adapter uses voltages from 100 to 240 volts so you won't need a second voltage adapter. However,
check with your travel agent to see if you need any socket adapters.

Put the notebook in its carrying bag and secure it with the bag’s straps.

If you're taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters
and/or cables.

8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both
hardware and software. Make sure your documents are prepared.

SN
ALK

Power Off Before Traveling

agprwbPE

N o

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the vent(s)/fan intake(s)/outlet(s) to be blocked. To prevent your

computer from overheating make sure nothing blocks the vent(s)/fan intake(s)/outlet(s) while the computer is in use.

X1l
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On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these pointsin mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’'t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Bewar e of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
Theserestrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power whereyou can - If an electrical outlet isavailable, usethe AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from acold to awarm location, water vapor can condense inside the computer.
Wait afew minutes before turning it on so that any moisture can evaporate.

XV
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Developing Good Work Habits

Developing good work habitsisimportant if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

Adjust the height of the chair and/or desk so that the keyboard is at or dightly below the level
of your elbow. Keep your forearms, wrists, and hands in arelaxed position.

Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a
footrest if necessary.

Use a chair with aback and adjust it to support your lower back comfortably.

Sit straight so that your knees, hips and elbows form approximately 90-degree angles when
you are working.

Take periodic breaks if you are using the computer for long periods of time.

Remember to:

Alter your posture frequently.

Stretch and exercise your body several times a day.

Take periodic breaks when you work at the computer for long periods of time. Frequent and
short breaks are better than fewer and longer breaks.

XV
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatiguein your neck and
shoulders.

Position the display to avoid glare or reflections from overhead lighting or outside sources of light.

Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
Position the display directly in front of you at a comfortable viewing distance.

Adjust the display-viewing angle to find the best position.

LCD Screen Care

To prevent image per sistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

Set the Windows Power Plansto turn the screen off after afew minutes of screenidle time.

Use arotating, moving or blank screen saver (this prevents an image from being displayed too long).
Rotate desktop background images every few days.

Turn the monitor off when the system isnot in use.

LCD Electro-Plated Logos

Note that in computers featuring araised LCD electro-plated logo, the logo is covered by a protective adhesive.
Due to general wear and tear, this adhesive may deteriorate over time and the exposed logo may develop sharp
edges. Be careful when handling the computer in this case, and avoid touching the raised LCD electro-plated
logo. Avoid placing any other items in the carrying bag which may rub against the top of the computer during
transport. If any such wear and tear develops contact your distributor/supplier.

XVI
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Quick Start Guide

Chapter 1. Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

e Chapter 2 A guideto using some of the main features of the computer e.g. the stor age devices (hard disk,
optical device, card reader), Touchpad/Mouse and Audio.

e Chapter 3  The computer’s power saving options.

e Chapter 4 Theinstalation of the driversand utilities essential to the operation or improvement of some of the
computer’s subsystems.

» Chapter 5  An outline of the computer’s built-in software or BIOS (Basic Input Output System).

» Chapter 6 Instructionsfor upgrading your computer.

e Chapter 7 A quick guide to the computer’s PC Camera, WirelessL AN, Combo Bluetooth & WLAN, TPM
(security), Intel and 3G/4G modules (some of which may be optional depending on your purchase
configuration).

e Chapter 8 A troubleshooting guide.

» Appendix A Definitions of the interface, ports/jackswhich allow your computer to communicate with external
devices.

» Appendix B Information on Control Center.

» Appendix C Information on the video driver controls.

» Appendix D The computer’s specification.

. |
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Advanced Users

If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
torefer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “ Upgrading The Computer” on
page 6 - 1 inthe reminder of the User' sManual. Y ou may also find the notes marked with a# of interest to you.

Beginners and Not-So-Advanced Users

If you are new to computers (or do not have an advanced knowledge of them) then
4 the information contained in the Quick Start Guide should be enough to get you up
Notes and running. Eventually you should try to look through all the documentation (more
Check the light colored detailed descriptions of the functions, setup and system controls are covered in the
boxes with the mark | remainder of the User's Manual), but do not worry if you do not understand every-
above to find detailed in- = thing the first time. Keep this manual nearby and refer to it to learn as you go. You
utors foatiroe. <™ | may find it useful to refer to the notes marked with a s indicated in the margin,
For amore detailed description of any of the interface ports and jacks see “ I nterface

(Ports & Jacks)” on page A - 1.

Warning Boxes

No matter what your level please pay careful attention to the warning and safety information indicated by the
2 symbol. Also please note the safety and handling instructions as indicated in the Preface.

1-2 Overview
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Not Included

Operating Systems (e.g. Windows 8.1) and applications (e.g. word processing, spreadsheet and database pro-
grams) have their own manuals, so please consult the appropriate manuals.

4

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “ Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the com-
puter and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order
listed. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If
your system hasn't been properly configured (your service representative may have already done that for you); refer to
Chapter 4 for installation instructions.

Ports and Jacks

See “Notebook Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your com-
puter to communicate with external devices, connect to the internet etc.

. |
Overview 1 -3
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System Startup

1. Remove all packing materials.

2. Place the computer on a stable surface.

3. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.

4. Attach the AC/DC adapter to the DC-In jack on the left of the computer, then plug the AC power cord into an
outlet, and connect the AC power cord to the AC/DC adapter.

5. Use one hand to raise the lid/LCD to a comfortable viewing angle (do not exceed 130 degrees); use the other

hand (as illustrated in Figure 1 - 1 below) to support the base of the computer (Note: Never lift the computer by
the lid/LCD).

4

(o]
130 Shutdown

Note that you should always
shut your computer down by
choosing the Shut Down
command in Windows (see
page 1 - 32). This will help
prevent hard disk or system
problems.

Figure 1 - 1 - Opening the Lid/LCD & Computer with AC/DC Adapter Plugged-In

L_________________________________________________________________________________________________________________________________________________|
1 -4 System Startup
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System Software

Y our computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find the Windows 8.1 operating system is sup-
ported.

Note: In order to run Windows without limitations or decreased performance, your computer requires a mini-
mum 1GB of system memory (RAM).

4

Windows Versions

Note that the information included on the following pages is for Windows 8.1 only.

Windows OS

In order to run Windows 8.1 (64 bit) without limitations or decreased performance, your computer requires a minimum
2GB of system memory (RAM).

System Startup 1 -5
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Model Differences

This notebook series includes two different model types that mainly differ asindicated in the table below. Note that
your model may appear slightly different from those pictured in this manual (see Appendix D for full details).

Feature Model A Model B
15.6"/ 39.62cm HD (1366 * 768), 16:9 Panel
ispiay 14.0" / 35.56cm HD (1366 * 768), 16:9 3.6mm thick (Th'c"“e;;: 3.8mm)
Backlit Panel 15.6" / 39.62cm FHD (1920 * 1080), 16:9 3.4mm
thick Backlit Panel
e A4 Size Isolated Keyboard Full Size Isolated Winkey Keyboard with Numeric
Keypad
USB 2.0 Ports One USB 2.0 Port Two USB 2.0 Ports
Other See “Dimensions & Weight” on page D - 4

Table 1 - 1 - Model Differences

1 -6 System Startup
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System Map: LCD Panel Open - Model A Figure 1- 2
9 e e n/_ LCD Panel Open -

Y Model A

Wireless Device Built-in PC Camera
Operation Aboard (Optional)

Aircraft

=

2. PC Camera LED
(4] The use of any portable 3. Built-In Microphone
electronic  transmission 4. LCD
devices aboard aircraft is 5. Power Button
usually prohibited. Make 6. Keyboard
sure the WLAN, Blue- 7. Touchpad &
tooth and 3G/4G mod- Buttons
ule(s) are OFF if you are
@ using the computer

aboard aircraft by putting

the system in to Airplane

@ Mode (see

) o

Touchpad Buttons
e (valid operation area)

Note that the Touchpad and

Buttons valid operational area
Note that the Touchpad and But- is that indicated within the red

tons valid operational area is that indicated within the red dotted lines indicated on the right. dotted lines indicated.

System Map: LCD Panel Open - Model A 1-7
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Figure 1 -3
LCD Panel Open -
Model B

1. Built-in PC Camera
(Optional)

PC Camera LED
Built-In Microphone
LCD

Power Button
Keyboard
Touchpad &
Buttons

Noogkwd

Touchpad Buttons
(valid operation area)

Note that the Touchpad and
Buttons valid operational area
is that indicated within the red
dotted lines indicated.

System Map: LCD Panel Open - Model B

e 0 o

1 - 8 System Map: LCD Panel Open - Model B

AN
&
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic  transmission
devices aboard aircraft is
usually prohibited. Make

sure the WLAN, Blue-
tooth and 3G/4G mod-
ule(s) are OFF if you are
using the  computer
aboard aircraft by putting
the system in to Airplane
Mode (see

).
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LED Indicators

The LED indicators on the computer display helpful information about the current status of the computer.

Icon Color Description
Orange DC Power is Plugged In
Green The Computer is On
Blinking Green The Computer is in Sleep Mode

Slow (20 second intervals)

o The Computer is in Sleep Mode and *Intel Smart Connect is Enabled
Blinking Green

Orange The Battery is Charging
Green The Battery is Fully Charged
Blinking Orange The Battery Has Reached Critically Low Power Status
Green Airplane Mode is ON (the WLAN, Bluetooth & 3G Modules are OFF)
Green Hard Disk Activity

Table 1 -2 - LED Indicators

*Intel® Smart Connect Technology is enabled by default to periodically, and briefly, wake the computer from Seep mode
in order to check email applications etc. Only certain Intel WLAN modules support this feature (see “ Intel® Smart Con-
nect Technology” on page 6 - 23 for more information).

LED Indicators 1 -9
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4

Other Keyboards

Keyboard - Model A

The keyboard has an embedded numerical keypad for easy numeric data input, and
function keys to change operational features instantly.
If your keyboard is dam-

aged or you just want to |
make a change, you can
use any standard USB
keyboard. The system will

detect and enable it auto- Play/Pause Key

matically. However spe-

cial  functions/hot-keys Numerical Keypad

unique to the system'’s
regular keyboard may not

work.

NumLk & ScrLk

NumLk &
ScrLk Keys

Windows Logo Key
Hold down the Fn Key 1
and either NumLk or Menu/Application Key

ScrLk to enable number .
or scroll lock, and check Figure 1 - 4 - Keyboard - Model A

the LED indicator for sta-

tus. 4

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLKk is on.

1-10Keyboard - Model A



Keyboard - Model B

The keyboard has an embedded numerical keypad for easy numeric data input, and
function keys to change operational features instantly.

| |

NumLk &
ScrLk Keys

Numerical Keypad

Play/Pause Key

| Windows Logo Key

]

Menu/Application Key

Figure 1 - 5 - Keyboard - Model B

4

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLKk is on.

Keyboard - Model B 1 - 11
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4

Other Keyboards

If your keyboard is dam-
aged or you just want to
make a change, you can
use any standard USB
keyboard. The system will
detect and enable it auto-
matically. However spe-
cial  functions/hot-keys
unique to the system'’s
regular keyboard may not
work.

NumLk & ScrLk

Hold down the Fn Key
and either NumLk or
ScrLk to enable number
or scroll lock, and check
the LED indicator for sta-
tus.
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4

Windows Logo
Keyboard Shortcut

Use the Windows logo
key 3@ + D key com-
bination to switch be-
tween the Start screen
and Windows Desktop.

Menu/Application
Keyboard Shortcut

When the Desktop app
iS running you can use
the Menu/Application
key [E] on the key-
board to display the
context menu as per a
mouse right-click. In
the Start screen this
function is useful to
quickly display the All
Apps icon.

Keyboard Shortcuts

The following Windows Logo Key (Winkey) keyboard shortcuts are useful for navi-

gation/operation in Windows 8.1.

Windows Logo Deseriilan

a8 Key +

Tap Winkey Toggle between the Startvifng)r;vznggzEtf;)Fr)emost running app or the
C Display Charms menu
D Switch to the Windows Desktop and toggle show Desktop
E Switch to the Windows desktop andllaunch Windows Explorer with

Computer displayed

F Display file Search
| Open the Settings charm
K Open the Connect charm
L Lock the computer and display the Lock screen
P Display the Second Screen menu (see Figure 1 - 19 on page 1 - 29)
R Switch to the Windows Desktop and display the Run dialog box
z Access the Customize Bar (see Figure 1 - 14 on page 1 - 24)

Table 1 - 3 - Keyboard Shortcuts

1-12 Keyboard - Model B
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Function/Hot Key Indicators

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition
to the basic function key combinations; visual indicators are available when the hot key utility isinstalled.

Keys Function Keys Function
Fn + Play/Pause (in Audio/Video Programs) Fn + Brightness Decrease/Increase
Fan Control Toggle PC Camera
Fn+ Automatic Fan Control / Full Fn+ Power Toggle
Power
Airplane Mode
Fn +
Fn + TouchPad Toggle Toggle

Turn LCD Backlight Off

Fn+ (Press a key to or use TouchPad to turn on) Fn + Sleep Toggle
Fn+ Mute Toggle Fn + NumLk Nun_lﬂ_'gg&';“k
Fn+ Volume Decrease/Increase Fn + ScrLk SC‘Ir'glgl]gLIZCk
Fn + Display Toggle Caps Lock Cz.il.zzgg(;k
Fn + Toggle Baotrtsroyﬁcharging Fn + Esc Control Center Toggle

Table 1 - 4 - Function & Hot Key Indicators

Function/Hot Key Indicators 1 - 13
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Control Center

When in the Windows Desktop application (not in the Start screen) press the Fn + Esc key combination, or
double-click theicon  inthenactification area of thetaskbar to toggle the Control Center on/off. The Con-
trol Center givesquick accessto frequently used controls and enables you to quickly turn the camera/touch pad
on/off (see Appendix B for full details).

4

Control Center Access

To run the Con-
trol Center
press the Fn +
Esc key combi-
nation, or dou-
ble-click the
icon in the

notification area
of the taskbar.

Close the Control Center by clicking
the close icon in the top right of
the panel (move the cursor onto the
top right corner of the panel to high-
light it).

Figure 1 - 6 - Control Center

1 - 14 Control Center
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System Map: Front & Left Views Figure 1- 7

Front & Left Views

0 1. LED Indicators
9 2.  Multi-in-1 Card
Reader
3. DC-InJack

4, RJ-45 LAN Jack
5. External Monitor

Port
6. Vent/Fan Intake/
Outlet
Multi-In-1 Card Reader 7. HDMI-Out Port

8. 2*USB 3.0 Ports

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / RS MMC
SD (Secure Digital) / Mini SD / SDHC / SDXC
MS (Memaory Stick) / MS Pro / MS Duo

USB 3.0 Port OR USB 2.0 Port

This model includes 2 * USB 3.0 ports on the left side of the computer. USB 3.0 ports are
denoted by their blue color; USB 2.0 ports are colored black.

System Map: Front & Left Views 1 - 15
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Figure 1- 8 System Map: Right & Rear Views

Right & Rear Views
1. Microphone-In

Jack
2. Headphone-Out @ 9 9 e 6

Jack
3. 1*USB 2.0 Port

(Model A)

OR o0 © 6 o (5

2 *USB 2.0 Ports

(Model B)

4. Optical Device @

Drive Bay (for CD/
DVD Device)
Security Lock Slot
6. Battery e

o

Battery Information

Always completely discharge, then fully charge, a new battery before using it. Completely
discharge and charge the battery at least once every 30 days or after about 20 partial dis-
charges.

.|
1-16 System Map: Right & Rear Views
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Disk Eject Warning

Don't try to eject a CD/DVD while the system is
accessing it. This may cause the system to
“crash”. Stop the disk first then eject it, or press
the stop button twice.

CD/DVD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due
to an unexpected power interruption) you may
push the end of a straightened paper clip into the
emergency eject hole. Do not use a sharpened
pencil or any object that may break and become
lodged in the hole. Don't try to remove a floppy
disk/CD/DVD while the system is accessing it.
This may cause the system to “crash”.

Quick Start Guide

4

Changing DVD Regional Codes

Go to the Control Panel and double-click
Device Manager (Hardware and Sound),
then click the + next to DVD/CD-ROM
drives. Double-click on the DVD-ROM de-
vice to bring up the Properties dialog box,
and select the DVD Region (tab) to bring
up the control panel to allow you to adjust
the regional code.

DVD region detection is device dependent,
not OS-dependent. You can select your
module’s region code 5 times. The fifth se-
lection is permanent. This cannot be al-
tered even if you change your operating
system or you use the module in another
computer.

System Map: Right & Rear Views 1 - 17
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Figure 1- 9 System Map: Bottom View - Model A

Bottom View

Model A o
1. Battery
2. Component Bay
Cover
3.  Vent/Fan Intake/
Outlet
4. Hard Disk Bay e 9
Cover
5. Speakers

CPU

The CPU is not a user
serviceable part.

Battery Removal

We recommend that you

do not remove the battery

yourself. If you do need .

to remove the battery for Overheating

any reason (e.g. long To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake
term storage) see page while the computer is in use.

1-18 System Map: Bottom View - Model A
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System Map: Bottom View - Model B Figure 1 - 10
Bottom View
o Model B

1. Battery

2. Component Bay
Cover

9 3.  Vent/Fan Intake/

Outlet

4. Hard Disk Bay
Cover

5. Speakers

CPU

The CPU is not a user
serviceable part.

Battery Removal
We recommend that you

;IX: do not remove the battery

. yourself. If you do need

Overheating to remove the battery for

To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake any reason (e.g. long
while the computer is in use. term storage) see page

System Map: Bottom View - Model B 1 - 19
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Windows 8.1 Control Panel

4
, _ Throughout this manual you will see an instruction to open the Control Panel.
Windows Versions £ pjght-click the lower left hot corner to bring up the context menu (or use the Win-
Note that the informa- || dowsLogo Key @ + X key combination) and select Control Panel in both the

tion included on the fol- Desktop app or Start screen.
lowing pages is for the
latest updated version

of Windows 8.1 only.

Make sure you enable

Windows Update in or- Desktop app
der to get all the latest

security updates etc.

(see “Windows Up-

date” on page 4 - 8).

O~ <

Figure 1 - 11 - Windows Context Menu

1-20 Windows 8.1 Control Panel
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The Control Panel can be accessed in a number of waysin Windows 8.1.
» Click Search inthe Windows Charms Bar (see previous page) and the search pane will pop out. Type
Control Panel and select it from the results to the left.

* Click on ThisPC (in Apps, or you canto pin This PC to the Start screen), click on Computer in the
top menu and select Open Control Panel from the ribbon.

* When in the Desktop app (this does not apply to the Start screen) click on Settingsin the Windows
Charms Bar and select Control Panel from the menu.

* Click thearrow at the bottom of the Start screen and click Control Panel in Apps (Windows System).
* Right-click the Start button to bring up the menu and select Control Panel (see Figure1- 12 on page 1
- 22).

4

Keyboard Shortcut to Control Panel

You can also use keyboard shortcuts to access the Control Panel. Press the Windows logo key == and X to bring up
the context menu, and then press P to bring up the Control Panel. Alternatively press the Windows logo key == and R
to bring up the Run dialog box, and then type “Control Panel” and press Enter to access the Control Panel.
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Right-click the Start button in the Desktop app (or use the Windows Logo Key

4 28 + X key combination) to bring up an advanced context menu of useful features
Display Most such as Control Panel, Programs and Features, Power Options, Task Manager,
Recently Used Search, File Explorer, Command Prompt, Device Manager and Network Connec-

Apps tions etc.

If you are in the Start
screen, Desktop or an
app you can move your
mouse to the upper left
corner of the screen to

get back to the most re-
cently used app.

To view all the most re-
cently used Apps hover
over the top left of the
screen and then move
the mouse down along
the left side of the
screen to display the
list.

Move the mouse to the bottom left of the screen
and right-click the Start button to access the menu.

Figure 1 - 12 - Advanced Context Menu (Right-Click Start Button)
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Quick Start Guide
Windows 8.1 Start Screen & Desktop

The Apps, control panels, utilities and programs within Windows are accessed from the Start screen and/or
Windows Desktop app. The Desktop (which runsasan app within the Start screen) can be accessed by clicking
the Desktop item in the Start screen (or by using the Windows L ogo Key g@ + D key combination). Click the
arrow at the bottom of the Start screen to access Apps.

Figure 1 - 13 - Windows Start Screen
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Apps & Tiles

The Start screen will contain a number of apps, and many more will be installed as you add more applications
etc. Not all of these apps can fit on one screen so you will often need use the dlider at the bottom of the screen
in order to view all the necessary Apps.

Accessing Pining/Unpinning All Apps

Y ou can add and remove thetiles for apps and control panelsin the Start screen. Right-click on an app to bring
up the context menu and you pin the App to (or unpin from) the Start screen, or to the taskbar.

Figure 1 - 14 - Apps
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Desktop Application

When the Desktop app is running (click the app in the Start screen or use the Windows Logo Key g@ + D key
combination) you can use lower left hot corner to switch between the Start screen and the Windows Desktop
app. To do so move your mouse to hover over the bottom left corner of the Desktop app and left-click.

Move the mouse to the bottom left of the screen and click to switch
back to the Start screen.

Figure 1 - 15 - Desktop

.|
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The Charms Bar

Theright side of the screen (Start or Desktop) displaysthe CharmsBar. The CharmsBar containsthe Sear ch,
Share, Start, Devicesand Settings menus. To access up the Charms Bar move the cursor to the upper or lower
right corners of the screen, and then hover over one of the itemsin the Charms Bar to activate it (the bar will
be black when it is active), or use the Windows L ogo Key g@ + C key combination.

Figure 1 - 16 - Start Screen with Charms Bar
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Charms Bar Items

Search E: You can search for any file, application, Apps and control panel settings with instantaneous
results.

Share @) This button is used to share information with people viamail or social networks.

Sart .: Click to bring up the Start screen (the same function as pressing the Windows Logo Key or click-
ing the bottom left of the screen).

Devices B3] Click this button to change connected peripheral device settings e.g. an external display.

SettingsE]: This button gives instant access to the computer settings, such as Network, Audio, Notifica-
tions, Power and Keyboard (click Change PC Settingsto activate the PC Settings menu).

4

Charms Bar - Touchpad Access
To quick access the Charms Bar using the Touchpad:

1. Place your finger off the Touchpad (slightly to the right of the
pad resting on the computer).

2. Move your finger across to the left on to the Touchpad.

3. The Charms Bar will then pop-up.

Figure 1 - 17 - Settings Menu
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Windows 8.1 Taskbar

In many instances throughout this manual you will see an instruction to access the notification ar ea of the task-
bar (system tray). In Windows 8.1 the taskbar can be directly accessed from the Desktop application; if you
arein the Start screen you will need to move the cursor to the bottom of the screen to display the taskbar.

The taskbar is displayed at the bottom of the screen, and you can see the notification area (system tray) of the
taskbar in the bottom right of the screen. Some of the control panels and applications referred to during the
course of this manual can be accessed from here.

Figure 1 - 18 - Taskbar & Notification Area (System Tray)

Y ou can pin/unpin appsto/from the taskbar in much the same way asyou can to the Start screen (see“ Accessing
Pining/Unpinning All Apps’ on page 1 - 24).
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Video Features

Y ou can switch display devices, and configure display options, from the Display control panel (in Appear ances
and Personalization) in Windows when running the Desktop app (see “ Desktop Application” on page 1 - 25
and Appendix C). It is possible to quickly configure external displays from the Devices menu item in the
CharmsBar (see“The CharmsBar” on page 1 - 26).

To Configure Displays from Devices (Charms Bar):

1. Attach your display to the appropriate port, and turn it on.

2. Gothe Charms Bar, select Devices.

3. Click Project (you may need to click Second Screen).

4. Click on any one of the options from the menu to select PC screen only, Duplicate, Extend or Second screen
only.

Figure 1 - 19- Devices (Project)
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To access Display (Control Panel) and Screen Resolution in Windows 8:
1. Gotothe Control Panel.

2. Click Display (icon) - In the Appearance and Personalization category.
3. Adjust resolution.

4

Right-Click Desktop
App

You can right-click
the desktop and
select Screen reso-
lution @ (Figure 1 -
0 @ 20).
. Use the dropbox to
select the screen
[3) Resolution @
(Figure 1 - 20).
Click Advanced
settings @ (Figure
1 - 20) to bring up the
Advanced
properties tabs.

Figure 1 - 20 - Screen Resolution
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To access the I ntel (R) HD Graphics Control Panel:

1. Click Advanced settings @ (Figure 1 - 20 on page 1 - 30) in the Screen Resolution control panel in Win-
2. dC(I)i(\;\LSt.he Intel(R)... tab and click Graphics Properties (button) @ (Figure 1 - 21 on page 1 - 31) .

SR Right-click the desktop and select Graphics Properties from the menu.

El).R Click the icon in the notification area of the Desktop taskbar and select Graphics Properties from the menu.

Figure 1 - 21 - Intel Graphics Control Panel
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Power Options

Power Options (Hardwar e and Sound) can be accessed from the Control Panel. The Power Menu itemin Set-
tingsin the Charms Bar in Windows 8.1 may be used to Shut down or Restart (you can also add Hiber nate/
Sleep to the menu - see “ Adding Hibernate/Sleep to the Power Menu” on page 3 - 10). You can also use the
context menu (Shut down or sign out) shut the computer down/restart etc.

Power Button Start Screen Desktop App Start Screen

Charms Bar

> O

Figure 1 - 22 - Shut Down/Restart
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Running Apps
To run appsin Windows 8.1 you will need to check that the Screen Resolution and User Account Contr ol Set-
tings are compatible with the system requirements.

Screen Resolution Settings

1. Switch to the Windows Desktop (click the app or use the Windows logo key &@ + D key combination).

2. Right-click a blank area of the Windows Desktop and select Screen Resolution. Adjust the Resolution to
make sure that it is at least 1024 * 768, although preferably 1366 * 768 or above (see sidebar).

Screen Resolution for Apps
(Windows 8.1)

The minimum resolution in which Apps will run is 1024x768.

The minimum resolution required to support all the features of
| 1 Windows 8 (including multitasking with snap) is 1366x768.

These specs are the minimum screen resolution that supports
all the features of Windows 8.1 on a useful physical size.

Figure 1 - 23 - Screen Resolution

.|
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User Account Control Settings

If your computer meets the minimum screen resol ution requirements, and still you can't run apps, then that you
have to check the status of User Account Control (UAC). Apps may fail to open when the UAC is turned off.
To check whether the UAC is on or off, follow the instructions below.

1. Open the Control Panel.

2. Click on User Accounts and then click on Change User Account Control settings (or click System and
Security and click Change User Account Control Settings under Action Center).

3. Ifthe slider is in the Never notify position, then the UAC is disabled.

4. To enable or turn on the UAC, move the slider to Always notify or Notify me when apps try to make changes
to my computer (default) position, and then click OK.

Figure 1 - 24 - User Account Control

.|
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Features & Components

Chapter 2. Features & Components

Overview

Read this chapter to learn more about the following main features and components
of the computer:

Hard Disk Drive/Solid State Drive
Optical (CD/DVD) Device
Multi-In-1 Card Reader

TouchPad and Buttons/Mouse
Audio Features

. |
Overview 2 - 1
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e Hard Disk Drive/Solid State Drive

T - The hard disk drive is used to store your data in the computer. The hard disk can be
Removal Warning taken out to accommodate other serial (SATA) hard disk drives, however you will
need to contact your distributor/supplier to do this in order to avoid violating the

SRR terms of your warranty. The system can also support solid state drives as storage de-

er(s) and /or screw(s) for

s e e f Vices (see” Storage” on page D - 2 for specification information).

upgrade as this may vio-
late the terms of your

warranty.

If you need to replace/
remove the hard disk for
any reason, please con-
tact your distributor/sup-
plier for further
information.

2 - 2 Hard Disk Drive/Solid State Drive
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Optical (CD/DVD) Device

4
Thereisabay for a5.25" optical (CD/DVD) device (9.5mm height). The actual de-
vice will depend on the module you purchased (see “ Storage” on page D - 2). The SOA‘(’jrj‘Ss\t/;':nTe

optical device is usually labeled “Drive D:” and may be used as a boot device if

properly set inthe BIOS (see “Boot Menu” on page 5 - 14). How high the sound vol-
ume can be set depends

- - on the setting of the vol-
Loadmg Discs ume control within Win-

Toinsert aCD/DVD, press the open button @ and carefully placeaCD/DVD onto | dows. Click the Volume
the disc tray with label-side facing up (usejust enough force for thedisctoclick onto || icon on the taskbar to
the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks’ and you fgecdk. theF Sf“'”g" ==
are ready to start. The busy indicator @ will light up while data is being accessed, pa;elg- 12)6_1 drest on
or while an audio/video CD, or DVD, isplaying. If power isunexpectedly interrupt-
ed, insert an object such as a straightened paper clip into the emergency gject hole

© toopenthetray. Figure2-1

Optical Device

Optical (CD/DVD) Device 2 - 3
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Handling CDs or DVDs

7\[:1'( Proper handling of your CDS/DVDs will prevent them from being damaged. Please
follow the advice bel ow to make sure that the data stored on your CDS/DV Ds can be

CD Emergency Eject
accessed.

If you need to manually

SEei R RETERCRE - Note the following:

an unexpected power

LIEER RS GIER EVAl  » Hold the CD or DVD by the edges; do not touch the surface of the disc.
EERER I ESE o Use aclean, soft, dry cloth to remove dust or fingerprints.
f;{g'g::i?ﬁgrgg?grejﬂg « Do not write on the surface with a pen.

T EENEE e ¢ Do not attach paper or other materials to the surface of the disc.
SNeRRTEEE R ET Rl o Do not store or place the CD or DVD in high-temperature areas.
SRS EIEE o Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
SRS EECS . Do not bend the CD or DVD.

db lodged i .
ﬁ]ne hoﬁfome =S8 . Donot drop or subject the CD or DVD to shock.

Disk Eject Warning

Don't try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.

.|
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DVD Regional Codes

To change the DVD regional codes: Z

1. Go to the Control Panel DVD Region Note
2. Double-click Device Manager (Hardware and Sound), then click the + next to DVD region detection is
DVD/CD-ROM drives. device dependent, not
3. Double-click on the DVD-ROM device to bring up the Properties dialog box, and 0S-dependent. You can
select the DVD Region (tab) to bring up the control panel to allow you to adjust the select your module’s re-
regional code. gion code 5 times. The
) fifth selection is perma-
* Region 1-USA & Canada nent. This cannot be al-

« Region 2 - Western Europe, Japan tered even if you change
' ’ your operating system

South Africa, Middle East & Egypt ST LEE e e i
* Region 3- South-East Asia, Taiwan, another computer.
South Korea, The Philippines, Indo-
nesia, Hong Kong
* Region 4 - South & Central Amer-
ica, Mexico, Australia, New Zealand
* Region 5- N Korea, Russia, Eastern
Europe, India& Most of Africa _
+ Region 6 - China Figure2- 2
DVD Region Codes
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1.

Figure2- 3
Front View

Card Reader

Multi-In-1 Card Reader

The card reader alows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the card reader driver (see
“ CardReader” on page 4 - 6.

« MMC (MultiMediaCard) / RSMMC
» SD (Secure Digital) / Mini SD / SDHC / SDXC
* MS(Memory Stick) / MSPro/ MS Duo

Note: Some of these cards require PC adapters that are usually supplied with the
cards.

2 - 6 Multi-In-1 Card Reader
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TouchPad and Buttons/Mouse

The TouchPad is an alternative to the mouse; however, you can also add a mouse to _
your computer through one of the USB ports. The TouchPad buttons function in Mouse Driver
much the same way as a two-button mouse. If you are using an ex-

ternal mouse your op-
erating system may be
able to auto-configure

your mouse during its
installation or only en-
able its basic functions.
Be sure to check the
device’'s user docu-
mentation for details.

TouchPad and Buttons/Mouse 2 - 7
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4

TouchPad Scrolling

This computer model se-
ries may feature different
TouchPad versions.

These TouchPads may
differ in their vertical
scrolling function in most
scrollable windows.

Some TouchPads require
sliding the finger up and
down on the right of the
TouchPad to scroll the
window. Other versions
require  tapping/holding
down the finger at the top
right or bottom right of the
TouchPad to scroll the
window.

Figure2-4
Mouse Properties

Once you have installed the TouchPad driver (see “ Touchpad” on page 4 - 6) you
can configure the functions from the Mouse control panel in Windows, or by double-
clicking the TouchPad driver icon  in the notification area of the taskbar in the
Desktop app. You may then configure the TouchPad tapping, buttons, scrolling,
pointer motion and sensitivity optionsto your preferences. Y ou will find further in-
formation at www.synaptics.com.
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Gestures and Device Settings

The Synaptics Gestures Suite application allows you to use a specific gesture (ac-
tion) on the surface of the Touchpad to perform specific actions to manipul ate doc-

uments, objects and applications.

Y ou can configure the settings from the Device Settings tab in M ouse Properties:

1.

2.
3.
4,

TouchPad and Buttons/Mouse 2 - 9

Go to the Control Panel.

Click Mouse (Hardware and Sound).

Click Device Settings (tab) and click Settings.

Use the menu tree on the left to access the user configurable settings.

Features & Components

4

Show Video

You can get a clearer
view of the gestures in-
volved by clicking the
Show Video option for
each gesture item.

Select the gesture (Pinch
Zoom, Rotating, Three
Fingers Down and
Three Finger Flick) in the
Device Settings > Set-
tings left tree menu

and click the Show Video
button to see the demon-
stration video.

For more details on any of
the gestures see the help
in the lower part of the
right menu window.

Figure2-5
Mouse Properties -
Device Settings
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Disabling the Touchpad

If you need to disable the Touchpad for any reason (e.g. you may find that when us-
ing the computer’s internal keyboard you accidentally trigger the Touchpad when
resting your wrists or palmson it) you can do so by using Fn + F1 key combination.

Y ou can also set the system to automatically disable the internal Touchpad when an
external USB point device (e.g aUSB mouse) is attached.

1. Go to the Mouse Properties control panel.

2. Click to select Device Settings (tab).

3. Click to place a check in the “Disable internal pointing device when external
USB pointing device is attached” check box.

4. Click OK to save the setting.

Figure2-6
Mouse Properties
(Disable Touchpad)

. |
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PalmCheck™

The PalmCheck™ feature (Device Settings > Settings > Pointing > Sensitivity) ﬁ
helps prevent operating the Clickpad/Touchpad by accident, by recognizing when PalmCheck™
your palmisresting on it or brushing its surface while you are typing. In order to improve

Clickpad/Touchpad

scrolling responsive-
ness when using one-
finger scrolling, you can
adjust the PalmCheck™

slider towards “Mini-
mum” as per your pref-
erence.

However bear in mind
that adjusting the slider
too far towards “Mini-
mum” can turn off Palm-
Check™ altogether.

Figure2-7
PalmCheck™ Slider
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Scrolling

The Two-Finger scrolling feature works in most scrollable windows and allows you
to scroll horizontally and verticaly. Place two fingers, slightly separated, on the
TouchPad surface and slide both fingers in the direction required (in a straight con-
tinuous motion).

Figure2-8
Scrolling Gesture

Zooming

The Pinch Zoom gesture can be used to perform the same function as a scroll wheel
in Windows applications that support CTRL + scroll wheel zoom functionality.
Place two fingers on the TouchPad (for best results use the tips of the fingers) and
dlide them apart to zoom in, or closer together to zoom out.

Figure2-9

Zooming Gesture
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Rotating

Use the Pivot Rotate gesture to rotate objects (e.g. photos) in 90 degree increments.
Place a finger down on the left “target” zone and keep it stationary. Place another
finger near the middle of the TouchPad and slide it in a circular motion around the
stationary finger (clockwise or counterclockwise) to rotate the object.

Figure2 - 10
Rotating Gesture

Three Finger-Flick/Three Fingers Down (Press)

The Three Finger-Flick gesture may be used to enhance navigation with avariety of
applications such as browsing the Internet or scrolling through a photo viewer. The
Three Fingers Down gesture may be used to launch user-sel ectable applications.

Figure2-11
Flick/Press
Gesture

. |
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= Audio Features
_ Y ou can configure the audio options on your computer from the Sound  control
Volume Adjustment panel in Windows, or from the Realtek HD Audio Manager Ejj icon in the taskbar
The sound volume level

: notification area/control panel (right-click the taskbar notification area icon gjj to
can be set using the vol- bri di Th | also be adiusted b f th i
ume control in. the Set- ring up an audio menu). The volume may also be adju y means of thevolume

tings menu in the || iconinthetaskbar or theaudio sider in the Settings menu (see sidebar).
Charms Bar.

Right-click the icon
to access the menu
above.

Figure2- 12
Realtek Audio
Manager
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Setup for Audio Recording

To record audio sources on your computer at optimum quality follow the instruc-
tions below:

1. Go to the Control Panel.

2. Click Realtek HD Audio Manager (Hardware and Sound), or right-click the
taskbar icon ﬂ and select Sound Manager.

3. Click Microphone Effects (tab) in Microphone (tab), and then click to select
Noise Suppression (button), or adjust the Recording Volume level to around 60,
to obtain the optimum recording quality.

4. Click OK to close the control panel and save the settings.

Figure2- 13
Realtek Audio
Manager -
Recording Setup

. |
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Power Management

Chapter 3. Power Management P

Overview OS Note

To conserve power, especially when using the battery, your computer power man- | Power  management

. . functions will vary slight-
agement conserves power by controlling individual components of the computer ly depending on_ your

(the monitor and hard disk drive) or the whole system. This chapter covers: operating system. For
more information it is
¢ The Power Sources best to refer to the user’s

manual of your operat-

* Turning On the Computer :
ing system.

» Power Plans

» Power-Saving States

» Configuring the Power Buttons
» Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OSto set devicesinto low-power states based on user set-
tings and information from applications.

. |
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4

Forced Off

If the system “hangs”,
and the Ctrl + Alt + Del
key combination doesn’t
work, press the power
button for 4 seconds, or
longer, to force the sys-
tem to turn itself off.

The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter

Useonly the AC/DC adapter that comeswith your computer. Thewrong type of AC/
DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack on the left of the computer.

2. Plug the AC power cord into an outlet, and connect the AC power cord to the AC/
DC adapter (make sure you use the adapter when first setting up the
computer, as to safeguard the computer during shipping the battery will be locked
to not power the system until first connected to the AC/DC adapter).

3. Raise the lid/LCD to a comfortable viewing angle.

4. Press the power button to turn “On”.

Battery

The battery allows you to use your computer while you are on the road or when an
electrical outlet isunavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely beforerecharging (see “ Battery FAQ” on page 3 - 18).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “ Battery Information” on page 3 - 14.

3 - 2 The Power Sources
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Turning On the Computer

Now you are ready to begin using your computer. To turnit on simply pressthe pow-

er button on the front panel.
When the computer is on, you can use the power button as a Stand by/Hibernate/
Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and
holding the power button for longer than this will shut the computer down). Use

Power Options (Hardware and Sound) in the Windows control panel to configure
this feature.

4

Power Button as Stand by or Hibernate Button

You can use the OS's “Power Options” control panel to set the power button to send the
system into Stand by or Hibernate mode (see your OS’s documentation, or “Configuring
the Power Buttons” on page 3 - 9 for details).

Turning On the Computer 3 - 3
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Shutting the Computer Down

Note that you should always shut your computer down by choosing the Shut down

command asthiswill help prevent hard disk or system problems. Use the Shut down
or sign out item in the Context M enu (right-click the lower left corner of the screen
to bring up the menu).

Y ou can also use the Power M enu in Settingsin the Windows CharmsBar. If you
want to add Hibernate/Sleep to the Power Menu see“ Adding Hibernate/Sleep to the
Power Menu” on page 3 - 10.

Charms Bar Desktop App Start Screen

Figure3-1
Shut Down/Restart

3 - 4 Shutting the Computer Down
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Power Plans

The computer can be configured to conserve power by means of power plans. You

4

can use (or modify) an existing power plan, or create a new one. Resuming
Operation

The settings may be adjusted to set the display to turn off after a specified time, and

to send the computer into Sleep after a period of inactivity. <50 TEBEE = b o

page 3 - 11 for informa-

. . . . tion on how to resume
Click Change plan settings and then click Change advanced power settingstoac- | ('~ SRR

cess further configuration options in Advanced Settings. .

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

o > Figure3-2
Power Plan
Advanced Settings

Power Plans 3 - 5
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Figure3-3

Power Plans

Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. Thisisworth bearing in mind if you are experiencing
any reduced performance (especialy under DC/battery power).

Choose High perfor mance (you may need to click Show additional plansto view
the High performance plan) for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered.

Click to Show/Hide
additional
power plans

3 - 6 Power Plans



Power-Saving States

Y ou can use power-saving states to stop the computer’ s operation and restart where
you left off. Windows uses the Sleep, Hibernate and Shut Down power-saving
states.

Sleep

In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power.

The PC wakes from Sleep within seconds and will return you to where you last | eft
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.

To add Sleep to the Power Menu see “Adding Hibernate/Sleep to the Power
Menu” on page 3 - 10.

.|
Power-Saving States 3 - 7
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Wake On LAN
Support

Wake-On-LAN is only
supported from Sleep or
Hibernate states in
Windows.

If you require your com-
puter to wake up from
network activity in Win-
dows then make sure
that the computer is ei-
ther in Sleep or Hiber-
nate.

Wake-On-LAN is not
supported from Shut-
down states in Win-
dows.
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Figure3-4
Power Menu

Hibernate

Hiber nate uses the least amount of power of al the power-saving states and saves
al of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last |eft off within seconds. Y ou should
put your mobile PC into Hiber nate if you will not use the computer for a period of
time, and will not have the chance to charge the battery. To add Hiber nate to the
Power Menu see “ Adding Hibernate/Sleep to the Power Menu” on page 3 - 10.

Shut down

Y ou should Shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from Shut down takes longer than
from Sleep or Hiber nate.

Sleep

Hibernate

Shut down

Restart

3 - 8 Power-Saving States
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Configuring the Power Buttons

The power/sleep button (Fn + F12 key combo) and closed lid may be set to send the Z
computer in to a power-saving state. Click Choose what the power buttons do on Password
the left menu in Power Options to bring up the menu. Protection

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure3-5
Power Options
Define Power
Buttons

.|
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Figure3-6
Power Options
Define Power
Buttons - Shutdown
Settings

Adding Hibernate/Sleep to the Power Menu
Add Hibernate/Slegp to the Power Menu as follows.

Go to the Power Options (Hardware and Sound) control panel.

Click “Change settings that are currently unavailable” @ change settings that ar= currently unsvsilsble .
Click Choose what the power buttons do.

Click to put a check in the Hibernate/Sleep box under Shutdown settings.

Click Save Changes and close the control panel.

agpNE

3 - 10 Configuring the Power Buttons
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Resuming Operation
Y ou can resume operation from power-saving states by pressing the power button,
or in some cases pressing the sleep button (Fn + F12 key combo).

Power Status Icon Color To Resume
Table3-1
Power Off Off Press the Power Button Resuming
Press the Power Button Operation
Sleep Blinking Green
Press the Sleep Button (Fn + F4 Key Combo)
Off (battery)
Hibernate Press the Power Button
Orange (AC/DC adapter)
Display Turned Off Green Press a Key or Move the Mouse/Touchpad
Power Button 2
When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down Closing the Lid
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
R If you have chosen to
button for longer than this will force the computer to shut down).
send the computer to
Sleep when the lid is
closed, raising the lid

will wake the system up.

Configuring the Power Buttons 3 - 11
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Power Conservation Modes

g This system supports Energy Star power management features that place comput-
3 Power Conservation ers (CPU, hard drive, etc.) into a low-power sleep modes after a designated period
Modes of inactivity. Adjust Power Conservation Modes from the Control Center:

The Energy Star setting
will result in maximum
power saving, but with
the possible loss of
some performance.

1. Pressthe Fn + Esc key combination to toggle the Control Center on/off.
2. Click either the Performance, Balanced or Energy Star button.

Setting the mode to Bal-
ance will give power
saving matched with
performance.

Performance will give
optimum computer per-
formance but with less
power conservation.

Note that the Energy
Star setting will put the
display into sleep after
no more than 15 min-
utes of user inactivity.

Figure3-7
Control Center
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Ctrl + Alt + Delete Key Combination

YoucanusetheCTRL + ALT + DEL key combination from almost any of the Win-

dows 8 interfaces/Appsto bring up afull-screen displaying L ock, Switch User, Log

off, Change a password and Task Manager options. If you click the Power icon
in the lower right corner of the screen a power management option menu appears to

display Sleep, Shut down, and Restart.

Figure3-8
Ctrl + Alt + Delete
Menu

To fully control all the power options (including Hibernate mode) go to the Power
Options control panel and configure the power button, sleep button and lid to per-
form the function selected.

.|
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Battery Information

\ A/
ﬂ‘ Follow these simple guidelines to get the best use out of your battery.
Low Battery
Warning Battery Power

Whenihe bareryis oriti Y our computer’s bqttery power .is dependerjt upon many factors, includi ng the pro-
VA e @ grams you are running, and peripheral devices attached. You can set actions to be
ceueas GER Aehlel  taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
SCERERCEREEIE A power plan Change plan settings > Change advanced power settings (see Figure

or save your work, oth- ] i
erwise, the unsaved 3 -3 on page 3 - 6).

?hata WERERERUEIE  Click the battery icon ﬂ in the notification area to see the current battery level
e power is depleted.
and charge status.

Figure3-9
Battery Icon
(Notification Area) &
Battery Advanced
Settings

.|
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Conserving Battery Power

» Useapower plan that conserves power (e.g Power saver), however note that Z
this may have an affect on computer performance. Windows Mobility
+ Lower the brightness level of the LCD display. The system will decrease LCD Center

brightness dlightly to save power when it is not powered by the AC/DC adapter. The Windows Mobility

. . . Center control panel
* Reduce the amount of time before the display is turned off. provides an easy point

» Closewireless, Bluetooth, modem or communication applicationswhenthey are | of access for information

not being used. on battery status, power
plans used and wireless
» Disconnect/remove any unnecessary external devices e.g. USB devices, device status etc.
ExpressCards etc.
Figure3- 10
Windows Mobility
Center
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Battery Life

Battery life may be shortened through improper maintenance. To optimizethelife
and improveits performance, fully discharge and recharge the battery at least
onceevery 30 days. It isrecommended that you use the Battery Settingsin the En-
ergy Save Utility to help maintain the life of the battery.

We recommend that you do not remove the battery yourself. If you do need to re-
movethe battery for any reason (e.g. long term storage) see “ Removing the Battery”
on page 3 - 22.

New Battery

Always completely discharge, then fully charge, a new battery (see “ Battery FAQ”
on page 3 - 18 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter

The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hoursto fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery chargetimeisless. Refer to “ LED Indica-
tors” on page 1 - 9 for information on the battery charge status, and to “ Battery I n-
formation” on page 3 - 14 for more information on how to maintain and properly
recharge the battery pack.

.|
3 - 16 Battery Information



Power Management

Use of Fn + 6 to Enable/Disable Battery Charging s

Y ou can use the Fn + 6 key combination to enable/disable battery charging. Thisis ﬂ‘

useful if you need to discharge the battery as recommended (see overleaf) in order Caution

to maintain the battery. Note that the chipset controller which governs this process Danger of explosion if
is controlled by use of the AC/DC adapter. Thereforeif you disable battery charging BRSNS F SRS ESS =
and shut the computer down, and then remove the AC/DC adapter from the DC-In - BEEE=E

jack, whenever the AC/DC adapter is plugged-in again and the computer restarted,
the battery will revert to its default charging state.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
* DO NOT disassemble the battery pack under any circumstances used battery according

» DO NOT expose the battery to fire or high temperatures, it may explode to the manufacturer’s in-
* DO NOT connect the metal terminals (+, -) to each other structions.

Proper handling of the Battery Pack

2NZ
Z &

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being

dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your distributor/supplier. If the battery has been dropped we
do not recommend using it any further, as even if the computer continues to work with a
damaged battery in place, it may cause circuit damage, which may possibly result in fire. It
is recommended that you replace your computer battery every two years.

.|
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Battery FAQ

How do | completely dischargethe battery?

Use the computer with battery power until it shuts down due to alow battery. Don’t
turn of f the computer even if amessage indicates the battery iscritically low, just let

the computer use up al of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.

Figure3- 11
Power Plan Create

.|
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3. Click Change plan settings (after creating it) and click Change plan settings >
Change advanced power settings.

Figure3- 12
Change Plan
Settings / Change
Advanced Power
Settings

S
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

Figure3- 13
Power Options
Advanced Settings -
Battery

» Low battery levels = 0%

» Critical battery Levels= 1%

» Low battery action = Do Nothing

» Critical battery action (On battery) = Shut Down
 Critical battery action (Plugged in) = Do Nothing

.|
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How do | fully chargethe battery?
When charging the battery, don’t stop until the LED charging indicator light changes

from orange to green.

How do | maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.

.|
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SN
L&

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Figure3- 14
Battery Removal

Removing the Battery
We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason (e.g. long term storage) see below.

1. Turn the computer off, and turn it over.

2. Slide the latch @ in the direction of the arrow.

3. Slide the latch @ in the direction of the arrow, and hold it in place.
4. Slide the battery out in the direction of the arrow @.

3 - 22 Removing the Battery



Chapter 4: Drivers & Utilities

This chapter dealswith installing the drivers and utilities essential to the operation or
improvement of some of the computer’s subsystems. The system takes advantage of
some newer hardware componentsfor which the latest versions of most available op-
erating systems haven't built in drivers and utilities. Thus, some of the system com-
ponents won't be auto-configured with an appropriate driver or utility during
operating system installation. Instead, you need to manually install some system-re-
quired drivers and utilities.

What to Install

The Device Drivers & Utilities+ User’sManual disc containsthe drivers and util-
ities necessary for the proper operation of the computer. Table4 - 1, on page4 - 3
listswhat you need toinstall and it isvery important that thedriversareinstalled
by the method outlined in this chapter, and in the order indicated.

Note that the information included on the following pagesis for Windows 8.1 only.

Module Driver Installation
The proceduresfor installing driversfor the WirelessL AN, Bluetooth & WLAN Com-
bo modules are provided in “ Modules & Options’ on page 6 - 1.

What to Install 4 - 1

Drivers & Utilities

\ 7/
L&
Driver Installation &
Power

When installing driv-
ers make sure your
computer is powered
by the AC/DC adapter
connected to a work-
ing power source.
Some drivers draw a
significant amount of
power during the instal-
lation procedure, and if
the remaining battery
capacity is not adequate
this may cause the sys-
tem to shut down and
cause system problems
(note that there is no
safety issue involved
here, and the battery will
be rechargeable within 1
minute).




Drivers & Utilities

Driver Installation

1.

Insert the Device Drivers & Utilities + User’s Manual
disc into the computer’s DVD drive.

Click the message “Tap to choose what happens
with this disc.”

Click Run autorun.exe.

Click Install Drivers (button), or Option Drivers
(button) to access the Optional driver menu.

Figure4 - 1- Drivers Installer Screen 1

Check the driver installation order from Table 4 - 1,
on page 4 - 3 (the drivers must be installed in this
order) which is the same as that listed in the Drivers
Installer menu below.

Click to select the driver you wish to install, (you
should note down the drivers as you install them).
Follow the instructions for each individual driver
installation procedure as listed on the following
pages.

Figure4 - 2 - Install Drivers

. |
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Win 8.1 System Driver Page # Optional Drivers Page #
Chipset Page 4 - 6 PC Camera Module (No driver required) Page 6 -3
Video (VGA) Page 4 -6 Wireless LAN Module Page 6 - 12
LAN Page 4 - 6 Bluetooth & WLAN Combo Module Page 6 - 17
CardReader Page 4 -6 Intel® Rapid Storage Technology Page 6 - 22
Touchpad Page 4 - 6 Intel® Smart Connect Technology Page 6 - 23
Hot Key Page 4 -7 Free Fall Data Protection Page 6 - 28
MEI Driver Page 4 -7 3G/4G Module (No driver required) Page 6 - 32
Audio Page 4 -7 Trusted Platform Module (No driver required) Page 6 - 37
Wireless Display (No driver required) Page 6 - 43

Table 4 - 1 - Driver Installation
All drivers provided are for the Windows 8.1 operating system.

Note that you need to install both the WLAN & Bluetooth driversfor Intel and 3rd party WLAN & Bluetooth
Combo modules.

. |
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Manual Driver Installation

Click Browse CD/DVD (button) inthe Driversinstall-
er application and browse to the executable file in the
appropriate driver folder.

Windows Update

After installing all the drivers make sure you enable
Windows Updatein order to get all the latest security
updatesetc. (all updateswill includethelatest hotfixes
from Microsoft). See “Windows Update” on page 4 -
8 for instructions.

Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if itisnot listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Go tothe Control Panel).

2. Double-click Device Manager (Hardware and
Sound > Devices and Printers > Device
Manager).

3. Double-click the device you wish to update/reinstall
the driver for (you may need to click “+” to expand
the selection).

4. Click Driver (tab) and click the Update Driver or
Uninstall button and follow the on screen prompts.
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User Account Control

If aUser Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow theinstallation procedure as direct-
ed.

Windows Security Message

If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or “Install” to continue the
installation procedure.

Y ou will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
aready received certification for Windows.

New Hardware Found

If you see the message “New Hardware Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the install ation proce-
dure.

Drivers & Utilities

4

Driver Installation General Guidelines

The driver installation procedure outlined in this Chapter
(and in Chapter 7 Options & Modules), are accurate at 4

the time of going to press.

Drivers are always subject to upgrade and revision so
the exact procedure for certain drivers may differ slight-
ly. As a general guide follow the default on screen in-
structions for each driver (e.g. Next > Next > Finish)
unless you are an advanced user. In many cases a re-
start is required to install the driver.

Make sure any modules (e.g. WLAN or Bluetooth) are
ON (and the system is not in Airplane Mode) before
installing the appropriate driver.

Driver Installation 4 - 5



Drivers & Utilities

Driver Installation Procedure

Insert the Device Drivers & Utilities+ User’s Manual
disc and click Install Drivers (button).

Chipset

1. Click Llnstall Chipset Driver > Yes.
2. Click Next > Accept > Install.

3. Click Finish.

Video (VGA)

1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.

3. Click Finish to restart the computer.

Note: After installing the video driver go to the Dis-
play/Display Settings control panel to adjust the vid-
€0 Settings to the highest resolution.

LAN

Note: If the computer enters a deep sleep mode during
installation, you will be prompted to plug in a network
cable, and click OK, to continue installation. If a net-
work cable is not available, restart the system and re-
install the LAN driver.

1. Click 3.Install LAN Driver > Yes.
2. Click Next > Install.
3. Click Finish.

CardReader
1. Click 4.Install Cardreader Driver > Yes.
2. Click Finish.

Touchpad

1. Click 5.Install Touchpad Driver > Yes.

2. Click Next.

3. Click the button to accept the license agreement
and click Next.

4. Click Finish > Restart Now to restart the com-
puter.
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Note: Do not use Update Driver in Device Manager to
install the Airplane Mode driver.

1. Click 6.Install AirplaneDriver > Yes.

2. Click Next.

3. Click Finish to restart the computer.

Hot Key
1. Click 7.Install Hotkey AP > Yes.
2. Click Next.

3. Click Finish to restart the computer.

MEI Driver

1. Click 8.Install MEI Driver > Yes.

2. Click Next.

3. Click the check box to accept the license and
then click Next.

Click Next.

5. Click Finish.

E

Drivers & Utilities

Audio

1. Click 9.Install Audio Driver > Yes.
2. Click Next.

3. Click Finish to restart the computer.

Note that after installing the audio driver the system
will not return to the Drivers Installer screen. To in-
stall any of the optional drivers listed overleaf, gject
the Device Drivers & Utilities + User’s Manual disc
and thenreinsert it (or double-click thedisciconinMy
Computer), and click Option Drivers (button) to ac-
cess the optional driver menu.

It is recommended you now also install the Intel Rap-
id Storage Technology driver (see “Intel® Rapid
Storage Technology” on page6 - 22 - required for
AHCI mode hard disks).

(see over)
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4
Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc., (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

1.
2.

3.

Go to the Control Panel.

Click Windows Update (System and Security/
Security).

Click Check for updates (button).

The computer will now check for updates (you
need to be connected to the internet).

Click Install now (button) to begin checking for the
updates.

Click Install updates (button) to install the
updates.

Optional Drivers

Seethepagesindicatedin Table 4 - 1, on page 4 - 3for
the driver installation procedures for any modules in-
cluded in your purchase option.

Figure4 - 3 - Option Drivers

Note that you need to install both the WLAN & Blue-
tooth driversfor Intel and 3rd party WLAN & Blue-
tooth Combo modules.

.|
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Chapter 5: BIOS Utilities "

Overview BIOS Screens

This chapter gives a brief introduction to the computer’ s built-in software: i e e B
screens  pictured on

. these pages are intend-
If your computer has never been set up, or you are making important changesto the BESEERIREREE IRE

system (e.g. hard disk setup), then you should review this chapter first and note the B FSEeNIE S R
original settings found in Setup. Even if you are abeginner, keep arecord of the set-  JHEISES
tings you find and any changes you make. This information could be useful if your

- BIOS versions are sub-
system ever needs servicing. ject to constant change

and revision, therefore
Thereis one general rule: Don’t make any changes unless you are sure of what you VSISl lE]

. . . : screens may appear
aredoing. Many of the settings are required by the system, and changing them could slightly _ different _from

cause it to become unstable or worse. If you have any doubts, consult your service  BEFSEE IS T
representative. pages.

. |
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BIOS Settings
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Opti-
mized Defaults with
<F3>.

UEFI Boot & POST

When UEFI Boot is en-
abled, then the prompts
to press F2 or F7 will
not appear. However
you can still press F2 to
enter the setup, or F7 to
choose the preferred
boot device, if you press
the key immediately the
system boots up.

The Setup Utility

Each time you turn on the computer the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).

Asthe POST proceeds, the computer will tell you if thereisanything wrong. If there
isaproblem that prevents the system from booting, it will display asystem summary
and prompt you to run Setup.

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can't get into Setup without rebooting.

The Aptio Setup Utility tells the system how to configure itself and manage basic
features and subsystems (e.g. port configuration).

To enter Setup, turn on the computer and press F2 (give the system a few seconds
to enter Setup). If the Boot L ogo is enabled the F2 on screen will be highlighted to
illustrate that the system is processing the request during the POST (or press F7 for
boot options). If you get a*“Keyboard Error”, (usually because you pressed F2 too
quickly) just press F2 again.

If the computer is aready on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.

To see the boot options press F7 and choose your preferred boot device.
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Failing the POST
Errors can be detected during the POST . There are two categories, “fatal” and “non-
fatal”.

Fatal Errors

These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
distributor/supplier as soon as possible.

Non-Fatal Errors

This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) and you can then press F7 (the F7 on screen
will be highlighted to illustrate that the system is processing the request) for boot
options.

Press F2 (give the system a few seconds to enter Setup; the F2 on screen will be
highlighted to illustrate that the system is processing the request) to run the Setup
program and try to correct the problem. If you still get an error message after you
change the setting, or if the “cure” seems even worse, call for help.
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4

Setup Menus

The Setup menus
shown in this section are
for reference only. Your
computer's menus will
indicate the configura-
tion appropriate for your
model and options.

Figure5-1
Navigation Menu

Setup Screens

The following pages contain additional advice on portions of the Setup. Along the
top of the screen is a menu bar with menu headings. When you select a heading, a
new screen appears. Scroll through the features listed on each screen to make chang-
esto Setup.

Instructions on how to navigate each screen are in the box at the bottom right side of
the screen.

If these tools are confusing, press F1 to call up aGeneral Help screen, and then use
the arrow keysto scroll up or down the page.

Theltem Specific Help onthe upper right side of each screen explainsthe highlight-
ed item and has useful messages about its options.

If you see an arrow p next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.
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Main Menu

Aptio Setup Utility — Copyright (C) 2014 American Megatrends Inc.

System Date

Figure5-2
Main Menu

System Time & Date (Main Menu)

The hour setting uses the 24-hour system (i.e., @@ = midnight; 13 = 1 pm). If you
can change the date and time settingsin your operating system, you will aso change
these settings. Some applications may also alter data files to reflect these changes.

Main Menu 5 - 5



BIOS Utilities

SATA Port # (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of a optical Device/
HDD on the computer’s SATA Ports.

System/Extended Memory: (Main Menu)
Thisitem contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

MB Series/ BIOS Revision / KBC/EC firmware Revision
This item contains information on the BIOS version etc., and is not user configu-
rable.
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Advanced Menu

Aptio Setup Utility — Copyright (C) 2014 American Megatrends Inc.

Figure5- 3

p Advanced Chipset Control
Advanced Menu

Advanced Chipset Control (Advanced Menu)
The sub-menu here alows you to change the device installed in the Combo mSA-
TA/3G Slot.
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4

UEFI Boot

When UEFI Boot is en-
abled, then the prompts
to press F2 or F7 will
not appear. However
you can still press F2 to
enter the setup, or F7 to
choose the preferred
boot device, if you
press the key immedi-
ately the system boots

up.

Intel Smart Connect Technology (Advanced Menu)

Smart Connect isatechnology that makes checks on web applicationsthat are open
even when the computer isin sleep mode, and thus allows updates to be made with-
out the need to turn the computer on. The sub-menus here allow you to enable/dis-
able the technology (I SCT Configuration).

SATA Mode (Advanced Menu)
The SATA (Serial ATA) control is configured to operatein AHCI (Advanced Host
Controller Interface) mode.

Boot Logo (Advanced Menu)

Use this menu item to enable/disable the Boot L ogo screen at system startup if you
have not enabled UEFI Boot. If you disable the Boot L ogo you will not see the F2
Enter Setup or F7 Boot Options prompts on the screen, however you can still press
these keys, while the boot screen is displayed, to perform the Enter Setup or Boot
Option functions.

Power On Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.
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Combo Sot
(Advanced Menu > Advanced Chipset Control) 3[,1’:
Select which deviceisinstalled in the Combo slot from this menu option. Select the
appropriate device installed in the slot from the menu, and then save the changed
BIOS settings. You will then need to shutdown the system and remove the AC/ [ s et sicie Bl
DC adapter. Y ou should then plug the AC/DC adapter back in again and restart the gg:gcgilsvggﬁ g:]e ifaf/oﬁ
computer to have the system recognize the changes made. have included it in your

purchase configuration.

Combo Slot Support

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

Combo slot [Storage device]

Figure5-4
Advanced Chipset

Combo slot:
Storage device ContrOI
3G device (Advanced Men u)
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Security Menu

Aptio Setup Utility — Copyright (C) 2014 American Megatrends Inc.

4

Security Menu

The changes you make
here affect the access
to the Setup utility itself,
and also access to your
machine as it boots up
after you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in your
software OS.

Secure Boot Mode [Standard]

Secure Boot Mode
Standard
Custom

Figure5-5
Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Aptio Setup Utility. This will not affect
access to the computer OS (only the Aptio Setup Utility).
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Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Set User Password (Security Menu)

Y ou can set a password for user mode access to the Aptio Setup Utility. Thiswill
not affect access to the computer OS, (only the Setup utility) unless you choose to
set a Password on Boot (see below). Many menu items in the Aptio Setup Utility
cannot be modified in user mode.

Note: You can only set the user password after you have set the supervisor pass-
word.

Password on boot: (Security Menu)

Specify whether or not a password should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is“Disabled”.

Security Menu 5 - 11
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Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled’), NEVER
forget your password.

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.




BIOS Utilities

Secure Boot Control (Security Menu)

Secure Boot prevents unauthorized operating systems and software from loading
during the startup process. Secur e Boot Control isavailable asamenu optionif you
have enabled UEFI Boot (see “UEFI Boot (Boot Menu)” on page5 - 15). En-
abling Secure Boot will bring up the Secur e Boot M ode menu to enable you to con-
figure Secure Boot as Standar d (with afixed secure boot policy) or Custom (which
enables you to make changes to the Key M anagement database).

5 - 12 Security Menu
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TPM Configuration (Security Menu)
This sub-menu will allow you to enable/disable Trusted Platform Module (TPM)
support. Press Enter to access the Security Device Support menu and select Enable

to support TPM 2.0 aslong as UEFI Boot is enabled (see “ Trusted Platform Mod-
ule” on page 6 - 37 for details).

Aptio Setup Utility — Copyright (C) 2014 American Megatrends Inc.

Security Device Support [Enable]

Figure5-6
Security Device
Support

Security Menu 5 - 13
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Boot Menu

Aptio Setup Utility — Copyright (C) 2014 American Megatrends Inc.

. oot
Figure5-7 -
Boot Menu

Boot Option #1 [Windows Boot Manager]

2NZ
Z &

BIOS Screens

Note that the BIOS
screens pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-
ject to constant change
and revision, therefore

your computer’'s actual A . .
A When you turn the computer on it will look for an operating system (e.g. Windows

slightly different from 7) from the devices listed in this menu, and in this priority order. If it cannot find
LRSSl the operating system on that device, it will try to load it from the next device in the
pages. order specified in the Boot Option Priorities. Item specific help on the right is
available to help you move devices up and down the order.

|
5 - 14 Boot Menu



Boot Option Priorities (Boot Menu)

Press Enter to access the menu, use the arrow keys to move up and down the menu,
and press Enter to select a device from the Boot Option # list (the selected device
will be highlighted in white).

UEFI Boot (Boot Menu)

Enable/disable UEFI Boot from this menu. The Unified Extensible Firmware Inter-
face (UEFI) specification provides a clean interface between operating systems and
platform firmware at boot time. In contrast to BIOS, UEFI defines a set of standard
boot and runtime services. The Network Stack and Launch CSM (Compatability
Support Module - for legacy BIOS compatibility) items will be enabled as options
under UEFI Boot.

BIOS Utilities

Boot Menu 5 - 15
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Exit Menu

Aptio Setup Utility — Copyright (C) 2014 American Megatrends Inc.

Flgure 5 - 8 Save & Exit
Exit Menu

Save Changes and Reset

Click Save Changes and Reset to save al changes made. Choosing to Discard
Changes, or Exit Discarding Changes, will wipe out any changes you have made
to the Setup. Y ou can also choose to restore the original Setup defaults that will re-
turn the Setup to its original state, and erase any previous changes you have madein
aprevious session.

. |
5 - 16 Exit Menu
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Chapter 6: Modules & Options %

/ \Y

i Wireless Device
OverVIGW Operation Aboard
This chapter contains information on the following modules, which may come with Aircraft
your computer, depending on the configuration purchased. If you are unsure please | RS T a1
contact your service representative. electronic transmission

. devices aboard aircraft
» PC CameraModule » Free Fall Data Protection is usually prohibited.

* WirelessLAN Module * 3G/4G Module Make sure the WLAN,
* Bluetooth & WLAN Combo Module Trusted Platform Module Bluetooth and 3G/4G
+ Intel® Rapid Storage Technology Wireless Display module(s) are OFF if

ou are using the com-
* Intel® Smart Connect Technology guter aboardgaircraﬂ by

putting the system in to
Airplane Mode (see

).

. |
Overview 6 - 1
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\ A/
2§
Important Notice
If your purchase option includes both Wireless LAN and 3G/4G modules, then the appro-
priate antennas will be installed. Note that In order to comply with FCC RF exposure com-

pliance requirements, the antenna must not be co-located or operate in conjunction with
any other antenna or transmitter.

Important Notice - 3G/4G & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3G/4G module and
the Bluetooth/Wireless LAN modules at the same time as this may disrupt radio frequency,
and cause interference. When the 3G/4G module is powered on, make sure that the Blue-
tooth/Wireless LAN modules are powered off.

. |
6 - 2 Overview
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PC Camera Module

Note that you need to use the Camer a app in Windows to take pictures and capture
video. Usethe Fn + F10 key combination (see“ Function/Hot Key | ndicators’ on
page 1 - 13) to toggle power to the PC Camera module. When the PC Camerais
in use the LED indicator to the left of the camerawill be illuminated in red (see @
Figurel-2onpagel- 7/[Figurel- 3 on pagel- 8).

. |
PC Camera Module 6 - 3
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PC

Camera Audio Setup

If you want to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1.
2.
3.
4.
5.
6.
Figure6-1
Audio Setup for PC
Camera

Go to the Control Panel.

Click Sound (Hardware and Sound) and click Recording (tab).

Right-click hold and release Microphone (Realtek High Definition Audio) and
make sure the item is not disabled.

Double-click Microphone (or select Properties from the right-click menu).

Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to
the level required.

Click OK and close the control panels.

Right-click

6 - 4 PC Camera Module
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Camera App

1. Runthe Camera app from the Start screen by clicking on the Camera app icon

2. The camera interface will display two buttons on the right side of the screen. .
' Wil dispiay ) 'gnt S| Figure6- 2

Camera App
Buttons

4

Exposure

Use the slider to adjust
the Exposure level.

3. The upper button is used to record video, and the lower button is used
to take still pictures.

Right-click on the screen to bring up menu buttons at the bottom of the screen.
These buttons enable you to access the camera roll (where captured pictures and
video are displayed), set the timer (the time period before capture begins; 3
seconds, 10 seconds or Off) and set the exposure level using the slider to obtain

the best results.
Figure6- 3
Camera Options

Camera roll

ok

Timer Exposure

PC Camera Module 6 - 5
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Camera Options
The Camera Options settings may be accessed as follows:
1. Runthe Camera app from the Start screen by clicking on the Camera app icon

2. While the camera app is running access the Charms Bar (e.g. click Use the
Windows logo key == + C key combination).

3. Click Settings and then click Options.

4. You can adjust the Photo Aspect Ratio, select the Microphone, Hide/Show grid
lines and turn Location Info on or off from the Options panel.

Figure6- 4
Camera Options

6 - 6 PC Camera Module
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Taking Pictures/Capturing Video
1. Runthe Camera app from the Start screen by clicking on the Camera app icon

2. Right-click the screen and select the timer if you require a countdown before
capture.

3. Click the appropriate icon to take a picture or start video capture (if video capture

begins a timer will appear in the bottom corner of the screen).

To stop video capture click the main window again (or click the stop icon ).

Captured photos and videos will be saved to a Camera Roll folder within the

Pictures folder.

ok

Figure6-5
Pictures - Camera
Roll

PC Camera Module 6 - 7
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Camera Roll
1. Runthe Camera app from the Start screen by clicking on the Camera app icon

2. Right-click on the screen to bring up menu buttons at the bottom of the screen.

3. Click Camera Roll.

4. Click the arrows - / -(on either side of the screen) to browse through the
captured photos/video, and back to the Camera app.

Editing Photos
1. Clicking on a captured photo will bring up an app bar with a series of buttons.

Figure6-6
b Edit Buttons
(for Still Photos)

2. The Camera button will take you back to the home screen of the camera app.

3. Click Delete to remove any photo from the camera roll (you will be asked to click
Delete again to confirm the deletion).

4. The Open With button will allow you to select a program with which to open the

photo.

You can click Set as Lock screen to set the photo as the lock screen picture.

Clicking Slide Show will create a slide show of photos/video in the camera roll.

Click Rotate to rotate the picture through 90 degrees.

Use the handles to Crop any captured picture, and click Apply to make the

changes (you can change the Aspect ratio by clicking the button and selecting an

aspect ratio from the menu). You can Save a copy (create another copy of the

©NOo O

. |
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photo with the edited changes), Update original (which changes the original

picture permanently) or Undo any changes.

9. Click the Edit button to bring up a full suite of tools to edit the photo.
10. Click on the menu headings on the left, and then click on the tool on the right to

edit the photo as required.
Edit Menu Basic Fixes Light

Q

Rotate

Retouch

Color Effects

%t

Temperature

Figure6-7
Editing Tools

Saturation

Q

Color enhance

11. After the editing process is completed right-click on the photo to Save a copy
(create another copy of the photo with the edited changes), Update original
(which changes the original picture permanently), Undo any changes or Cancel

the editing.

PC Camera Module 6 - 9
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Editing Photos
1. Clicking on a captured video will bring up an app bar with a series of buttons.

Figure 6 - 8
Edit Buttons
(for Video) Trim
2. Click Delete to remove any video from the camera roll (you will be asked to click
Delete again to confirm the deletion).
3.  The Open With button will allow you to select a program with which to run the
Video.
Clicking Slide Show will create a slide show of photos/video in the camera roll.
5. Click Trim to edit the video. Use the round buttons at either end of the slider to
adjust the video length and click Save a copy to save the changes made.

»

Figure6-9
Trim Video
(for Video Files)
Click to select and move the rounded buttonsto edit the video.

. |
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Video File Size

Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (goto My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to aremovable medium e.g. CD, DVD or USB Flash
drive.

Note that the Windows 8.1 system requires a minimum of 16GB (32-bit) or 20GB
(64-bit) of free space on the C: drive system partition. In order to prevent system
problems it is recommended that you move any large sized captured video fileto a
location other than the C: drive.

PC Camera Module 6 - 11
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Wireless LAN Module

N If you haveincluded an I ntel® or 3rd Party WL AN modulein your purchase option
Spciiden Ay mak_e surethai_t the moduleison (i.e. the systemisnot in Airplane Mode) before in-
Aircraft stalling the driver.

2MN\Z
R

IR c SRl Make sure you install the driversin the order indicated in Table 4 - 1, on page 4 - 3.
electronic transmission

devices aboard aircraft

. o Note that you need to install both the WLAN & Bluetooth drivers for the WLAN
is usually prohibited.
VR AN B & Bluetooth Combo modules.

Bluetooth and 3G/4G
module(s) are OFF if
you are using the com-
puter aboard aircraft by
putting the system in to
Airplane Mode (see

).

6 - 12 Wireless LAN Module



Modules & Options

3rd Party 802.11b/g/n Driver Installation

1. Makesurethemoduleison and the system isnot in Airplane Mode,
and then insert the Device Drivers & Utilities + User’s Manual disc into
the DVD drive.

Click Option Drivers (button).

Click L.Install WLAN Driver > Yes.

Click Next.

Click Finish to restart the computer.

The operating system is the default setting for Wireless LAN control in
Windows (see page 6 - 14).

OO0k wWN

Intel® WLAN Driver Installation

1. Makesurethemoduleison and the system isnot in Airplane Mode,

and then insert the Device Drivers & Utilities + User’s Manual disc into

the DVD drive.

Click Option Drivers (button).

Click L.Install WLAN Driver > Yes.

ICIEs(t:inIn the check box to agree to the End User License Agreement and click
nstall.

Click Finish.

The operating system is the default setting for Wireless LAN control in

Windows (see page 6 - 14).

ou AWN

. |
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Figure6 - 10
WiFi Settings
(Charms Bar) &
Networks

WLAN Configuration in Windows

Y ou can configure a wireless connection using one of the following options, how-
ever make sure the Wireless LAN module is turned on (and not in Airplane Mode)
before configuration begins.

Charms Bar

1. Go tothe Charms Bar.

2. Select Settings and then click the WiFi icon (it should read Available under the
icon and Airplane mode should be Off).

3. Alist of available access points will appear.

(© Networks

Off

* Airplane mode
*
a7

Available Brightness

On

E d) .Illl CPhone

Motifications Power Keyboard
] ROT13-ASUS-RT66U-2...

all RD113
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4. Double-click an access point to connect to it (or click it and click Connect).

5. Enter a network security key (password) if required, and click Next.

6. You can choose to find other devices or not.

7. When you are connected to the network access point it will display Connected
[Connected |

8.

Select any connected network and click Disconnect to disconnect from a
connected access point.

(© Networks (© Networks

Airplane mode Airplane mode

Off

Figure6- 11
Networks
Connected /
Disconnect

On

.llll CPhone

RD113-ASUS-RTE6U-2....
il

al RD113

9. You can click the Airplane Mode button to turn the mode (including Bluetooth) On
or Off.

10. Alternatively you can click the WiFi button to turn just the WiFi On or Off.

Wireless LAN Module 6 - 15
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Figure6 - 12
Windows Desktop
Taskbar Notification
Area WLAN
Connection

Desktop Mode

1.

Nogk~wd

Switch to the Windows Desktop (click the app or use the Windows logo key == +
D key combination).

Click the wireless icon [l in the notification area of the taskbar.

A list of available access points will appear.

Double-click an access point to connect to it (or click it and click Connect).

Enter a network security key (password) if required, and click Next.

You can choose to find other devices or not.

Select any connected network and click Disconnect to disconnect from a
connected access point.

(© Networks

Airplane mode

(© Networks off

Airplane mode

On

.lllI CPhone

RD113-ASUS-RTE6U-2....
all

| RD113

6 - 16 Wireless LAN Module



Modules & Options
Bluetooth & WLAN Combo Module :

AL
If your purchase option includes the Combination Wireless LAN & Bluetooth /ﬂ\

. . . . Wireless Device
module (either Intel® or 3rd Party) then install the driver as instructed overleaf. Spciiden Ay

Make sure that the module is on (i.e. the system is not in Airplane M ode) beforein- Alfcrat

stalling the driver. The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the WLAN,
Bluetooth and 3G/4G
module(s) are OFF if
you are using the com-
puter aboard aircraft by
putting the system in to
Airplane Mode (see

4

Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported

in one direction only (simultaneous data transfer is not supported). Therefore if you are copying
a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from
the Bluetooth enabled device to your computer until the file transfer process from the computer
has been completed.

).

Bluetooth & WLAN Combo Module 6 - 17
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4

High Speed Bluetooth
Data Transfer

The Combination Wire-
less LAN & Bluetooth
module supports high
speed data transfer. How-
ever to achieve such
transfer speeds, both de-
vices must support
high speed data trans-
fer.

To obtain high speed
data transfer make sure
that both the WLAN and
Bluetooth modules are
powered on.

Check your Bluetooth
compatible device’'s doc-
umentation to confirm it
supports high speed data
transfer.

3rd Party Bluetooth (V4.0) Combo Driver Installation

1.

ok wN

Make surethe moduleison and the system isnot in Airplane Mode,
and then insert the Device Drivers & Utilities + User’'s Manual disc into
the DVD drive.

Click Option Drivers (button).

Click 2.Install Combo BT Driver > Yes.

Click Next.

Click Finish to restart the computer.

See “ Bluetooth Configuration in Windows” on page 6 - 19 for configura-
tion instructions.

Intel Bluetooth Combo Driver Installation

1.

Noak~rwd

Make surethe moduleison and the system isnot in Airplane Mode,
and then insert the Device Drivers & Utilities + User’s Manual disc into
the DVD drive.

Click Option Drivers (button).

Click 2.Install Combo BT Driver > Yes.

Click Next > Next.

Click in the check box to accept the license and click Next.

Click Next > Finish.

See “Bluetooth Configuration in Windows” on page 6 - 19 for configura-
tion instructions,

6 - 18 Bluetooth & WLAN Combo Module
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Bluetooth Configuration in Windows ™
Y ou can configure a Bluetooth connection as below, however make sure the Blue- 7£l<
tooth module is on (or the system is not in Airplane Mode) before configuration. Bluetooth Headset

Desktop Mode Stereo Setup

1. Switch to the Windows Desktop (click the App or use the Windows logo key == + To setup a Bluetooth
D key combination).

2. Click the notification area of the taskbar and double-click the Bluetooth icon (or
click and select Show Bluetooth Devices).

3. The Bluetooth item in PC and Devices will appear.
OR

Charms Bar

1. Go tothe Charms Bar.

2. Select Settings and then click Change PC Settings.

3. Select the Bluetooth item in PC and Devices.

O E -jc}j- Figure6 - 13

headset to support ste-
reo audio see page

Available Brightness Bluetooth Taskbar
Icon & Change PC
=] Settings (Charms

Bar -Settings)

Notifications Keyboard

( > Change PC settings

Bluetooth & WLAN Combo Module 6 - 19
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4. Make sure that Bluetooth is turned on and a list of discovered devices will appear.
5. Double-click the device you want to pair with the computer and click Pair.

Figure6- 14

PC and Devices -
Bluetooth
6. On first connection the computer will provide you with a pairing code to be entered
onto the device.
Figure6 - 15

Enter the Passcode

7. Enter the code into your Bluetooth enabled device and click Yes on the computer
to complete the pairing.
8. Select a device and click Remove Device to disconnect from any device.

6 - 20 Bluetooth & WLAN Combo Module
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To Make your Computer Discoverable to Bluetooth Devices

1. Switch to the Windows Desktop (click the app or use the Windows logo key == +
D key combination).

2. Click the natification area of the taskbar, click the Bluetooth icon and click
Open Settings.

3. Click Options, and make sure that Allow Bluetooth devices to find this
computer check box (Discovery) has a check inside it.

4. Make sure that the Alert me when a new Bluetooth device wants to connect
check box (Connections) has a check inside it, if you want to be notified when a
Bluetooth device wants to connect.

Figure6 - 16
Bluetooth Settings

Bluetooth & WLAN Combo Module 6 - 21
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Intel® Rapid Storage Technology

Install the Intel® Rapid Storage Technology to support your AHCI mode SATA
drive.

IRST Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD
drive.

Click Option Drivers (button).

Click 3.Install IRST Driver > Yes.

Click Next.

Click in the check box to accept the license and click Next.

Click Next > Next > Next.

Click Finish to restart the computer.

Run the Intel® Rapid Storage Technology app from the Apps screen.

ONOUAWDN

.|
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Intel® Smart Connect Technology

Intel® Smart Connect Technology periodically, and briefly, wakes the computer ntel® S c
from Sleep mode in order to update information for certain applications (e.g. to get r}teechn OT;Z@ S;Z{‘;ft
mail from Microsoft Outlook) as required. These updates can therefore be made Requirements
without having to turn the computer on, and applicationswill be up to date when the _

ter resumes from Sleep mode (make sure that I ntel Smart Connect Technol- Note that in order to sup-
ComP“ -, eep ) port Intel® Smart Con-

Technology (Advanced Menu)” on page 5 - 8). system will need to have
hat th licati eed tob d . h h the item enabled in the
Note that the applications need to be on and running when the computer enters | giog (see page 5 - 8).

Sleep mode in order to get updates.

Z

In addition only certain
Intel  WLAN modules

Intel® Smart Connect Technology Driver Installation T Sy e
1. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD Check with your distrib-
drive. utpr/supplier for de-
2. Click Option Drivers (button). talls.
3. Makesurethat Intel Smart Connect Technology is enabled in the BIOS -
see“Intel Smart Connect Technology (Advanced Menu)” on page5 - 8.
4. Click 4.Install ISCT Driver > Yes.
5. Click Next.
6. Click inthe check box to accept the license and click Next.
7. Click Next > Install > Finish.
8. Click Yesto restart the computer.

.|
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Intel® Smart Connect Technology Configuration

\ A/
7£l< 1. Access the Intel(R) Smart Connect Technology application from the Apps menu.
Wireless Device 2. The Keep Data Fresh ON is enabled by default (if you wish to turn it off click the
Operation Aboard OFF button to do so).
Aircraft 3. You can select to have the system update open application data every 15, 30 or
The use of any portable 60. minutes. . . . L .
electronic  transmission 4. Click Save to retain the settings (in order to update any applications, they will need
= e to be on and running when the computer enters Sleep mode).
is usually prohibited. 5. Note the sidebar warning about the use of Intel(R) Smart Connect Technology
Make sure the WLAN, aboard aircraft and make sure your wireless LAN module is off during air travel.

Bluetooth and 3G/4G
module(s) are OFF if
you are using the com-
puter aboard aircraft by
putting the system in to
Airplane Mode (see

)-

Figure6 - 17
iSCT Basic
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6. Click Customize Schedule to customize the update frequency, and the hours and
days when the updates will occur. ;Il’;
7. Bear in mind that the more often you set the system to update, the more power is

consumed, and this may be a consideration if the system is battery powered. ISCT & System

Power

Note that Intel Smart
Connect will turn off
when it detects a low
battery level, and will

not run if the system is
Shut Down or is in Hi-
bernate mode.

It is recommended that
the system be left
plugged-in if left for an
extended period.

Figure6- 18
iSCT Customize
Schedule

.|
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8. Click the Help icon and select Help to access the menu.

Intel WLAN Modules

If your purchase option
includes an Intel WLAN
module, (with Intel's
PROSet Wireless Con-
nection  Utility in-
stalled), Intel® Smart
Connect Technology

will search for WiFi net-
works around you that
you have previously ac-
cessed.

If no known WiFi net-
works are found, your
computer will not update
again until it recognizes
a known WiFi network.

Figure6 - 19
iSCT Help
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Remote Wake
Remote Wake allows you to wake the computer remotely from another device such
as aphone, tablet or another PC. Thiswill allow you to access files on the computer.

A link to alist of applications and usage is supplied if you click Learn More and
thelink provided. An application must support thisfeature and you will need to reg-
ister any devices. Check any particular application for more information on this fea-
ture, and you will need to have the application loaded on any device from which you
want to connect to the system. A list of compatible applications is provided if you
click the link provided.

LED Power Indicator & Intel® Smart Connect
The LED power indicator will blink as indicated in the table below when Intel®
Smart Connect is enabled (Intel® Smart Connect is enabled in the BIOS by de-

fault).
Icon Color Description
Orange DC Power is Plugged In Table6- 1
Green The Computer is On Power LED Indicator
Blinking Green The Computer is in Sleep Mode

Slow (20 second intervals) The Computer is in Sleep Mode and *Intel Smart
Blinking Green Connect is Enabled

.|
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Free Fall Data Protection

“ (Optional)
~ Sensitivity The Free Fall Data Protection sensor and HDD Protect Utility will help protect your
Adjustment&Power | 44 gisk drive, in the event that the computer is accidentally dropped, by parking
Saving States the HDD read/write heads away from the platter to avoid scratching the surface of
Note that you can adjust | the hard disk. If you want to install Free Fall Data Protection then follow the pro-
the sensitivity level of the £ cedure outlined on the following pages to install the driver, and then configure the

HDD Protect Utility by s s
means of the slider at the | Senaitivity from the application.

bottom of the screen, . ) .
however it will take a few Free Fall Protection Driver Installation

seconds for adjustments § 9 |ngart the Device Drivers & Utilities + User’s Manual disc into the DVD
to come into effect. drive

Click Option Drivers (button).

Click 5.Install Freefall Protection > Yes.
Click Next > Next.

Click Install.

Click Finish.

Click Yesto restart the computer.

If the system is in a pow-
er-saving state it will
also take a few seconds
for the system to imple-
ment HDD protection.

NoakrwnN
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HDD Protect Utility Configuration
1. Accessthe HDD Protect Utility from the Free-Fall Sensor Utility Start screen, or
by right-clicking the icon in the natification area of the taskbar and selecting Show.

Figure6 - 20
Free Fall Data
Protection Access
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2. The Free Fall Protection Data Protection can be enabled or disabled by clicking the
icon in the notification area of the taskbar, or by clicking Enable/Disable in the HDD
Protect Utility. and then clicking OK.

3. The taskbar icon will be orange when data protection is ON, and blue when
it is OFF.

Figure6- 21 ( > ( }
Free Fall Data

Protection Enabled/
Disabled
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4. Adjust the sensitivity level by means of the slider at the bottom of the screen.

Figure6 - 22
HDD Protect Utility
(Sensitivity)

5. If the computer is accidentally dropped the HDD heads will be parked temporarily
to avoid damage (the icon will switch to an exclamation mark when the heads
are parked).

6. This should take only a few seconds and the computer will be ready for use soon
after.

Figure6 - 23
HDD Protect Utility
(Disk Heads Parked)
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3G/4G Module

Wireless Device If you haveincl ud.ed an optional UMTS]HSPA+ based 3G Module (Universal Mo-
Spciiden Ay bile Telecommunications System or High Speed Packet Access) module or LTE
erai (Long Term Evolution) 4G module (see“ Communication” on page D - 3 for spec-

The use of any portable ification details) in your purchase option, you do not require a driver/application
S ety installation for Windows. Follow the instructions overleaf to install the USIM card
s el i B (which will be provided by your service provider), and then use the Charms Bar

SR TEIETA el Wirelessicon to accessthe 3G/4G networ k in the same manner asthe WLAN (see
Make sure the WLAN, page 6 - 34).

Bluetooth and 3G/4G
module(s) are OFF if
you are using the com-
puter aboard aircraft by
putting the system in to
Airplane Mode (see

2MN\Z
R

2NZ
2L &

Important Notice

If your purchase option includes both Wireless LAN and 3G/4G modules, then the appro-
priate antennas will be installed. Note that In order to comply with FCC RF exposure com-
pliance requirements, the antenna must not be co-located or operate in conjunction with
any other antenna or transmitter.

)

Important Notice - 3G/4G & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3G/4G module and
the Bluetooth/Wireless LAN modules at the same time as this may disrupt radio frequency,
and cause interference. When the 3G/4G module is powered on, make sure that the Blue-
tooth/Wireless LAN modules are powered off.
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3G/4G Module USIM Card Installation

. . . . . . SN
Follow the instructions below to install the USIM card (which will be provided by ZAS
your service provider). Power Safety
. Warning
1. Turn off the computer, and turn it over.
2. Slide the latch @ in the direction of the arrow. Before you undertake any
3. Slide the latch @ in the direction of the arrow, and hold it in place. e
4. Remove the battery @. ELE SR [t JoU [EE
. turned off the power, and
5. Insert the_U_SIM card 9 (at the rear of the battery compartment) as illustrated disconnected all peripher-
below until it clicks fully into position, and replace the battery. als and cables (including
telephone lines). It is advis-
9 able to also remove your
0 battery in order to prevent
9 accidentally turning the ma-

chine on.

USIM Card Orientation

Note that the USIM card’s
readable side (with the
gold-colored contacts)
should face upwards as il-
lustrated.

(1) Figure6- 24
Battery Removal &
USIM Card Insertion
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3G/4G Module PIN
Code & Power-Saving

Note that there may be
some issues when a/4G
PIN Code is set for 3G
modules in Windows, if
Mobile Broadband has
been turned off, and the
system has resumed
from a power-saving
state. See “

Figure6 - 25
Networks
Mobile Broadband

3G/4G Configuration in Windows

Y ou can configure a 3G/4G connection as below, however make sure the systemis
not in Airplane Mode before configuration begins.

Charms Bar

1. Go tothe Charms Bar.

2. Select Settings and then click the WiFi icon (it should read Available under the
icon and Airplane mode should be Off).

3. Alist of available access points will appear under Mobile Broadband.

* i > Cl)"

Dt

Available 67 Brightness

2 O

Notifications Power Keyboard

Change PC settings

\/
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Any 3G/4G service provider (connection information is usually stored on the USIM
card) will appear under Mobile Broadband.

Double-click any connection icon under Mobile Broadband (or click and then click
Connect).

Figure6 - 26
Mobile Broadband

(Connect) a

6. The system will connect to your network.

7. A Connected will appear alongside the 3G/4G connection (click the connection to
view the timer which indicates your connected time for the current session).

. |
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- 8. You can then access the internet, download e-mail etc. as per any internet
2§ connection.

Wireless Device 9. To disconnect you can select the connection and click Disconnect [E2e].

Operation Aboard
Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.

Make sure the system is
in Airplane Mode if you
are using the computer
aboard aircraft.

Figure6 - 27
Mobile Broadband 10. You need to either use Airplane Mode, or to turn the Mobile Broadband module
(Disconnect) off aboard aircratft.
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Trusted Platform Module

(Optional)

The TPM security chip allowsyou to create and manage digital certificatesfor user
and platform authentication. This type of security is usually administered within
large enterprises and organi zations, and therefore requires implementation by a sys-
tem administrator before users can access security features.

Make sure you have administrator’ s rights to your computer, and have a Windows
password enabled for full security protection. In addition Make sure you prepare
aremovablemedia (e.g. aUSB flash drive) to stor e passwor dsetc. befor e begin-
ning the TPM initialization process.

Before setting up the TPM functions you must enable and initialize the security plat-
form.
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Enabling & Activating TPM

Restart the computer.

Enter the Aptio Setup Utility pressing F2 during the POST/startup.

Use the arrow keys to select the Security menu.

Select TPM Configuration and press Enter to access the sub-menu.

Press Enter to access the TPM Support menu and select Enable in Security
Device Support.

You will then need to press F4 to save the changes and restart the computer.

grwONPE

o

Aptio Setup Utility — Copyright (C) 2014 American Megatrends Inc.

Security Device Support [Enable]

Figure6 - 28
Security Device
Support (Enabled)

. |
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TPM Management in Windows
Y ou can manage your TPM settings from within Windows:

1. Go tothe Control Panel.
2. Click BitLocker Drive Encryption (System and Security).
3. Click TPM Administration.

Figure6 - 29 a

BitLocker Drive
Encryption
(TPM
Administration)
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4. The TPM Management window allows you to configure the TPM within Windows.
As TPM is usually administered within large enterprises and organizations, your
system administrator will need to assist you in managing the information here.

b Figure6 - 30

Trusted Platform
Module (TPM)
Management on
Local Computer
Administration
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TPM Actions

1. Click Prepare the TPM and follow the instructions in the Wizard to prepare the
TPM (this will probably require a restart of the computer and confirmation of the
setting changes after restart by pressing the appropriate F key).

2. After the restart the TPM will be prepared and you can then use the Actions menu
to Turn TPM off, Change Owner Password, Clear TPM or Reset TPM Lockout.

3. A wizard will help take you through any setup steps.

Figure6 - 31
TPM Actions Menu

. |
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BitLocker

BitLocker Drive Encryption can be used in conjunction with the TPM to encrypt
data on the disk. Access the Microsoft BitL ocker Drive Encryption control panel
applet from the Windows control panel (System and Security).

1. Click Turn on Bit Locker.
2. Follow the on-screen instructions to setup BitLocker, and make sure you have a
removable media (e.g. a USB flash drive) to store saved recovery keys etc.

Figure6 - 32
BitLocker Drive
Encryption

. |
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Wireless Display uses your Wireless LAN module/WLAN Bluetooth Combo mod-
ule (you need to make surethat your video adapter/display deviceiscompatible
with your particular WL AN/Combo module) in conjunction with a compatible
video adapter/display device (purchased separately) to allow you to display the
contents of the notebook display on another display (e.g. HDTV), without the need
to have cables stretching across a room.

Y ou can use the wireless display to play games, browse the internet, display videos
or photo slide shows on your TV/externa display without using HDMI or A/V ca
bles.

Before configuring Wireless Display you will need to set up your compatible
adapter with your display/speakers. Connect the adapter usingan HDMI or A/V ca
ble and turn on the display (or in the case of speakers connect them to the wireless
speaker adapter with the cables provided with the adapter), and then set the display
to the appropriate input channel (see the documentation supplied with your compat-
ible adapter/display for full details).

Note that no driver or application is required for wireless display in Windows 8.1.

Modules & Options

4

Compatible
Adapters

For a list of compatible
adapters check the vid-
eo adapter/display de-
vice documentation, or

with  your
supplier.

distributor/ a
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Wireless Display Configuration

Note that no driver or application is required for wireless display in Windows 8.1.
Go the Charms Bar, select Devices.

Click Project.

Click Add a wireless display.

PR

Figure6 - 33
Add a Wireless
Display
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5. The system will then search for compatible display devices (this may take up to
60 seconds so allow time for this to complete).

Figure6 - 34

Searching For
J Devices

6. Double-click any detected display device in the list.
7. You may then need to input a pin number for the device to which you are
connecting.
8. Click Next.
Figure6 - 35
Enter PIN

.|
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9. The display will then connect (for specific settings for your display see the
documentation supplied with your compatible adapter/display for full details).

10. To disconnect from the display you can select it in PC and Devices > Devices and
click Remove Device > Yes; or go to the Project menu (Charms Bar > Devices)
and click Disconnect.

Figure6 - 36

b Remove Device/ < >

Disconnect

S

Remove device
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Chapter 7: Troubleshooting

Overview

Should you have any problemswith your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’'t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautionsin the preface.
If al elsefails, talk to your service representative. Y ou should also make a record of what happened and what
remedies you tried.

Of course, if something goeswrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you' ve tried everything, and the system still won't cooperate, try turning it off
for afew minutes and then rebooting. Y ou will lose any unsaved data, but it may start working again. Then call
your service representative.

. |
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Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working.

Power - Isthe computer actually plugged into aworking electrical outlet? If plugged into apower strip,
make sureit is actually working. Check the LED Power & Communication Indicators (see” LED Indica-
tors’ on page 1 - 9) to see the computer’s power status.

Connections - Check al the cables to make sure that there are no loose connections anywhere.

Power Savings - Make sure that the system is not in Hiber nate or Sleep mode by pressing the keys config-
ured in your Power Options (see “ Power-Saving States” on page 3 - 7), the Fn + F12 key combination, or
power button to wake-up the system.

Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
Ness.

Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive.

.|
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Backup and General Maintenance

» Always backup your important data, and keep copies of your OS and programs safe, but close to hand.
Don't forget to note the serial numbersif you are storing them out of their original cases, e.g. inaCD wal-
let.

* Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with
your OS, or buy the more powerful dedicated programs to do so.

» Write down your passwords and keep them safe (away from your computer). Thisis especially important if
you choose to use a Super visor password for the BIOS (see “ The Setup Utility” on page5 - 2).

» Keep copiesof vital settingsfiles such as network, dialup settings, mail settings etc.(even if just brief notes).

N2
2

Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-
ranty.
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Viruses

» Ingtal an Anti-Virus program and keep the definitionsfile (the file which tells your program which viruses
to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tionsfile updates are usually downloadable directly from the internet.

» Becareful when opening e-mail from sources you don’'t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

» Keepa“Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic
information which allows you to startup your computer) handy. You may refer to your OS's documentation
for instructions on how to make one, and many Anti-Virus programs will also provide such adisk (or at
least instructions on how to make one).
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Upgrading and Adding New Hardware/Software

Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are
doing, otherwise you will risk severely damaging your system.

Don’'t open your computer or undertake any repair or upgrade work if you are not comfortable with what
you are doing.

Read the documentation. We can assume, since you are reading this that you are looking at the computer’s
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by
the installation of new hardware and/or software. Always refer to the documentation of any new hardware
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

When installing a new device always make sure the device is powered on, and in many cases you will need
to restart the computer. Always check that all the cables are correctly connected.

Make sure you have installed the drivers for any new hardware you have installed (latest driver filesare
usually available to download from vendor’s websites).
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» Thoroughly check any recent changes you made to your system as these changes may affect one or more
system components, or software programs. If possible, go back and undo the change you just made and see
if the problem still occurs.

» Don't over complicate things. The less you have to deal with then the easier the source of the problem may
be found; Example - if your computer has many devices plugged into its ports, and a number of programs
running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices
and restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and
removing devices and restarting where necessary) will often find the source of a problem, although this may
be time consuming.
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Problems and Possible Solutions

Problem

Possible Cause - Solution

You turned on the power but it doesn't
work.

Battery missing / incorrectly installed. Check the battery bay, make sure the
battery is present and seated properly (the design of the battery only allows it to
go in one way). Make sure there’s nothing interfering with the battery contacts.

The battery LED power indicator ,is
blinking orange.

Low Battery. Plug in the DC power source. If the computer doesn't start up
immediately, turn it off then on again.

You are losing battery power too quickly.

The system is using too much power. If your OS has a Power Options scheme
(see “Power Plans” on page 3 - 5) check its settings. You may also be using a
peripheral device/lUSB device that is drawing a lot of power.

Actual battery operating time is shorter
than expected.

The battery has not been fully discharged before being recharged. Make sure
the battery is fully discharged and recharge it completely before reusing (see
“Battery Information” on page 3 - 14).

Power Options have been disabled. Go to the Control Panel in Windows and
re-enable the options.

A peripheral device/lUSB device is consuming a lot of power. Turn off/fremove
the unused device to save power.

The battery doesn’t to be

charging.

appear

You my have battery chargung turned off. Use the Fn + 6 key combination to
toggle battery charging on/off (see “Use of Fn + 6 to Enable/Disable Battery
Charging” on page 3 - 17 & “Function/Hot Key Indicators” on page 1 - 13).
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Problem

Possible Cause - Solution

The computer feels too hot.

Make sure the computer is properly ventilated and the Vent/Fan intakes are not
blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn
it off for an hour. Make sure the computer isn't sitting on a thermal surface (see
“Overheating” on page 1 - 18). Make sure you're using the correct adapter.

Make sure that your notebook is completely powered off before putting it into a
travel bag (or any such container). Putting a notebook which is powered on in a
travel bag may cause the Vent/Fan intakes to be blocked.

Nothing appears on screen.

The system is in a power saving mode. Toggle the sleep/resume key
combination, Fn + F4 (see “Configuring the Power Buttons” on page 3 - 9).

The screen controls need to be adjusted. Toggle the screen control key
combinations Fn + F8/F9. If you're connected to an external monitor, make sure
it's plugged in and turned on. You should also check the monitor’s own
brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key
combination, Fn + F7. If an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

No image appears on the external
monitor | have plugged in and powered
on.

You haven't installed the video driver and configured it appropriately from the
Control Panel. See Appendix C for instructions on installing and configuring
the video driver.
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Problem

Possible Cause - Solution

You forget the boot password.

If you forget the password, you may have to discharge the battery of the CMOS.
Contact your service representative for help.

AN
Ik

Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.

The sound cannot be heard or the volume
is very low.

The volume might be set too low. Check the volume control in the Volume
Control Panel in the Windows notification area, or use the key combination Fn
+ F5 and F6 (see “Function/Hot Key Indicators” on page 1 - 13) to adjust.

The CD/DVD cannot be read.

The CD/DVD is dirty. Clean it with a CD/DVD cleaner kit.

The CD/DVD tray will not open when
there is a disc in the tray.

The CD/DVD is not correctly placed in the tray. Gently try to remove the disc
using the eject hole (see “Loading Discs” on page 2 - 3).

The DVD regional codes can no longer
be changed.

The code has been changed the maximum 5 times. See “DVD Regional
Codes” on page 2 - 5.

Unwelcome numbers when

typing.

appear

Num Lock is turned ON (see “Function/Hot Key Indicators” on page 1 - 13).
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Problem

Possible Cause - Solution

| am sliding my finger up and down on the
right side of the Touchpad to scroll a
Window and the Touchpad does not
respond.

There are different Touchpad versions available on this computer, and this
version requires tapping/holding to scroll. Either tap repeatedly, or hold the
finger down, at the top or bottom right of the Touchpad (depending on the
scrolling direction required) to scroll the window.

work.

4

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will
detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not

The system freezes or the screen goes
dark.

The system’s power saving features have timed-out. Use the AC/DC adapter,
press the sleep (Fn + F4) key combination, or press the power button if no LEDs
are lit.

The system never goes into a power
saving mode.

Power Options features are not enabled. Go to the Windows Power Options
menu and enable the features you prefer (see “Power-Saving States” on
page 3 - 7). Make sure you have enabled Hibernate mode from the control
panel.

The Wireless LAN/Bluetooth modules
cannot be detected.

The modules are off as the computer is in Airplane Mode. Go to the Charms
Bar and select Settings and then click the WiFi icon (Airplane mode should be

Off).
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Problem

Possible Cause - Solution

The PC Camera module cannot be
detected.

The module is off. Press the Fn + F10 key combination in order to enable the
module (see “Function/Hot Key Indicators” on page 1 - 13). Run the camera
application to view the camera picture.

The Wireless LAN/Bluetooth modules
cannot be configured.

The driver(s) for the module(s) have not been installed. Make sure you have
installed the driver for the appropriate module (see the instructions for the
appropriate module in “Modules & Options” on page 6 - 1).

A file cannot be copied to/from a

connected Bluetooth device.

The transfer of data between the computer and a Bluetooth enabled device is
supported in one direction only (simultaneous data transfer is not
supported). If you are copying a file from your computer to a Bluetooth enabled
device, you will not be able to copy a file from the Bluetooth enabled device to
your computer until the file transfer process has been completed

| cannot obtain high speed Bluetooth data
transfer.

To obtain high speed Bluetooth data transfer take into account the following:

» Toachieve high speed transfer speeds, both devices must support high
speed data transfer (i.e both the computer and the Bluetooth compati-
ble device you are connecting to).

e Check your Bluetooth compatible device's documentation to confirm it
supports high speed data transfer, and for configuration information.
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Problem

Possible Cause - Solution

| have used Update Driver in Device
Manager (Unknown device > Other
Devices) to try and install the Airplane
Mode driver. Windows encountered a
problem in attempting to update the driver,
and a yellow exclamation mark appears
in Device Manager against the Unknown
device.

It is very important that the drivers are installed in the order indicated in Chapter
4 (which is the numbered installation order on the Device Drivers & Utilities +
User’s Manual disc). This issue can occur when drivers are manually installed,
and not in the correct order.

If you have attempted to Update Driver from the Device Manager control panel
and have encountered problems, then use the method below to correct this:

To correct this problem:

1. Go tothe Programs and Features (Programs) control panel in
Windows.

2. Select any installed Airplane Mode driver item (e.g. Insyde Airplane
Mode HID Mini-Driver), and click Uninstall/Change to uninstall the
current driver.

3. Restart the computer.

4. Insert the Device Drivers & Utilities + User’'s Manual disc and click
Install Drivers (button).

5. Double-click the Airplane Driver item in the menu.

6. Follow the instructions to install the correct driver (you will need to
restart the computer as part of the installation process).
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Problem Possible Cause - Solution

| have connected a Bluetooth Mouse but | This is an issue with some mouse models and the Intel Wireless 7260 WLAN
it loses the Bluetooth connection and | and Bluetooth combo module series. To resolve this issue do the following:

no longer responds after a short period of
inactivity. Go to the Device Manager control panel in Windows.

Click the arrow alongside Bluetooth to expand the menu if required.
Double-click Intel(R) Wireless Bluetooth(R) 4.0 + HS Adapter.
Click the Power Management tab.

Make sure that the check box alongside “allow the computer to turn
off this device to save power” doesn’t have a check alongside it.

Click OK and close the control panel.

agrwbhE

o

Intel(R) Wireless Bluetooth(R) 4.0 + HS Adapter Prope... |

General | Advanced | Driver | Details E\rerrt

9 Intel{R) Wirsless Blustocth(R) 4.0 = H5 Adapter

QG

low the computer to tum off this device to save power:

Figure 7 - 1 - Device Manager (Bluetooth)

Problems and Possible Solutions 7 - 13



Troubleshooting

Problem

Possible Cause - Solution

When using a Bluetooth headset the
audio appears to be mono and not
stereo.

This is a common issue with Bluetooth headsets. To resolve this issue do the
following (you will need to repeat this procedure after every boot up, restart,
or when the system resumes from hibernation):

Go to the Devices & Printers control panel in Windows.
Double-click the Bluetooth headset.
Click Connect to complete the stereo connection.

Go to the Sound control panel in Windows.

Right-click (in the Playback tab) the Bluetooth Stereo Audio device
(the default device is Headset).

Click Connect to complete the stereo connection.

NEOWDNE
Py}

w
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3G/4G Module PIN Code & Power-Saving

Note that there may be someissueswhen aPIN Codeis set for the 3G/4G modulein Windows, if Mobile Broad-
band has been turned off, and the system has resumed from a power-saving state. To prevent any issuesit is
recommended that you simply do not enable a PIN for the 3G/4G module. The following provides instruc-
tions for disabling the PIN code.

Disabling a PIN code for a 3G/4G Module

1. Go tothe Charms Bar.
2. Click Change PC Settings.

P'Q

* I‘u) o)
67

Available Brightness

2 ¢

Notifications Power Keyboard

@ )

hange PC settings )

Figure7 - 2 - Change PC Settings
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Click Network.

Click the broadband connection under Mobile Broadband.

Scroll down to Security and click Remove PIN.

Enter the current PIN number and click OK.

It is recommended that you do not Enable a PIN for the 3G/4G module.

-

NooM®

-
-

Figure 7 - 3 - Disable PIN
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Resolving the “Insert a SIM” issue with the 3G/4G Module (Windows 8.1)

1. If a PIN was set for the 3G/4G module, you have then switched Mobile broadband off (or put the system in
Airplane Mode) in Networks, and the system has just resumed from a power-saving state the following error
may occur.

On resuming from the power-saving state the standard procedure would be to go to Networks in the Charms
Bar and turn on Mobile broadband.

Go to the Charms Bar.

Select Settings and you will then note that the WiFi icon will read Unavailable.

Standard procedure would be to click the connection and enter the PIN number to unlock the connection.

In this instance you will note that the Mobile broadband connection will read Insert a SIM.

In this case you will need to restart the computer.

After system restart you can then connect to the Mobile Broadband as normal.

To fully resolve this issue it is recommended that you do not Enable a PIN for the 3G/4G module.

n
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Appendix A: Interface (Ports & Jacks)

Overview

The following chapter will give aquick description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.
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Notebook Ports and Jacks

Item

Description

Card Reader Port

The card reader allows you to use some of the latest digital storage cards. Push the card into the
slot and it will appear as a removable device.

DC-In Jack

Plug the supplied AC/DC adapter into this jack to power your computer.

External Monitor (VGA)
Port

This port allows you to connect an external monitor, or Flat Panel Display, to get dual video or
simultaneous display on the LCD and external monitor/FPD.

HDMI-Out Port

The HDMI-Out (High-Definition Multimedia Interface) is an audio/video connector interface for
transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or
Flat Panel Display etc. as a display device by means of a HDMI cable. Note that HDMI carries
both audio and video signals.

Headphone-Out Jack

Headphones or speakers may be connected through this jack. Note: Set your system’s volume to
a reduced level before connecting to this jack.
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Item Description
Microphone-In Jack Plug an external microphone in to this jack to record on your computer.
RJ-45 LAN Jack This port supports LAN (Network) functions.

Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

USB 2.0/1.1 Ports These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed
peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as
external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into

USB 3.0 Port the computer, and unplugged from the computer, without the need to turn the system off (if the
power rating of your USB device is 500mA or above, make sure you use the power supply which
350 comes with the device).

The USB 3.0 ports are denoted by their blue color; USB 2.0 ports are colored black. USB
3.0 will transfer data much faster than USB 2.0, and is backwards-compatible with USB 2.0.
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Appendix B: Control Center

Overview

The following chapter will give a quick description of the functions of the Control Center. The Control Center
givesquick accessto frequently used controls, power management features and enables you to quickly turn mod-
ules on/off. Click the Control Center iconsto toggle the appropriate function, or hold the mouse button down
and movethedial control where applicable. Certain functionswill automatically be adjusted when a power mode
is selected. The Control Center in Windows 8.1 works under the Desktop App and not under the Start screen.

4

Control Center Access

To run the Control Center press
the Fn + Esc key combination,
or double-click the icon in

the notification area of the task- ﬂ
bar.

Close the Control Center by
clicking the close icon in the
top right of the panel (move the
cursor onto the top right corner
of the panel to highlight it).

Figure B - 1 - Control Center
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Power Modes
Y ou can set a Power M ode by clicking the appropriate icon at the top of the Control Center. Each power
mode will affect the Power Conservation Mode, Airplane Mode, Power Plan and PC camera power etc.

You can click a Control Center icon to set an overall power mode and then click individual iconsin the
Control Center to power on/off the Touchpad and PC camera.

Modes Quiet Power Saving Performance Entertainment
Icon
Power Plan Balanced Power Saver High Performance Balanced
Power Conservation Mode Balance Energy Star Performance Balance
PC Camera ON OFF ON ON
TouchPad ON ON ON ON
Airplane Mode OFF ON OFF OFF

Table B - 1- Power Modes
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Control Center Menus
The Control Center contains 2 menu headings (System Program & Device) under the Power Modes. Click
the menu headings and then click any of the buttons outlined on the following pages.

Figure B - 2 - Control Center Menus
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Power Status (System Program) /
The Power Statusicon will show whether you are currently powered by the battery, or by the AC/DC adapter
plugged in to aworking power outlet. The power status bar will show the current battery charge state.

Brightness (System Program)
The Brightness icon will show the current screen brightness level. You can use the slider to adjust the screen
brightness or the Fn + F8/F9 key combinations, or use the Fn+ F2 key combination to turn off the LED backlight
(press any key to turn it on again).

Volume (System Program)
The Volume icon will show the current volume level. Y ou can use the slider to adjust the Volume or the Fn +
F5/F6 key combinations, or use the Fn+ F3 key combination to mute the volume.

Fan Speed (System Program)

Y ou can set thefan speed to M aximum (full power), Automatic or Custom from this menu item. The fan speed
will adjust itself automatically to control the heat of the CPU. However you can adjust the setting to maximum
if you prefer. Select Custom and click on the sliders to adjust the settings to your preference, however these set-
tings can be overridden by the system, as a safety precaution, if it requires heavier use of the fan.

4

Custom Settings

Click Save to retain customized settings, or Reset to select default settings.
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This system supports Energy Star power

management features that place computers

(CPU, hard drive, etc.) into alow-power sleep modes after a designated period of inactivity (see “ Power Con-
servation Modes’ on page 3 - 12). Click either the Perfor mance, Balanced or Energy Star button.

Sleep Button (System Program)
Click either the Hiber nate or Sleep buttons to have the computer enter the selected power-saving mode when
the Fn + F4 key combination is pressed (see “ Power-Saving States’ on page 3 - 7).

Desktop Background (System Program)
Clicking the Desktop Background button will allow you to change the desktop background picture.

Display Switch (System Program)
Click the Display Switch button to access the menu (or use the g@ + P key combination) and select the appro-
priate attached display mode.

Time Zone (System Program)
Clicking the Time Zone button will access the Date and Time Windows control panel.

TouchPad/PC Camera (Device)
Click either of these buttons to toggle the TouchPad or camera module' s power status. The icon will appear
dimmed when it is disabled. Note that the power status of the cameramoduleis a so effected by the Power M ode
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selected (see Table B - 1, on page B - 2).

Caps Lock/Scroll Lock/ Number Lock/Airplane Mode
Click the button to toggle the appropriate lock mode and Airplane Mode.
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Appendix C: Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features’ on
page 1 - 29.

Video Driver Installation

Make sureyou install the driversin the order indicated in Table 4 - 1, on page 4 - 3.

1. Insertthe Device Drivers & Utilities+ User’s Manual disc and click I nstall
Drivers (button).

2. Click 2.Install VGA Driver > Yes.

3. Click Next > Yes> Next > Next.

4. Click Finish to restart the computer.

Note: After installing the video driver go to the Display control panel to adjust the
video settings to the highest resolution.

Dynamic Video Memory Technology

Intel® DVMT automatically and dynamically alocates as much (up to 1748MB)
system memory (RAM) as needed to the integrated video system (the video driver
must beinstalled). DVMT returns whatever memory is no longer needed to the op-
erating system.

. |
Video Driver Installation C - 1

4

Video Card Options

Note that card types,
specifications and driv-
ers are subject to contin-
ual updates and
changes. Check with
your distributor/supplier
for the latest details on
video cards supported.

DVMT Notes

DVMT is not local video
memory.

DVMT will not function
in MS-DOS. DOS uses
the legacy memory indi-
cated.
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Intel® HD Graphics Control Panel

Advanced video configuration options are provided by the Intel®@ HD Control Pan-
el. To access the control panel see below and overleaf:

1. Click the Intel® HD Graphics Control Panel icon in the Apps screen.

FigureC-1
Apps Screen
Intel® HD Graphics
Control Panel

(seeover)
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OR

2. Right-click the Desktop and select Graphics Properties from the menu.

OR

3. Click Advanced settings in the Screen Resolution control panel in Windows.

4. Click the Intel(R) HD Graphics Control Panel tab and click Graphics Properties
(button).

5. Double-click the Intel(R) HD Graphics control panel in the Windows Control
Panel.

FigureC- 2
Intel® HD Graphics
Control Panel
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Y ou may make changesto any of the graphics properties by clicking the appropriate
menu panel and adjusting the settings from the menus.

FigureC- 3
Intel® HD Graphics
Control Panel
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Sub-Menus
Some of the menu panelswill also have sub-menus (in the top left corner of the menu
alongsidetheicon ) to display further configuration options.

FigureC-4
Intel® HD Graphics
Control Panel
Sub-Menus
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Display
Z \ Click either Display Settings or Color Settings to make display adjustments, in-
Multiple Display cluding configuration for any attached external displays.
At least one other dis-
play must be attached in < \;

order to view multiple
display selection op-
tions.

FigureC-5
Intel® HD Graphics
Control Panel
Display Settings
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Click the Display menu at the top of the screen to display the sub-menus. The M ul-
tiple Displays menu allows you to configure the display mode of any attached dis- Z
plays (see” Attaching Other Displays’ on page C - 17). Multiple Display
At least one other dis-
play must be attached in
order to view multiple
display selection op-
tions.

Audio Settings

Any attached active dis-
plays must have audio
capacity to allow audio
configuration.

FigureC-6

Intel® HD Graphics

Control Panel
Display Settings -
Multiple Displays
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The Custom Resolutions sub-menu allows you to adjust the display (or any at-
tached display) to any width, height, refresh rate, color depth and underscan percent-
age of your choice. Note that incorrect settings can cause system instability and even
possible component damage, so thisis adjusted at your own risk.

FigureC-7
Intel® HD Graphics
Control Panel
Display Settings -
Custom
Resolutions

C - 8 Intel® HD Graphics Control Panel



Video Driver Controls

3D

This menu allows you to choose how 3D images are displayed. Performance Qual-
ity displaysthe most detail, Balanced M ode provides better computer performance
with good quality and Custom allows you to configure the Anisotropic Filtering
and Vertical Sync and features to your preferences. Click Apply to save changes.

FigureC-8
Intel® HD Graphics
Control Panel 3D
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Options and Support
Hot Key Manager in Optionsand Support allowsyou to create hot keysfor open-
ing the application, rotating the display, scaling etc. Click Apply to save changes.

FigureC-9
Intel® HD Graphics
Control Panel
Options and
Support
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Click the Options menu at the top of the screen to display the sub-menus. The In-
formation Center provides details on System Information, the Built-1n Display Z
and any attached displays.

Preferences
Go to the Preferences
sub-menu in Options to
configure the preferences
for the Intel® HD Graphics
Control Panel.

Make sure you Enable
Tray Icon to display the In-

tel® HD Graphics Control
Panel icon in the notifica-
tion area of the taskbar (as
below).

FigureC- 10

Intel® HD Graphics
Control Panel
Options -
Information Center
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FigureC- 11
Intel® HD Graphics
Control Panel -
Video
(Color
Enhancement)

Video

The Video Profiles menu allows you to brighten or darken movies, or to switch to
vivid colors. The Preview image will display a sample image using the current set-
tings. You can Save Profile and name the Profile to recall the settings at any time.
Click Apply to save changes (select Color Enhancement, | mage Enhancement,
Image Scaling or Gamut M apping from the menu).
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Click the Video menu at the top of the screen to display the sub-menus.The Image
Enhancement menu allows you to adjust the Sharpness, Skin Tone Enhance-
ment, Noise Reduction, Contrast Enhancement and Film M ode Detection etc.
Click Apply to save changes.

FigureC - 12
Intel® HD Graphics
Control Panel -
Video
(Image
Enhancement
Basic)
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Turn Image Scaling on, and use the sliders to adjust the scaling.

FigureC- 13
Intel® HD Graphics
Control Panel Video

Image Scaling
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Power

There are two separate menus to adjust the power settings for whenever the comput-
er isPlugged In or On Battery. Maximum Battery Life will reduce graphics per-
formance for power saving, Balanced will provide full graphics performance when
required and minimize power consumption when inactive, and Maximum Perfor -
mance will give top graphics performance but requires more power.

FigureC- 14
Intel® HD Graphics
Control Panel -
Power

.|
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Display Devices & Options

Note that you can use external displays connected to the HDMI-Out port and/or ex-
ternal monitor port. See your display device manual to see which formats are sup-
ported.

4
Attaching Displays

When you first attach an external display you may find that the desktop does not occupy
the full screen area. Use either the display’s auto adjust/configure controls, or the Intel(R)
HD Graphics Control Panel to configure the full screen display.

Display Mode Description
Single Display One of the connected displays is used as the display device (PC
screen only or Second screen only).
TableC-1 _ _ _
C Display Modes Clone/Duplicate _Both connected displays output the same view and may be configured
independently

Extended / Extend B‘_oth connected displays are treated as separate devices, and act as a
virtual desktop

A number of connected displays are combined into a single

Collage o : : .
9 unified higher resolution for larger screen sizes
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Attaching Other Displays

. e
To Clone Displays: _ .
; ) ; ; Multiple Display

1. Attach your external display to the HDMI-Out port/external monitor port, and turn it on.
2. Go to the Intel(R) HD Graphics Control Panel control panel and click Display >

Multiple Displays (sub-menu). play must be attached in
3. Click Clone from the Select Display Mode menu. order to view Multiple
4. Click Apply, and OK to confirm the settings change. Display selection op-
5. Select the displays from the Select One or More Active Displays menu. tions.

At least one other dis-

FigureC- 15
Display > Multiple
Displays (Clone)
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4

Display Settings
Extended Desktop

You can have different
Colors, Screen Area
and Monitor Refresh
Rates for each display
device provided your
monitor can support
them.

You can drag the moni-
tor icons to match the
physical layout of your
displays. Icons and pro-
grams may also be
dragged between the
displays.

FigureC- 16
Display > Multiple
Displays (Extended)

To Enable Extended Mode;:

Attach your external display to the HDMI-Out port/external monitor port, and turn it on.
Go to the Intel(R) HD Graphics Control Panel control panel and click Display >

1.
2.

w

Multiple Displays (sub-menu).
Click Extended from the Select Display Mode menu.
Click Apply, and OK to confirm the settings change.

Click the appropri-
ate monitor icon
and drag it to match
the physica ar-
rangement you
wish to use (e.g. the
secondary display
may be extended
left/right/above/be-
low the primary dis-
play).
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To Enable Collage Mode:

1. Attach your external displays to the external monitor port and HDMI-Out port, and turn 4
them on.
2. Go to the Intel(R) HD Graphics Control Panel control panel and click Display > Collage Mode
Multiple Displays (sub-menu). Collage mode is used to
3. Click Collage from the Select Display Mode menu. combine a number of
4. Click Enable. displays into a single
5. Click Vertically or Horizontally to arrange and displays as required. unified higher resolution
6. Click Apply, and OK to confirm the settings change. for larger screen sizes,.

FigureC- 17
Display > Multiple
Displays (Collage)
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4

Windows Logo Key
= + P Key
Combination

You can use the 58 + P
key combination to
quickly bring up the Sec-
ond Screen menu.

You can also use the
Display Switch button
in the Control Center to
access the menu and
select the appropriate
attached display mode.

You can also use the Fn
+F7 key combination to
quickly access the Sec-
ond Screen menu in
Windows.

FigureC- 18
Second Screen
(Devices)

Attaching Other Displays - Devices (Charms Bar)

Y ou can configure attached displays from Devices (in the Charms Bar).

Attach your external display to the HDMI-Out port/external monitor port, and turn it on.
Go the Charms Bar, select Devices.

Click Project (you may need to click Second Screen).

Click on any one of the options from the menu to select PC screen only,
Duplicate, Extend or Second screen only.

PR
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Configuring an External Display In Windows

1.

2.
3.
4

Attach your external display to the HDMI-Out port/external monitor port, and turn it on.
Go to the Screen resolution control panel (see page 1 - 30) in the Desktop app.
Click the Detect button.

The computer will then detect any attached displays.

FigureC - 19
Screen Resolution
Multiple Displays

Attaching Other Displays - Devices (Charms Bar) C - 21
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5. You can configure the displays from the Multiple Displays menu.

FigureC- 20
Screen Resolution
Multiple Display
Options

» Duplicate these displays - Shows an exact copy of the main display desktop on

the other display(s)
» Extend these displays - Treats both connected displays as separ ate devices
» Show desktop only on 1/2 - Only one of your displaysis used.

.|
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HDMI Audio Configuration

HDMI (High-Definition Multimedia I nterface) carries both audio and video signals.
In some cases it will be necessary to go to the Sound control panel and manually
configure the HDMI audio output as per the instructions below.

1.
2.
3.

Go to the Control Panel.

Click Sound (Hardware and Sound) and click Playback (tab)

Depending on your display, the playback device may be selected, however in some
cases you may need to select the audio device and click Set Default (button).
Double-click the device to access the control panel tabs illustrated overleaf.

4

Volume Adjustment

The sound volume level
can be set using the vol-
ume control in the Set-
tings menu in the
Charms Bar.

FigureC- 21
Sound - HDMI
Device (set Default)
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5. Adjust the HDMI settings from the control panel tabs.
6. Click OK to close the Sound control panel.

Figure C - 22
HDMI Device
Properties
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HDMI Notes
» Connect adevice with HDMI support to the HDMI-Out port BEFORE attempt- A
ing to play audio/video sources through the _device. Other Applications
*To play audio sources through your external display’s (TV or LCD) speakers you . .
will need to go to the audio configuration control panel on the display and con- If you are using a third

party application to play
DVDs etc. from any at-
tached DVD device,
you will need to consult

figure the audio input accordingly (see your display device manual).

HDMI Video Configuration

1. Connect an HDMI cable from the HDMI-Out porlt to your extgrnal display. the application’s docu-
2. Configure your external display as per the instructions in “Attaching Other mentation to see the
Displays” on page C - 17. appropriate audio con-
3. Set up your external display (TV or LCD) for HDMI input (see your display device figuration (the applica-
manual). tion must support digital
4. You can now play video/audio sources through your external display. to analog translation).

.|
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Appendix D: Specifications
e

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your distributor/supplier for details.

.|
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Specifications

Intel® Core™ i7-5500U (2.4GHz)

4M L3 Cache, 14nm (14 Nanometer),

DDR3L-1600MHz, TDP 15W

Intel® Core™ i5-5200U (2.2GHz)

3M L3 Cache, 14nm (14 Nanometer),

DDR3L-1600MHz, TDP 15W

Intel® Core™ i3-5010U (2.1GHz)

3M L3 Cache, 14nm (14 Nanometer),

DDR3L-1600MHz, TDP 15W

Intel® Core™ i3-5050U (2.0GHz)

3M L3 Cache, 14nm (14 Nanometer),

DDR3L-1600MHz, TDP 15W

Intel® Pentium® 3805U (1.9GHz)

2M L3 Cache, 22nm (22 Nanometer),

DDR3L-1600MHz, TDP 15W

Intel® Celeron® 3755U (1.70GHz)

2M L3 Cache, 22nm (22 Nanometer),

DDR3L-1600MHz, TDP 15W

Intel® Celeron® 3205U (1.50GHz)

2M L3 Cache, 22nm (22 Nanometer),

DDR3L-1600MHz, TDP 15W

Model A:
14.0"/ 35.56cm HD (1366 * 768), 16:9
3.6mm thick Backlit Panel

Model B:

15.6"/ 39.62cm HD (1366 * 768), 16:9
3.8mm thick Backlit Panel

OR

15.6"/39.62cm FHD (1920 * 1080), 16:9
3.4mm thick Backlit Panel

Dual Channel DDR3L

Two 204 Pin SO-DIMM Sockets
Supporting DDR3L 1600 MHz Memory
Modules (real operational frequency
depends on the FSB of the processor)

Memory Expandable up to 16GB
Compatible with 2GB, 4GB or 8GB Modules

Intel® HD Graphics 5000

(Integrated with i7-5500U / i5-5200U/ i3-
5010U/ i3-5005U CPUSs)

Dynamic Frequency

Intel Dynamic Video Memory Technology
up to 1.7MB

Microsoft DirectX®11.1 Compatible

Intel® HD Graphics

(Integrated with Pentium® 3805U /
Celeron® 3755U/ Celeron® 3205U
CPUs)

Dynamic Frequency

Intel Dynamic Video Memory Technology
up to 1.7MB

Microsoft DirectX®11.1 Compatible

One Changeable 9.5mm(h) Super Multi/
Blu-ray Combo Optical Device Drive with
SATA Interface (Factory Option)

Dummy Optical Device Drive (Factory
Option)

See overleaf
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One Changeable 2.5" 9.5 mm /7.0 mm (h)
HDD with SATA (Serial) Interface

MSATA SSD (Solid State Drive) with
SATA (Serial) Interface (Factory Option
for computers with i7-5500U, i5-5200U
& i3-5010U CPUs)

High Definition Audio Interface
Built-In Microphone
2 * Built-In Speakers

Built-in Touchpad with Multi-Gesture and
Scrolling Functionality

Isolated A4 Size Keyboard (Model A)

Full Size Isolated Keyboard with Numeric
Pad (Model B)

Model A:
One USB 2.0 Port

Model B:
Two USB 2.0 Ports

All Models:

Two USB 3.0 Ports

One External Monitor Port

One HDMI-Out (High-Definition
Multimedia Interface) Port (with HDCP)
One Headphone-Out Jack

One Microphone-In Jack

One RJ-45 LAN Jack

One DC-In Jack

Embedded Multi-In-1 Card Reader

- MMC/ RS MMC

- SD/ Mini SD / SDHC/ SDXC

- MS/ MS Pro/ MS Duo

Note: Some of these cards require PC
adapters that are usually supplied with
the cards.

For All Model CPUs:
Two Mini-Card Slots:

Slot 1 for Half Size Mini-Card WLAN
Combo Module with PCle & USB Interfaces

For i7-5500U / i5-5200U / i3-5010U CPUs:
Slot 2 for Full Size Mini-Card mSATA
SSD with SATA Interface

OR

Slot 2 for LTE or UTMS/HSPA (3G/4G)
Module + Mini-Card interface adapter for
M.2 3042 Card with USB interface
(Factory Option)

For i3-5005U, Pentium® 3805U / Celeron®
3755U / Celeron® 3205U CPUs:

Slot 2 for LTE or UTMS/HSPA (3G/4G)
Module + Mini-Card interface adapter for
M.2 3042 Card with USB interface
(Factory Option)

Built-In 10/100/2000Mb Base-TX
Ethernet LAN

Intel® Wireless-N 3160 (1*1 802.11 ac)
Half Mini-Card PCle WLAN + Bluetooth
Combo Module (Factory Option)

Intel® Wireless-N 7260 (2*2 802.11 b/g/n)
Half Mini-Card PCle WLAN + Bluetooth
Combo Module (Factory Option)

3rd Party WLAN 802.11b/g/n Half Mini-
Card Module (Factory Option)
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3rd Party Combo WLAN (802.11b/g/n)
and Bluetooth v4.0+LEHalf Mini-Card
Module with PCle Interface (Factory
Option)

1.0M HD HD Video Camera Module with
USB interface (Factory Option)

3G UTMS/HSPA+ M.2 3042 Card Module
(Factory Option)

OR

4G LTE M.2 3042 Card Module (Factory
Option)

Quad-band GSM/GPRS (850 MHz, 900
MHz, 1800 MHz, 1900 MHz)

UMTS WCDMA FDD (2100 MHz)

Note that UMTS modes CAN NOT be
used in North America

Supports Wake on LAN

Supports Wake on USB

Supports Wake on RTC Alarm (AC Mode
Only)

Full Range AC/DC Adapter
AC input 100 - 240V, 50 - 60Hz,
DC Output 19V, 2.1A (40 Watts)

Removable 6 Cell Smart Lithium lon
Battery Pack 48.84WH

Removable 6 Cell Smart Lithium lon
Battery Pack 62.16WH (Factory Option)

Security (Kensington® Type) Lock Slot
BIOS Password
TPM 2.0 (Factory Option)

Painted Style (For some Model designs)
Intel® Smart Connect Technology

LED Indicators - Power/Suspend, Battery,
HDD/ODD, Airplane Mode, Camera

Windows® 8.1

One 48Mb SPI Flash ROM
AMI BIOS

Temperature
Operating: 5°C - 35°C
Non-Operating: -20°C - 60°C

Relative Humidity
Operating:
Non-Operating:

20% - 80%
10% - 90%

Model A:

340mm(w) * 241mm(d) * 11 - 25.4mm(h)
(Height excluding battery area)

2.15 kg *Barebone system with 48.84WH
Battery & ODD

Model B:

374mm(w) * 252mm(d) * 14 - 25.4mm(h)
(Height excluding battery area)

2.2kg *Barebone system with 48.84WH
Battery & ODD

*A barebone system does not include the HDD,
RAM, adapter, power cord, VGA card & factory
option modules (weight tolerance within +/- 5%).
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Notice

The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.

©November 2014

Trademarks
Intel, Pentium and Intel Core are trademarks/registered trademarks of Intel Corporation.



Preface

R&TTE Directive
Thisdeviceisin compliance with the essential requirements and other relevant provisions of the R& TTE Direc-
tive 1999/5/EC.

Thisdevice will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Lux-
embourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland,
United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slov-
enia.

ErP Off Mode Power Consumption Statement:
Thefigures below note the power consumption of thiscomputer in compliance with European Commission (EC)
regulations on power consumption in off mode:

« Off Mode <0.5W
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CE Marking

This device has been tested to and conforms to the regulatory requirements of the European Union and has at-
tained CE Marking. The CE Mark is a conformity marking consisting of the letters“CE”. The CE Mark applies
to products regulated by certain European health, safety and environmental protection legislation. The CE Mark

is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his
product in the European market.

This product conforms to the essential requirements of the R& TTE directive 1999/5/EC in order to attain CE
Marking. A notified body has determined that this device has properly demonstrated that the requirements of the
directive have been met and hasissued afavorable certificate of expert opinion. As such the device will bear the
notified body number 0560 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product.
Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.
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FCC Statement

(Federal Communications Commission)

Y ou are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limitsfor aClass B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonabl e protection against harmful interferencein
aresidential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, thereisno guarantee that interference will not occur in aparticular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

« Connect the equipment into an outlet on acircuit different from that to which the receiver is connected.
» Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
And

2. This device must accept any interference, including interference that may cause undesired operation of the
device.
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FCC RF Radiation Exposure Statement:
1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator

and your body.

N2
2

Warning

Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the

equipment.
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IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.

4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may
explode. Check with local codes for possible special disposal instructions.

5. This product is intended to be supplied by a Listed Power Unit according to the model’s requirements:

Full Range AC/DC Adapter - AC Input 100 - 240V, 50 - 60Hz, DC Output 19V, 2.1A (40W) minimum.

This Computer’s Optical Device is a Laser Class 1 Product

Vi



Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions.

1.

Preface

Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

Do not expose the computer
to any shock or vibration.

surface.

Do not placeit on an unstable

Do not place anything heavy
on the computer.

Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-

aged.

Do not expose it to excessive
heat or direct sunlight.

Do not leaveit in a place
where foreign matter or mois-
ture may affect the system.

Don't use or store the com-
puter in a humid environment.

Do not place the computer on
any surfacethat will block the
Vents/Fan Intakes.

Vi
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Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other
strong magnetic fields. These can hinder proper performance and damage your data.

Follow the proper working procedures for the computer. Shut the computer down properly and don'’t forget

to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

Do not turn off the power
until you properly shut down
all programs.

Do not turn off any peripheral
devices when the computer is
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance
on your computer.

VIiI

Take care when using peripheral devices.

Use only approved brands of
peripherals.

Unplug the power cord before
attaching peripheral devices.




Power Safety

The computer has specific power requirements:

* Only use a power adapter approved for use with this computer.

* Your AC/DC adapter may be designed for international travel but it still requiresa
steady, uninterrupted power supply. If you are unsure of your local power specifications,

consult your service representative or local power company.

» The power adapter may have either a 2-prong or a 3-prong grounded plug. The third
prong is an important safety feature; do not defeat its purpose. If you do not have access

to acompatible outlet, have a qualified electrician install one.

*  When you want to unplug the power cord, be sure to disconnect it by the plug head, not

by itswire.

* Make sure the socket and any extension cord(s) you use can support the total current

load of all the connected devices.

» Before cleaning the computer, make sure it is disconnected from any external power

supplies (i.e. AC/DC adapter or car adapter).

cord if you are wet.

Do not plug in the power

Do not use the power cord if
it is broken.

Do not place heavy objects
on the power cord.

Preface
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Power Safety
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines and

power cord).

You must also remove
your battery in order to
prevent accidentally
turning the machine
on. Before removing
the battery discon-
nect the AC/DC
adapter from the
computer.
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Polymer Battery Precautions
Note the following information which is specific to polymer batteries only, and where applicable, this overrides
the general battery precaution information overleaf.

» Polymer batteries may experience aslight expansion or swelling, however thisis part of the battery’s safety mecha-
nism and is not a cause for concern.

e Use proper handling procedures when using polymer batteries. Do not use polymer batteries in high ambient tempera-
ture environments, and do not store unused batteries for extended periods.

See a'so the general battery precautionary information overleaf for further information.
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Battery Precautions

Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.

Do not remove any batteries from the computer while it is powered on.

Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even
if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly
resultinfire.

If you do not use the battery for an extended period, then remove the battery from the computer for storage.
Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.

Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-
ified service personnel.

Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries
may explode or leak if exposed to fire, or improperly handled or discarded.

K eep the battery away from metal appliances.

Affix tape to the battery contacts before disposing of the battery.

Do not touch the battery contacts with your hands or metal objects.

SN
ALK

Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,
under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
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Cleaning

Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing

Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply and then refer servicing to qualified service personnel under any of the following conditions:

*  When the power cord or AC/DC adapter is damaged or frayed.

 If the computer has been exposed to rain or other liquids.

 |If the computer does not work normally when you follow the operating instructions.

 If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
» If thereisan unusual odor, heat or smoke coming from your computer.

S
&
Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before restoring power to the system.

Also note the following when the cover is removed:

e Hazardous moving parts.
* Keep away from moving fan blades.

Xl
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Travel Considerations

Packing
Asyou get ready for your trip, run through this list to make sure the system is ready to go:

Check that the battery pack and any spares are fully charged.

Power off the computer and peripherals.

Close the display panel and make sure it's latched.

Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.

The AC/DC adapter uses voltages from 100 to 240 volts so you won't need a second voltage adapter. However,
check with your travel agent to see if you need any socket adapters.

Put the notebook in its carrying bag and secure it with the bag’s straps.

If you're taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters
and/or cables.

8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both
hardware and software. Make sure your documents are prepared.

SN
ALK

Power Off Before Traveling

agprwbPE

N o

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the vent(s)/fan intake(s)/outlet(s) to be blocked. To prevent your

computer from overheating make sure nothing blocks the vent(s)/fan intake(s)/outlet(s) while the computer is in use.

X1l
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On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these pointsin mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’'t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Bewar e of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
Theserestrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power whereyou can - If an electrical outlet isavailable, usethe AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from acold to awarm location, water vapor can condense inside the computer.
Wait afew minutes before turning it on so that any moisture can evaporate.

XV
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Developing Good Work Habits

Developing good work habitsisimportant if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the
level of your elbow. Keep your forearms, wrists, and hands in arelaxed position.

Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a
footrest if necessary.

Use a chair with aback and adjust it to support your lower back comfortably.

Sit straight so that your knees, hips and elbows form approximately 90-degree angles when
you are working.

Take periodic breaks if you are using the computer for long periods of time.

Remember to:

Alter your posture frequently.

Stretch and exercise your body several times aday.

Take periodic breaks when you work at the computer for long periods of time. Frequent
and short breaks are better than fewer and longer breaks.

XV



Preface

Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatiguein your neck and
shoulders.

Position the display to avoid glare or reflections from overhead lighting or outside sources of light.

Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
Position the display directly in front of you at a comfortable viewing distance.

Adjust the display-viewing angle to find the best position.

LCD Screen Care

To prevent image per sistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

Set the Windows Power Plansto turn the screen off after afew minutes of screenidle time.

Use arotating, moving or blank screen saver (this prevents an image from being displayed too long).
Rotate desktop background images every few days.

Turn the monitor off when the system isnot in use.

LCD Electro-Plated Logos

Note that in computers featuring araised LCD electro-plated logo, the logo is covered by a protective adhesive.
Due to general wear and tear, this adhesive may deteriorate over time and the exposed logo may develop sharp
edges. Be careful when handling the computer in this case, and avoid touching the raised LCD electro-plated
logo. Avoid placing any other items in the carrying bag which may rub against the top of the computer during
transport. If any such wear and tear develops contact your distributor/supplier.

|
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Quick Start Guide

Chapter 1. Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

e Chapter 2 A guideto using some of the main features of the computer e.g. the stor age devices (hard disk,
optical device, Multi-in-1 card reader), TouchPad & Mouse & Audio.

e Chapter 3  The computer’'s power saving options.

e Chapter 4 Theinstalation of the driversand utilities essential to the operation or improvement of some of the
computer’s subsystems.

e Chapter 5  An outline of the computer’s built-in software or BIOS (Basic Input Output System).

e Chapter 7 A quick guide to the computer’'s PC Camera, WirelessL AN, Combo Bluetooth & WLAN, TPM
(security), Intel and 3G/4G modules (some of which may be optional depending on your purchase
configuration).

e Chapter 7 A troubleshooting guide.

« Appendix A Definitions of the interface, ports/jackswhich allow your computer to communicate with external
devices.

» Appendix B Information on Control Center.

* Appendix C Information on the Video driver controls.

» Appendix D The computer’s specification.

. |
Overview 1 -1
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Advanced Users

If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “What to Install” on page4 - 1 and “BIOS Utilities” on page5 - 1 in the remainder of the User’'s
Manual. Y ou may also find the notes marked with a /Z of interest to you.

Beginners and Non-Advanced Users

If you are new to computers (or do not have an advanced knowledge of them) then
4 the information contained in the Quick Start Guide should be enough to get you up
Notes and running. Eventually you should try to look through all the documentation (more
Check the light colored detailed descriptions of the functions, setup and system controls are covered in the
boxes with the mark | remainder of the User's Manual), but do not worry if you do not understand every-
above to find detailed in- = thing the first time. Keep this manual nearby and refer to it to learn as you go. You
utors foatiroe. <™ | may find it useful to refer to the notes marked with a s indicated in the margin,
For amore detailed description of any of the interface ports and jacks see “ I nterface

(Ports & Jacks)” on page A - 1.

Warning Boxes

No matter what your level please pay careful attention to the warning and safety information indicated by the
2 symbol. Also please note the safety and handling instructions as indicated in the Preface.

1-2 Overview
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Not Included

Operating Systems (e.g. Windows 8.1) and applications (e.g. word processing, spreadsheet and database pro-
grams) have their own manuals, so please consult the appropriate manuals.

4

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “ Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the com-
puter and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order
listed. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If
your system hasn't been properly configured (your service representative may have already done that for you); refer to
Chapter 4 for installation instructions.

Ports and Jacks

See “Interface (Ports & Jacks)” on page A - 1 for a description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.

. |
Overview 1 -3



Quick Start Guide

System Startup

1. Remove all packing materials, and place the computer on a stable surface.

2. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.

3. Attach the AC/DC adapter to the DC-In jack on the left of the computer, then plug the AC power cord into an
outlet, and connect the AC power cord to the AC/DC adapter (make sure you use the adapter when first
setting up the computer, as to safeguard the computer during shipping the battery will be locked to not power
the system until first connected to the AC/DC adapter).

4. Use one hand to raise the lid/LCD to a comfortable viewing angle (do not exceed 127 degrees); use the other
hand to support the base of the computer (Note: Never lift the computer by the lid/LCD).

Z
127° Shutdown

Note that you should al-
ways shut your comput-
er down by choosing
the Shut Down com-
mand in Windows (see
page 1 - 39). This will
help prevent hard disk
or system problems.

Figure 1 - 1 - Opening the Lid/LCD & Computer with AC/DC Adapter Plugged-In

1 -4 System Startup
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System Software

Y our computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find the Windows 8.1 operating system is sup-
ported.

Note: In order to run Windows without limitations or decreased performance, your computer requires a mini-
mum 1GB of system memory (RAM).

4

Windows Versions

Note that the information included on the following pages is for Windows 8.1 (64-bit) only.

Windows OS

In order to run Windows 8.1 (64-bit) without limitations or decreased performance, your computer requires a minimum
2GB of system memory (RAM).

System Startup 1 -5
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Model Differences

This notebook series includes two different models that vary dlightly in design style, color and general appear-
ance. Not all themodel variants, colors, configurations, buttons etc., are pictured in thismanual. Note that though
your computer may look slightly different from that pictured throughout this manual, all ports, jacks and general
functions are the same for al the design styles (see Appendix D for further details). Model A Design stylel |

computersfeature a Multi Touch screen.

Feature Model A Model B
14.0" / 35.56cm HD (1366 * 768), HD+ (1600 * 900)
' 16:9 3.6mm or 3.0mm Thick Backlit Panel 15.6"/ 39.62cm HD (1366 * 768), FHD (1920 *
Display 1080), 16:9 3.8mm Thick Backlit Panel

For Model A Design | Only:
Multi Touch Screen

e A4 Size Isolated Keyboard Full Size Isolated Wln;:))//p}gzyboard with Numeric

USB 2.0 Ports One USB 2.0 Port Two USB 2.0 Ports

See “Dimensions & Weight” on page D - 5

Table 1 - 1 - Model Differences

L_________________________________________________________________________________________________________________________________________________|
1 -6 System Startup



LCD Panel Open - Model A
(2 o (3

2NZ
L&
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the WLAN & Bluetooth
module(s) are OFF if you
are using the computer
aboard aircraft by putting
the system in to Airplane
Mode (see

)-

Quick Start Guide

Figure 1 -2
LCD Panel Open
Model A

Built-in PC Camera
PC Camera LED
Built-In Microphone
LCD*

Power Button
Keyboard
Touchpad & Buttons

*Model A Design | in-
cludes a Touch Panel (not
pictured)

Noogk~owpdpeE

Note that the Touchpad and
Buttons has a valid opera-
tional area indicated within
the dotted lines above.

LCD Panel Open - Model A 1-7
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Figure 1 -3
LCD Panel Open
Model B

Built-in PC Camera
PC Camera LED
Built-In Microphone
LCD

Power Button
Keyboard
Touchpad & Buttons

NoogkrwbdpE

Note that the Touchpad and
Buttons has a valid opera-
tional area indicated within
the dotted lines above.

LCD Panel Open - Model B
(2 o (3

4]

1-8LCD Panel Open - Model B

I\
2 &
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the WLAN & Bluetooth
module(s) are OFF if you
are using the computer
aboard aircraft by putting
the system in to Airplane
Mode (see

)
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LED Indicators

The LED indicators on the computer display helpful information about the current status of the computer.

Icon Color Description
Orange DC Power is Plugged In
Green The Computer is On
Blinking Green The Computer is in Sleep Mode

Slow (20 second intervals)

o The Computer is in Sleep Mode and *Intel Smart Connect is Enabled
Blinking Green

Orange The Battery is Charging
Green The Battery is Fully Charged
Blinking Orange The Battery Has Reached Critically Low Power Status
Green Airplane Mode is ON (the WLAN, Bluetooth & 3G Modules are OFF)
Green Hard Disk Activity

Table 1 -2 - LED Indicators

*Intel® Smart Connect Technology is enabled by default to periodically, and briefly, wake the computer from Seep mode
in order to check email applications etc. Only certain Intel WLAN modules support this feature (see “ Intel® Smart Con-
nect Technology” on page 6 - 22 for more information).

LED Indicators 1 -9
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4

Other Keyboards

Keyboard - Model A

The keyboard has an embedded numerical keypad for easy numeric data input, and
function keys to change operational features instantly.

If your keyboard is dam-
aged or you just want to
make a change, you can
use any standard USB
keyboard. The system will
detect and enable it auto-
matically. However spe-

cial  functions/hot-keys

unique to the system’s Numerical Keypad

regular keyboard may not
work. o
Menu/Application Key
Windows Logo Key
Hold down the Fn Key

NumLk & ScrLk
and either NumLk or ;
Figure1-4-K rd -M I A
ScrLk to enable number gure eyboa d ode
or scroll lock, and check
the LED indicator for sta- /
tus.

NumLk &
ScrLk Keys

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLKk is on.

1-10Keyboard - Model A
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4

Other Keyboards

Keyboard - Model B

The keyboard has anumerical keypad for easy numeric datainput, and function keys

to change operational features instantly.

If your keyboard is dam-
| | | | aged or you just want to
make a change, you can

use any standard USB
keyboard. The system will
detect and enable it auto-
matically. However spe-

cial  functions/hot-keys
i he system’s
Keypad unique to t
regular keyboard may not
el /
Windows Logo Ke! Menu/Application Ke
 — PP Y NumLk & ScrLk

Hold down the Fn Key
and either NumLk or
ScrLk to enable number

Play/Pause Key

ScrLk &
NumLk Keys

Figure 1 - 5 - Keyboard - Model B

/ or scroll lock, and check
the LED indicator for sta-
Special Characters tus.

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLKk is on.

Keyboard - Model B 1 - 11
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Keyboard Shortcuts

4 The following Windows Logo Key (Winkey) keyboard shortcuts are useful for navi-

Windows Logo gation/operation in Windows 8.1.
Keyboard Shortcut

i Windows Logo .
Use the Windows logo Description

key ®@ + D key com- am Key +
bination to switch

Toggle between the Start screen and the foremost running app or the

from the Start screen Tap Winkey -

to the Windows Desk- Windows Desktop

top. C Display Charms menu
Menu/Application D Switch to the Windows Desktop and toggle show Desktop

Keyboard Shortcut
Switch to the Windows desktop and launch Windows Explorer with

When the Desktop app Computer displayed
iS running you can use
the Menu/Application
key E| on the key- | Open the Settings charm
board to act as a
mouse right-click. In
the Start screen this
function is useful to
quickly display Cus-
tomize Apps.

F Display file Search

Open the Connect charm

Lock the computer and display the Lock screen

Display the Second Screen menu (see Figure 1 - 26 on page 1 - 36)

Switch to the Windows Desktop and display the Run dialog box

N| ™| T| | X

Access the Customize Bar (see Figure 1 - 21 on page 1 - 31)

Table 1 - 3 - Keyboard Shortcuts

1-12 Keyboard - Model B
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Function/Hot Key Indicators

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition
to the basic function key combinations; visual indicators are available when the hot key utility isinstalled.

Keys Function Keys Function
En + Play/Pause (in Audio/Video Programs) Fn + Brightness Decrease/Increase
Fan Control Toggle PC Camera
En+ Automatic Fan Control / Fn+ Power Toggle
Full Power
Airplane Mode
Fn +
Fn + TouchPad Toggle Toggle
Turn LCD Backlight Off
Fn+ (Press a key to or use TouchPad to turn on) Fn+ Sleep Toggle
Number Lock
Fn + Mute Toggle Fn + NumLk Toggle
Fn + Volume Decrease/Increase Fn + ScrLk Scroll Lock
Toggle
Fn + Display Toggle Caps Lock Cﬁ.zzgg;k
Toggle Battery Charging
Fn + on/Off Fn + Esc Control Center Toggle

Table 1 - 4 - Function & Hot Key Indicators

.|
Function/Hot Key Indicators 1 - 13
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Windows Touch Screen Controls/Gestures

Model A design style Il computers incorporate a Touch Screen and this can be used to navigate through he in-
terfacein much the same way as amouse, touchpad and keyboard. Where you see theinstruction to click/double-
click an item in this manual, you can choose to tap/double tap the appropriate area of the screen instead. The
following gestures are useful when navigating the Windows interface.

» Swipefrom theright (Access the CharmsBar) - Pull your finger from the right side of the screen (in the
black area) to the left alittle bit to bring up the Charms Bar.

Figure 1 - 6 - Swipe from Right & Left

» Swipefrom theleft (Switch apps) - If multiple apps are running you can slide your finger from the left side
of the screen (in the black area) to the right to switch between apps.

» Swipedowly from the left (Snap apps) - Perform the same action above more slowly, to drag one app out
and display it side-by-side with the app that was already on your screen.

1 - 14 Windows Touch Screen Controls/Gestures
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» Swipefrom left and back (Display running apps) - Slide your finger from the left and quickly drag it back
towards the right to display alist of apps that are currently running. Tap any app to switch to it.

e Pull down from the top (Close app) - Close any running app by starting at the top area of the screen and
quickly pulling your finger about halfway down the screen.

» Swipe down/up (Customize menu) - Swiping the finger alittle bit down from the top, or up from the bot-
tom of the Start screen will bring up the menu with the Customize icon. Tap the Customize icon and then
select the app tiles, and slide them to any selected position to rearrange them.

Figure 1 - 7 - Swipe Up and Tap, Hold & Release (Desktop Right-Click)
» Swipedown on an item (Select/right-click) - Swipe down on any tile in the Start screen to select it and
bring up additional options.
* Tap, Hold & Release (Desktop right-click) - Tap the Desktop, hold until a square icon appears, and then
release to access the right click menu.

. |
Windows Touch Screen Controls/Gestures 1 - 15
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Touch Keyboard

If you need to type on screen then the Touch Keyboard will pop up when required (e.g. when you need to type
in aninternet URL address in Internet Explorer). When the Touch Keyboard is displayed you have several dis-
play/input options and these can be accessed from the icon [] [ at the bottom right of the
keyboard. To access the Touch Keyboard from the Desktop app click/tap the keyboard icon in the taskbar

Touch Keyboard Desktop app taskbar Icon

&123  Ctrl

Select Keyboard or Writing Pad Input
Figure 1 - 8 - Touch Keyboard

1-16 Touch Keyboard
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The Touch Keyboard allows you to input text without the use of an actual keyboard., and you can use writing
pad to write (continuously or one character at atime) or touch keyboard to input text. Use the Help menu for
further information.

Click Help

&123 Ctrl

Figure 1 - 9 - Touch Keyboard, Writing Pad Input & Help

Touch Keyboard 1 - 17
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Control Center

When in the Windows Desktop application (not in the Start screen) press the Fn + Esc key combination, or
double-click theicon  inthenactification area of thetaskbar to toggle the Control Center on/off. The Con-
trol Center givesquick accessto frequently used controls and enables you to quickly turn the camera/touch pad
on/off (see Appendix B for full details).

4

Control Center Access

To run the Control Center press the Fn + Esc key
combination, or double-click

the icon in the notification

area of the taskbar.

Close the Control Center by
clicking the close icon in O
the top right of the panel
(move the cursor onto the top

right corner of the panel to
highlight it).

Figure 1 - 10 - Control Center

. |
1 - 18 Control Center
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Front & Left Views - Model A Figure 1 - 11
Front & Left Views
0 Model A
9 1. LED Indicators
2.  Multi-in-1 Card
Reader

3. DC-In Jack
4. RJ-45 LAN Jack
5. External Monitor

Port
6. Vent/Fan Intake/
g Outlet
Multi-In-1 R
ulti-n-1 Card Reader 7. HDMI-Out Port
The card reader allows you to use the most popular digital storage card formats: 8. USB 3.0 Ports

MMC (MultiMedia Card) / RS MMC
SD (Secure Digital) / Mini SD / SDHC / SDXC
MS (Memory Stick) / MS Pro / MS Duo

USB 3.0 Port OR USB 2.0 Port

This model includes 2 * USB 3.0 ports and 1* USB 2.0 port. The USB 3.0 ports are denoted
by their blue color; the USB 2.0 port is colored black.

Front & Left Views - Model A 1-19
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Figure 1 - 12 Front & Left Views - Model B

Front & Left Views
Model B 0

1. LED Indicators 9
2. Multi-in-1 Card
Reader
3. DC-InJack
4, RJ-45 LAN Jack
5. External Monitor
Port
6. Vent/Fan Intake/
Outlet Multi-In-1 Card Reader

7. HDMI-Out Port
8. USB 3.0 Ports

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / RS MMC
SD (Secure Digital) / Mini SD / SDHC / SDXC
MS (Memory Stick) / MS Pro / MS Duo

USB 3.0 Port OR USB 2.0 Port

This model includes 2 * USB 3.0 ports and 2* USB 2.0 ports. The USB 3.0 ports are de-
noted by their blue color; the USB 2.0 ports are colored black.

1-20 Front & Left Views - Model B



Right & Rear Views - Model A
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4

Battery Information

Always completely discharge, then fully charge, a new battery before using it. Completely
discharge and charge the battery at least once every 30 days or after about 20 partial dis-
charges. See “Battery Information” on page 3 - 14 for full instructions.

USB 3.0 Port OR USB 2.0 Port

This model includes 2 * USB 3.0 ports and 1* USB 2.0 port. The USB 3.0 ports are denoted
by their blue color; the USB 2.0 port is colored black.

Quick Start Guide

Figure 1 -13
Right & Rear Views
Model A

1. Microphone-In
Jack

2. Headphone-Out
Jack

3. USB 2.0 Port

4. Optical Device
Drive Bay (for
CD/DVD Device)

5. Cable (CATV)
Antenna Jack (For
Optional TV Tuner)

6. Security Lock
Slot

.|
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Figure 1- 14 Right & Rear Views - Model B

Right & Rear Views

Model B

L. Microphone-in 00 0 © () ©
Jack

2. Headphone-Out
Jack

3. USB 2.0 Ports
4. Optical Device

Drive Bay (for i
CD/DVD Device)

5. Security Lock Battery Information
Slot

Always completely discharge, then fully charge, a new battery before using it. Completely
discharge and charge the battery at least once every 30 days or after about 20 partial dis-

charges. See “Battery Information” on page 3 - 14 for full instructions.

USB 3.0 Port OR USB 2.0 Port

These models include 2 * USB 3.0 ports and 2* USB 2.0 ports. The USB 3.0 ports are de-
noted by their blue color; the USB 2.0 ports are colored black.

.|
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Disk Eject Warning

Don't try to eject a CD/DVD while the system is ac-
cessing it. This may cause the system to “crash”. Stop
the disk first then eject it, or press the stop button
twice.

CD/DVD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to
an unexpected power interruption) you may push the
end of a straightened paper clip into the emergency
eject hole. Do not use a sharpened pencil or any ob-
ject that may break and become lodged in the hole.
Don't try to remove a floppy disk/CD/DVD while the
system is accessing it. This may cause the system to
“crash”.

Quick Start Guide

4

Changing DVD Regional Codes

Go to the Control Panel and double-click Device
Manager (Hardware and Sound), then click the +
next to DVD/CD-ROM drives. Double-click on the
DVD-ROM device to bring up the Properties dialog
box, and select the DVD Region (tab) to bring up the
control panel to allow you to adjust the regional code
(see “DVD Regional Codes” on page 2 - 5).

DVD region detection is device dependent, not OS-
dependent. You can select your module’s region
code 5 times. The fifth selection is permanent. This
cannot be altered even if you change your operating
system or you use the module in another computer.

.|
Right & Rear Views - Model B 1 - 23
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Figure 1 - 15
Bottom View
Model A

1. Vent/Fan Intake/
Outlet
2. Speakers

RS
Overheating

To prevent your comput-
er from overheating
make sure nothing blocks
the Vent/Fan Intake while
the computer is in use.

Bottom View - Model A

2NZ
2L &

Bottom Cover Removal Warning

Do not remove any cover(s) and /or screw(s) for the purposes of device upgrade as this may

violate the terms of your warranty.

If you need to replace/remove the hard disk/RAM/optical device etc., for any reason, please
contact your distributor/supplier for further information.

1 - 24 Bottom View - Model A
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Bottom View - Model B Figure 1 - 16

Bottom View
Q Model B

1. Battery

2. Vent/Fan Intake/
Outlet

3. Speakers

2§

Bottom Cover
Appearance

Note that some design
styles will have a bottom
cover that differs in ap-
pearance slightly form

/s \

_Zl/_ that pictured here.

Overheating

To prevent your comput-
Do not remove any cover(s) and /or screw(s) for the purposes of device upgrade as this may er from overheating
violate the terms of your warranty. make sure nothing blocks
the Vent/Fan Intake while
the computer is in use.

Bottom Cover Removal Warning

If you need to replace/remove the hard disk/RAM/optical device etc., for any reason, please
contact your distributor/supplier for further information.

Bottom View - Model B 1 - 25
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Removing the Battery for Model B Computers

It is possible to remove the battery from Model B computers. Follow the procedure
below to do so if you need to remove the battery.

1.Turn the computer off, and turn it over.

2.Slide the latch @ in the direction of the arrow.

3.Slide the latch @ in the direction of the arrow, and hold it in place.
4.Slide the battery out in the direction of the arrow @.

5.Reinsert the battery as illustrated below @.

6.Make sure the latches are returned to the lock position @.

o 2]

Figure 1 -17
Battery Removal

Model B
Computers Only 9

1 - 26 Removing the Battery for Model B Computers
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4

Windows Versions

Windows 8.1 Control Panel

Throughout this manual you will see an instruction to open the Control Panel.
Right-click the lower left hot corner to bring up the context menu (or use the Win-
dows Logo Key =@ + X key combination) and select Control Panel in both the | Note that the informa-

Desktop app or Start screen. tion included on the fol-
lowing pages is for the

latest updated version

of Windows 8.1 only.

Make sure you enable
Desktop app Windows Update in or-
der to get all the latest
security updates etc.
(see “Windows Up-
date” on page 4 - 8).

O~ <

Figure 1 - 18 - Windows Context Menu

Windows 8.1 Control Panel 1 - 27
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The Control Panel can be accessed in a number of waysin Windows 8.1.
» Click Search inthe Windows Charms Bar (see previous page) and the search pane will pop out. Type
Control Panel and select it from the results to the left.

* Click on ThisPC (in Apps, or you canto pin This PC to the Start screen), click on Computer in the
top menu and select Open Control Panel from the ribbon.

* When in the Desktop app (this does not apply to the Start screen) click on Settingsin the Windows
Charms Bar and select Control Panel from the menu.

* Click thearrow at the bottom of the Start screen and click Control Panel in Apps (Windows System).
* Right-click the Start button to bring up the menu and select Control Panel (see Figure 1 - 19 on page 1
- 29).

4

Keyboard Shortcut to Control Panel

You can also use keyboard shortcuts to access the Control Panel. Press the Windows logo key == and X to bring up
the context menu, and then press P to bring up the Control Panel. Alternatively press the Windows logo key == and R
to bring up the Run dialog box, and then type “Control Panel” and press Enter to access the Control Panel.

1-28 Windows 8.1 Control Panel
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Right-click the Start button in the Desktop app (or use the Windows Logo Key
28 + X key combination) to bring up an advanced context menu of useful features 4
such as Control Panel, Programs and Features, Power Options, Task Manager, Display Most
Search, File Explorer, Command Prompt, Device Manager and Network Connec- Recently Used
tions etc. Apps

If you are in the Start
screen, Desktop or an
app you can move your
mouse to the upper left
corner of the screen to

get back to the most re-
cently used app.

To view all the most re-
cently used Apps hover
over the top left of the
screen and then move
the mouse down along
the left side of the
screen to display the
list.

Move the mouse to the bottom left of the screen
and right-click the Start button to access the menu.

Figure 1 - 19 - Advanced Context Menu (Right-Click Start Button)

. |
Windows 8.1 Control Panel 1 - 29
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Windows 8.1 Start Screen & Desktop

The Apps, control panels, utilities and programs within Windows are accessed from the Start screen and/or
Windows Desktop app. The Desktop (which runsasan app within the Start screen) can be accessed by clicking
the Desktop item in the Start screen (or by using the Windows L ogo Key g@ + D key combination). Click the
arrow at the bottom of the Start screen to access Apps.

Figure 1 - 20 - Windows Start Screen

1 - 30 Windows 8.1 Start Screen & Desktop
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Apps & Tiles

The Start screen will contain a number of apps, and many more will be installed as you add more applications
etc. Not all of these apps can fit on one screen so you will often need use the dlider at the bottom of the screen
in order to view all the necessary Apps.

Accessing Pining/Unpinning All Apps

Y ou can add and remove thetiles for apps and control panelsin the Start screen. Right-click on an app to bring
up the context menu and you pin the App to (or unpin from) the Start screen, or to the taskbar.

Figure 1 - 21 - Apps

Windows 8.1 Start Screen & Desktop 1-31
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Desktop Application

When the Desktop app is running (click the app in the Start screen or use the Windows Logo Key g@ + D key
combination) you can use lower left hot corner to switch between the Start screen and the Windows Desktop
app. To do so move your mouse to hover over the bottom left corner of the Desktop app and left-click.

Move the mouse to the bottom left of the screen and click to switch
back to the Start screen.

Figure 1 - 22 - Desktop

.|
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The Charms Bar

Theright side of the screen (Start or Desktop) displaysthe CharmsBar. The CharmsBar containsthe Sear ch,
Share, Start, Devicesand Settings menus. To access up the Charms Bar move the cursor to the upper or lower
right corners of the screen, and then hover over one of the itemsin the Charms Bar to activate it (the bar will
be black when it is active), or use the Windows L ogo Key g@ + C key combination.

Figure 1 - 23 - Start Screen with Charms Bar
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Charms Bar Items

Search E: You can search for any file, application, Apps and control panel settings with instantaneous
results.

Share @) This button is used to share information with people viamail or social networks.

Sart .: Click to bring up the Start screen (the same function as pressing the Windows Logo Key or click-
ing the bottom left of the screen).

Devices B3] Click this button to change connected peripheral device settings e.g. an external display.

SettingsE]: This button gives instant access to the computer settings, such as Network, Audio, Notifica-
tions, Power and Keyboard (click Change PC Settingsto activate the PC Settings menu).

4

Charms Bar - TouchPad Access
To quick access the Charms Bar using the TouchPad:

1. Place your finger off the TouchPad (slightly to the right of the
pad resting on the computer).

2. Move your finger across to the left on to the TouchPad.

3. The Charms Bar will then pop-up.

Figure 1 - 24 - Settings Menu
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Windows 8.1 Taskbar

In many instances throughout this manual you will see an instruction to access the notification ar ea of the task-
bar (system tray). In Windows 8.1 the taskbar can be directly accessed from the Desktop application; if you
arein the Start screen you will need to move the cursor to the bottom of the screen to display the taskbar.

The taskbar is displayed at the bottom of the screen, and you can see the notification area (system tray) of the
taskbar in the bottom right of the screen. Some of the control panels and applications referred to during the
course of this manual can be accessed from here.

Figure 1 - 25 - Taskbar & Notification Area (System Tray)

Y ou can pin/unpin appsto/from the taskbar in much the same way asyou can to the Start screen (see“ Accessing
Pining/Unpinning All Apps’ on page 1 - 31).
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Video Features

Y ou can switch display devices, and configure display options, from the Display control panel (in Appear ances
and Personalization) in Windows when running the Desktop app (see “ Desktop Application” on page 1 - 32
and Appendix C). It is possible to quickly configure external displays from the Devices menu item in the
CharmsBar (see“The CharmsBar” on page 1 - 33).

To Configure Displays from Devices (Charms Bar):

1.

2.
3.
4

Attach your display to the appropriate port, and turn it on.

Go the Charms Bar, select Devices.

Click Project (you may need to click Second Screen).

Click on any one of the options from the menu to select PC screen only, Duplicate, Extend or Second screen
only.

Figure 1 - 26- Devices (Project)

1 - 36 Video Features



Quick Start Guide

To access Display (Control Panel) and Screen Resolution in Windows 8:
1. Gotothe Control Panel.

2. Click Display (icon) - In the Appearance and Personalization category.
3. Adjust resolution.

4

Right-Click Desktop
App

You can right-click
the desktop and
select Screen reso-
lution @ (Figure 1 -
0 @ 27).
. Use the dropbox to
select the screen
[3) Resolution @
(Figure 1 - 27).
Click Advanced
settings @ (Figure
1-27)to bring up the
Advanced
properties tabs.

Figure 1 - 27 - Screen Resolution
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To access the I ntel (R) HD Graphics Control Panel:

1. Click Advanced settings @ (Figure 1 - 27 on page 1 - 37) in the Screen Resolution control panel in Win-
2. dC(I)i(\;\LSt.he Intel(R)... tab and click Graphics Properties (button) @ (Figure 1 - 28 on page 1 - 38) .

SR Right-click the desktop and select Graphics Properties from the menu.

El).R Click the icon in the notification area of the Desktop taskbar and select Graphics Properties from the menu.

Figure 1 - 28 - Intel Graphics Control Panel
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Power Options

Power Options (Hardwar e and Sound) can be accessed from the Control Panel. The Power Menu itemin Set-
tingsin the Charms Bar in Windows 8.1 may be used to Shut down or Restart (you can also add Hiber nate/
Sleep to the menu - see “ Adding Hibernate/Sleep to the Power Menu” on page 3 - 10). You can also use the
context menu (Shut down or sign out) shut the computer down/restart etc.

Power Button Start Screen Desktop App Start Screen

Charms Bar

> O

Figure 1 - 29 - Shut Down/Restart
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Running Apps
To run appsin Windows 8.1 you will need to check that the Screen Resolution and User Account Contr ol Set-
tings are compatible with the system requirements.

Screen Resolution Settings

1. Switch to the Windows Desktop (click the app or use the Windows logo key &@ + D key combination).

2. Right-click a blank area of the Windows Desktop and select Screen Resolution. Adjust the Resolution to
make sure that it is at least 1024 * 768, although preferably 1366 * 768 or above (see sidebar).

Screen Resolution for Apps
(Windows 8.1)

The minimum resolution in which Apps will run is 1024x768.

The minimum resolution required to support all the features of
| 1 Windows 8 (including multitasking with snap) is 1366x768.

These specs are the minimum screen resolution that supports
all the features of Windows 8.1 on a useful physical size.

Figure 1 - 30 - Screen Resolution

.|
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User Account Control Settings

If your computer meets the minimum screen resol ution requirements, and still you can't run apps, then that you
have to check the status of User Account Control (UAC). Apps may fail to open when the UAC is turned off.
To check whether the UAC is on or off, follow the instructions below.

1.
2.

3.

Open the Control Panel.

Click on User Accounts and then click on Change User Account Control settings (or click System and
Security and click Change User Account Control Settings under Action Center).

If the slider is in the Never notify position, then the UAC is disabled.

To enable or turn on the UAC, move the slider to Always notify or Notify me when apps try to make changes
to my computer (default) position, and then click OK.

Figure 1 - 31 - User Account Control
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Chapter 2. Features & Components

Overview

Read this chapter to learn more about the following main features and components
of the computer:

Hard Disk Drive/Solid State Drive
Optical (CD/DVD) Device
Multi-In-1 Card Reader

Touchpad and Buttons/Mouse
Audio Features

. |
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e Hard Disk Drive/Solid State Drive

T - The hard disk drive is used to store your data in the computer. The hard disk can be
Removal Warning taken out to accommodate other serial (SATA) hard disk drives, however you will
need to contact your distributor/supplier to do this in order to avoid violating the

SRR terms of your warranty. The system can also support solid state drives as storage de-

er(s) and /or screw(s) for

s e e f Vices (see” Storage” on page D - 2 for specification information).

upgrade as this may vio-
late the terms of your

warranty.

If you need to replace/
remove the hard disk for
any reason, please con-
tact your distributor/sup-
plier for further
information.

2 - 2 Hard Disk Drive/Solid State Drive
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Optical (CD/DVD) Device

Thereisabay for a5.25" optical (CD/DVD) device (12.7mm height). The actual de- Z

vice will depend on the module you purchased (see “ Storage” on page D - 2). The Sound Volume
optical device is usualy labeled “Drive D:” and may be used as a boot device if Adjustment
properly set inthe BIOS (see “Boot Menu” on page 5 - 14). How high the sound vol-

ume can be set depends

Loading Discs on the setting of the vol-
ume control within Win-

Toinsert aCD/DVD, press the open button @ and carefully place aCD/DVD onto | gows. Click the Volume
thedisc tray with label-side facing up (usejust enough forcefor thedisctoclick onto | icon on the notification
the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you | areato check the setting
are ready to start. The busy indicator @ will light up while data is being accessed, gsrfiage”g'_olzfat”res
or while an audio/video CD, or DVD, isplaying. If power isunexpectedly interrupt- '

ed, insert an object such as a straightened paper clip into the emergency gject hole

to open the tray. )
© Figure2-1
Optical Device

Optical (CD/DVD) Device 2 - 3
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Handling CDs or DVDs

7\[:1'( Proper handling of your CDS/DVDs will prevent them from being damaged. Please
follow the advice bel ow to make sure that the data stored on your CDS/DV Ds can be

CD Emergency Eject
accessed.

If you need to manually

SEei R RETERCRE - Note the following:

an unexpected power

LIEER RS GIER EVAl  » Hold the CD or DVD by the edges; do not touch the surface of the disc.
EERER I ESE o Use aclean, soft, dry cloth to remove dust or fingerprints.
f;{g'g::i?ﬁgrgg?grejﬂg « Do not write on the surface with a pen.

T EENEE e ¢ Do not attach paper or other materials to the surface of the disc.
SNeRRTEEE R ET Rl o Do not store or place the CD or DVD in high-temperature areas.
SRS EIEE o Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
SRS EECS . Do not bend the CD or DVD.

db lodged i .
ﬁ]ne hoﬁfome =S8 . Donot drop or subject the CD or DVD to shock.

Disk Eject Warning

Don't try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.

.|
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DVD Regional Codes
To change the DVD regional codes:

1.
2.

3.

Go to the Control Panel

Double-click Device Manager (Hardware and Sound > Devices and Printers),
then click the arrow next to DVD/CD-ROM drives.

Double-click on the DVD-ROM device to bring up the Properties dialog box, and
select the DVD Region (tab) to bring up the control panel to allow you to adjust the
regional code.

DVD region detection is device dependent, not OS-dependent. You can select
your module’s region code 5 times. The fifth selection is permanent. This cannot
be altered even if you change your operating system or you use the module in
another computer.

* Region 1-USA & Canada

* Region 2 - Western Europe, Japan, South
Africa, Middle East & Egypt

* Region 3 - South-East Asia, Taiwan, South )
Korea, The Philippines, Indonesia, Hong Kong Figure2 -2

* Region 4 - South & Central America, Mexico, DVD Region Codes
Australia, New Zealand

* Region 5- N Korea, Russia, Eastern Europe,
India & Most of Africa

* Region 6 - China

Optical (CD/DVD) Device 2 - 5
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1.

Figure2-3
Front View

Card Reader

Multi-In-1 Card Reader

The card reader alows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the card reader driver (see
“ CardReader” on page4 - 6).

« MMC (MultiMediaCard) / RSMMC
» SD (SecureDigital) / Mini SD / SDHC/ SDXC
e MS(Memory Stick) / MSPro/ MS Duo

*Note: The PC adapters are usually supplied with these cards.

2 - 6 Multi-In-1 Card Reader
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Touchpad and Buttons/Mouse

The Touchpad is an alternative to the mouse; however, you can also add a mouse to
your computer through one of the USB ports. The Touchpad buttons function in
much the same way as a two-button mouse.

Touchpad Sensitivity

The mouse button zones at the bottom of the pad are defined by the line at the bot-
tom of the pad, and the left and right buttons are divided roughly down the middle
as illustrated below. The active area of the touchpad is that defined in the diagram
below. Press the left button zone for a left click, and right button zone for a right
click action.

-

Touchpad Active
Areas

Note that the pointing
active area is clearly
defined from the but-
ton active area as il-
lustrated.

Figure2-4
Touchpad
Sensitivity

.|
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Once you have installed the Touchpad driver (see “ Touchpad” on page 4 - 6) you

\ can configure the functions by double-clicking the Touchpad driver icon  in the
Touchpad Scrolling notification area of the taskbar. Y ou may then configure the Touchpad tapping, but-
tons, scrolling (see sidebar), pointer motion and sensitivity options to your prefer-

This computer model se-
ences.

ries may feature different
Touchpad versions.

These Touchpads may
differ in their vertical
scrolling function in most
scrollable windows.

Some Touchpads require
sliding the finger up and
down on the right of the
Touchpad to scroll the
window. Other versions
require  tapping/holding
down the finger at the top
right or bottom right of the
Touchpad to scroll the
window.

Figure2-5
Mouse Properties

2 - 8 Touchpad and Buttons/Mouse
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Gestures and Device Settings

The Synaptics Gestures Suite application allows you to use a specific gesture (ac-
tion) on the surface of the Touchpad to perform specific actions to manipul ate doc-
uments, objects and applications.

Y ou can configure the settings from the Device Settings tab in M ouse Properties:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Mouse (Hardware and Sound).

3. Click Device Settings (tab) and click Settings.

4. Use the menu tree on the left to access the user configurable settings.

Touchpad and Buttons/Mouse 2 - 9

4

Show Video

You can get a clearer
view of the gestures in-
volved by clicking the
Show Video option for
each gesture item.

Select the gesture (Pinch
Zoom, Rotating, Three
Fingers Down and
Three Finger Flick) in the
Device Settings > Set-
tings left tree menu

and click the Show Video
button to see the demon-
stration video.

For more details on any of
the gestures see the help
in the lower part of the
right menu window.

Figure2-6
Mouse Properties -
Device Settings
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Disabling the Touchpad

If you need to disable the Touchpad for any reason (e.g. you may find that when us-
ing the computer’s internal keyboard you accidentally trigger the Touchpad when
resting your wrists or palmson it) you can do so by using Fn + F1 key combination.

Y ou can also set the system to automatically disable the internal Touchpad when an
external USB point device (e.g aUSB mouse) is attached.

1. Go to the Mouse Properties control panel.

2. Click to select Device Settings (tab).

3. Click to place a check in the “Disable internal pointing device when external
USB pointing device is attached” check box.

4. Click OK to save the setting.

Figure2-7
Mouse Properties
(Disable Touchpad)

.|
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PalmCheck™

The PalmCheck™ feature (Device Settings > Settings > Pointing > Sensitivity) ﬁ
helps prevent operating the Clickpad/Touchpad by accident, by recognizing when PalmCheck™
your palmisresting on it or brushing its surface while you are typing. In order to improve

Clickpad/Touchpad

scrolling responsive-
ness when using one-
finger scrolling, you can
adjust the PalmCheck™

slider towards “Mini-
mum” as per your pref-
erence.

However bear in mind
that adjusting the slider
too far towards “Mini-
mum” can turn off Palm-
Check™ altogether.

Figure2-8
PalmCheck™ Slider
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Figure2-9

Scrolling Gesture

4

Mouse Driver

If you are using an ex-
ternal mouse your op-
erating system may be
able to auto-configure
your mouse during its
installation or only en-
able its basic functions.
Be sure to check the
device’s user docu-
mentation for details.

Figure2- 10
Zooming Gesture

Scrolling

The Two-Finger scrolling feature works in most scrollable windows and allows you
to scroll horizontally and verticaly. Place two fingers, slightly separated, on the
Touchpad surface and slide both fingers in the direction required (in a straight con-
tinuous motion).

Zooming

The Pinch Zoom gesture can be used to perform the same function as a scroll wheel
in Windows applications that support CTRL + scroll wheel zoom functionality.
Place two fingers on the Touchpad (for best results use the tips of the fingers) and
slide them apart to zoom in, or closer together to zoom out.
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Rotating

Use the Pivot Rotate gesture to rotate objects (e.g. photos) in 90 degree increments.
Place a finger down on the left “target” zone and keep it stationary. Place another
finger near the middle of the Touchpad and slide it in a circular motion around the
stationary finger (clockwise or counterclockwise) to rotate the object.

Figure2-11
Rotating Gesture

Three Finger-Flick/Three Fingers Down (Press)

The Three Finger-Flick gesture may be used to enhance navigation with avariety of
applications such as browsing the Internet or scrolling through a photo viewer. The
Three Fingers Down gesture may be used to launch user-sel ectable applications.

Figure2-12
Flick/Press
Gesture

.|
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= Audio Features
_ Y ou can configure the audio options on your computer from the Sound  control
Volume Adjustment panel in Windows, or from the Realtek HD Audio Manager Ejj icon in the taskbar
The sound volume level

: notification area/control panel (right-click the taskbar notification area icon gjj to
can be set using the vol- bri di Th | also be adiusted b f th i
ume control in. the Set- ring up an audio menu). The volume may also be adju y means of thevolume

tings menu in the || iconinthetaskbar or theaudio sider in the Settings menu (see sidebar).
Charms Bar.

Right-click the icon
to access the menu
above.

Figure2- 13
Realtek Audio
Manager
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Setup for Audio Recording

To record audio sources on your computer at optimum quality follow the instruc-
tions below:

1. Go to the Control Panel.

2. Click Realtek HD Audio Manager (Hardware and Sound), or right-click the
taskbar icon ﬂ and select Sound Manager.

3. Click Microphone Effects (tab) in Microphone (tab), and then click to select
Noise Suppression (button), or adjust the Recording Volume level to around 60,
to obtain the optimum recording quality.

4. Click OK to close the control panel and save the settings.

Figure2- 14
Realtek Audio
Manager -
Recording Setup

. |
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Chapter 3. Power Management P

Overview OS Note

To conserve power, especially when using the battery, your computer power man- | Power  management

. . functions will vary slight-
agement conserves power by controlling individual components of the computer ly depending on_ your

(the monitor and hard disk drive) or the whole system. This chapter covers: operating system. For
more information it is
¢ The Power Sources best to refer to the user’s

manual of your operat-

* Turning On the Computer :
ing system.

» Power Plans

» Power-Saving States

» Configuring the Power Buttons
» Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OSto set devicesinto low-power states based on user set-
tings and information from applications.

. |
Overview 3 - 1
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4

Forced Off

If the system “hangs”,
and the Ctrl + Alt + Del
key combination doesn’t
work, press the power
button for 4 seconds, or
longer, to force the sys-
tem to turn itself off.

The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter

Useonly the AC/DC adapter that comeswith your computer. Thewrong type of AC/
DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack on the left of the computer.

2. Plug the AC power cord into an outlet, and connect the AC power cord to the AC/
DC adapter (make sure you use the adapter when first setting up the
computer, as to safeguard the computer during shipping the battery will be locked
to not power the system until first connected to the AC/DC adapter).

3. Raise the lid/LCD to a comfortable viewing angle.

4. Press the power button to turn “On”.

Battery

The battery allows you to use your computer while you are on the road or when an
electrical outlet isunavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely beforerecharging (see “ Battery FAQ” on page 3 - 18).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “ Battery Information” on page 3 - 14.

3 - 2 The Power Sources
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Turning On the Computer

Now you are ready to begin using your computer. To turnit on simply pressthe pow-

er button on the front panel.
When the computer is on, you can use the power button as a Stand by/Hibernate/
Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and
holding the power button for longer than this will shut the computer down). Use

Power Options (Hardware and Sound) in the Windows control panel to configure
this feature.

4

Power Button as Stand by or Hibernate Button

You can use the OS's “Power Options” control panel to set the power button to send the
system into Stand by or Hibernate mode (see your OS’s documentation, or “Configuring
the Power Buttons” on page 3 - 9 for details).

Turning On the Computer 3 - 3
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Shutting the Computer Down

Note that you should always shut your computer down by choosing the Shut down

command asthiswill help prevent hard disk or system problems. Use the Shut down
or sign out item in the Context M enu (right-click the lower left corner of the screen
to bring up the menu).

Y ou can also use the Power M enu in Settingsin the Windows CharmsBar. If you
want to add Hibernate/Sleep to the Power Menu see“ Adding Hibernate/Sleep to the
Power Menu” on page 3 - 10.

Charms Bar Desktop App Start Screen

Figure3-1
Shut Down/Restart

3 - 4 Shutting the Computer Down
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Power Plans

The computer can be configured to conserve power by means of power plans. You

4

can use (or modify) an existing power plan, or create a new one. Resuming
Operation

The settings may be adjusted to set the display to turn off after a specified time, and

to send the computer into Sleep after a period of inactivity. <50 TEBEE = b o

page 3 - 11 for informa-

. . . . tion on how to resume
Click Change plan settings and then click Change advanced power settingstoac- | ('~ SRR

cess further configuration options in Advanced Settings. .

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

o > Figure3-2
Power Plan
Advanced Settings

Power Plans 3 - 5
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Figure3-3

Power Plans

Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. Thisisworth bearing in mind if you are experiencing
any reduced performance (especialy under DC/battery power).

Choose High perfor mance (you may need to click Show additional plansto view
the High performance plan) for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered.

Click to Show/Hide
additional
power plans

3 - 6 Power Plans
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Y ou can use power-saving states to stop the computer’ s operation and restart where
you left off. Windows uses the Sleep, Hibernate and Shut Down power-saving
states.

Sleep

In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power.

The PC wakes from Sleep within seconds and will return you to where you last | eft
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.

To add Sleep to the Power Menu see “Adding Hibernate/Sleep to the Power
Menu” on page 3 - 10.

.|
Power-Saving States 3 - 7
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Wake On LAN
Support

Wake-On-LAN is only
supported from Sleep or
Hibernate states in
Windows.

If you require your com-
puter to wake up from
network activity in Win-
dows then make sure
that the computer is ei-
ther in Sleep or Hiber-
nate.

Wake-On-LAN is not
supported from Shut-
down states in Win-
dows.
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Figure3-4
Power Menu

Hibernate

Hiber nate uses the least amount of power of al the power-saving states and saves
al of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last |eft off within seconds. Y ou should
put your mobile PC into Hiber nate if you will not use the computer for a period of
time, and will not have the chance to charge the battery. To add Hiber nate to the
Power Menu see “ Adding Hibernate/Sleep to the Power Menu” on page 3 - 10.

Shut down

Y ou should Shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from Shut down takes longer than
from Sleep or Hiber nate.

Sleep

Hibernate

Shut down

Restart

3 - 8 Power-Saving States
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Configuring the Power Buttons

The power/sleep button (Fn + F12 key combo) and closed lid may be set to send the Z
computer in to a power-saving state. Click Choose what the power buttons do on Password
the left menu in Power Options to bring up the menu. Protection

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure3-5
Power Options
Define Power
Buttons

.|
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Figure3-6
Power Options
Define Power
Buttons - Shutdown
Settings

Adding Hibernate/Sleep to the Power Menu
Add Hibernate/Slegp to the Power Menu as follows.

Go to the Power Options (Hardware and Sound) control panel.

Click “Change settings that are currently unavailable” @ change settings that ar= currently unsvsilsble .
Click Choose what the power buttons do.

Click to put a check in the Hibernate/Sleep box under Shutdown settings.

Click Save Changes and close the control panel.

agpNE

3 - 10 Configuring the Power Buttons



Power Management

Resuming Operation
Y ou can resume operation from power-saving states by pressing the power button,
or in some cases pressing the sleep button (Fn + F12 key combo).

Power Status Icon Color To Resume
Table3-1
Power Off Off Press the Power Button Resuming
Press the Power Button Operation
Sleep Blinking Green
Press the Sleep Button (Fn + F4 Key Combo)
Off (battery)
Hibernate Press the Power Button
Orange (AC/DC adapter)
Display Turned Off Green Press a Key or Move the Mouse/Touchpad
Power Button 2
When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down Closing the Lid
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
R If you have chosen to
button for longer than this will force the computer to shut down).
send the computer to
Sleep when the lid is
closed, raising the lid

will wake the system up.

Configuring the Power Buttons 3 - 11



Power Management

Power Conservation Modes

g This system supports Energy Star power management features that place comput-
3 Power Conservation ers (CPU, hard drive, etc.) into a low-power sleep modes after a designated period
Modes of inactivity. Adjust Power Conservation Modes from the Control Center:

The Energy Star setting
will result in maximum
power saving, but with
the possible loss of
some performance.

1. Pressthe Fn + Esc key combination to toggle the Control Center on/off.
2. Click either the Performance, Balanced or Energy Star button.

Setting the mode to Bal-
ance will give power
saving matched with
performance.

Performance will give
optimum computer per-
formance but with less
power conservation.

Note that the Energy
Star setting will put the
display into sleep after
no more than 15 min-
utes of user inactivity.

Figure3-7
Control Center
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Ctrl + Alt + Delete Key Combination

YoucanusetheCTRL + ALT + DEL key combination from almost any of the Win-

dows 8 interfaces/Appsto bring up afull-screen displaying L ock, Switch User, Log

off, Change a password and Task Manager options. If you click the Power icon
in the lower right corner of the screen a power management option menu appears to

display Sleep, Shut down, and Restart.

Figure3-8
Ctrl + Alt + Delete
Menu

To fully control all the power options (including Hibernate mode) go to the Power
Options control panel and configure the power button, sleep button and lid to per-
form the function selected.

.|
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Battery Information

\ A/
ﬂ‘ Follow these simple guidelines to get the best use out of your battery.
Low Battery
Warning Battery Power

Whenihe bareryis oriti Y our computer’s bqttery power .is dependerjt upon many factors, includi ng the pro-
VA e @ grams you are running, and peripheral devices attached. You can set actions to be
ceueas GER Aehlel  taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
SCERERCEREEIE A power plan Change plan settings > Change advanced power settings (see Figure

or save your work, oth- ] i
erwise, the unsaved 3 -3 on page 3 - 6).

?hata WERERERUEIE  Click the battery icon ﬂ in the notification area to see the current battery level
e power is depleted.
and charge status.

Figure3-9
Battery Icon
(Notification Area) &
Battery Advanced
Settings

.|
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Conserving Battery Power

» Useapower plan that conserves power (e.g Power saver), however note that Z
this may have an affect on computer performance. Windows Mobility
+ Lower the brightness level of the LCD display. The system will decrease LCD Center

brightness dlightly to save power when it is not powered by the AC/DC adapter. The Windows Mobility

. . . Center control panel
* Reduce the amount of time before the display is turned off. provides an easy point

» Closewireless, Bluetooth, modem or communication applicationswhenthey are | of access for information

not being used. on battery status, power
plans used and wireless
» Disconnect/remove any unnecessary external devices e.g. USB devices, device status etc.
ExpressCards etc.
Figure3- 10
Windows Mobility
Center
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Battery Life

Battery life may be shortened through improper maintenance. To optimizethelife
and improveits performance, fully discharge and recharge the battery at least
onceevery 30 days. It isrecommended that you use the Battery Settingsin the En-
ergy Save Utility to help maintain the life of the battery.

We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason (e.g. long term storage) see “ Removing the Battery
- Model B Computers’ on page 3 - 22.

New Battery

Always completely discharge, then fully charge, a new battery (see “ Battery FAQ”
on page 3 - 18 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter

The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hoursto fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery chargetimeisless. Refer to “ LED Indica-
tors” on page 1 - 9 for information on the battery charge status, and to “ Battery I n-
formation” on page 3 - 14 for more information on how to maintain and properly
recharge the battery pack.

.|
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Use of Fn + 6 to Enable/Disable Battery Charging s

Y ou can use the Fn + 6 key combination to enable/disable battery charging. Thisis ﬂ‘

useful if you need to discharge the battery as recommended (see overleaf) in order Caution

to maintain the battery. Note that the chipset controller which governs this process Danger of explosion if
is controlled by use of the AC/DC adapter. Thereforeif you disable battery charging BRSNS F SRS ESS =
and shut the computer down, and then remove the AC/DC adapter from the DC-In - BEEE=E

jack, whenever the AC/DC adapter is plugged-in again and the computer restarted,
the battery will revert to its default charging state.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
* DO NOT disassemble the battery pack under any circumstances used battery according

» DO NOT expose the battery to fire or high temperatures, it may explode to the manufacturer’s in-
* DO NOT connect the metal terminals (+, -) to each other structions.

Proper handling of the Battery Pack

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer

down immediately and contact your distributor/supplier. If the battery has been dropped we
do not recommend using it any further, as even if the computer continues to work with a
damaged battery in place, it may cause circuit damage, which may possibly result in fire. It
is recommended that you replace your computer battery every two years.

.|
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Battery FAQ

How do | completely dischargethe battery?

Use the computer with battery power until it shuts down due to alow battery. Don’t
turn of f the computer even if amessage indicates the battery iscritically low, just let

the computer use up al of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.

Figure3- 11
Power Plan Create

.|
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3. Click Change plan settings (after creating it) and click Change plan settings >
Change advanced power settings.

Figure3- 12
Change Plan
Settings / Change
Advanced Power
Settings

S
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

Figure3- 13
Power Options
Advanced Settings -
Battery

» Low battery levels = 0%

» Critical battery Levels= 1%

» Low battery action = Do Nothing

» Critical battery action (On battery) = Shut Down
 Critical battery action (Plugged in) = Do Nothing

.|
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How do | fully chargethe battery?
When charging the battery, don’t stop until the LED charging indicator light changes

from orange to green.

How do | maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.

.|
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SN
L&

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Figure3- 14
Battery Removal
Model B Computers

Removing the Battery - Model B Computers

We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason (e.g. long term storage) see below. In normal cir-
cumstances you should not remove the bottom cover and battery of Model A
computersasthiscan void your warranty. However it is necessary to remove the bot-
tom cover and battery to insert the 3G/4G USIM card (see page 6 - 33).

1. Turn the computer off, and turn it over.

2. Slide the latch @ in the direction of the arrow.

3. Slide the latch @ in the direction of the arrow, and hold it in place.

4. Slide the battery out in the direction of the arrow @).

3 - 22 Removing the Battery - Model B Computers



Chapter 4: Drivers & Utilities

This chapter dealswith installing the drivers and utilities essential to the operation or
improvement of some of the computer’s subsystems. The system takes advantage of
some newer hardware componentsfor which the latest versions of most available op-
erating systems haven't built in drivers and utilities. Thus, some of the system com-
ponents won't be auto-configured with an appropriate driver or utility during
operating system installation. Instead, you need to manually install some system-re-
quired drivers and utilities.

What to Install

The Device Drivers & Utilities+ User’sManual disc containsthe drivers and util-
ities necessary for the proper operation of the computer. Table4 - 1, on page4 - 3
listswhat you need toinstall and it isvery important that thedriversareinstalled
by the method outlined in this chapter, and in the order indicated.

Note that the information included on the following pagesis for Windows 8.1 only.

Module Driver Installation

The proceduresfor installing driversfor the WirelessL AN and Combination Blue-
tooth & WLAN modules are provided in “Modules & Options’ on page6 - 1.

. |
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Drivers & Utilities

\ 7/
L&
Driver Installation &
Power

When installing driv-
ers make sure your
computer is powered
by the AC/DC adapter
connected to a work-
ing power source.
Some drivers draw a
significant amount of
power during the instal-
lation procedure, and if
the remaining battery
capacity is not adequate
this may cause the sys-
tem to shut down and
cause system problems
(note that there is no
safety issue involved
here, and the battery will
be rechargeable within 1
minute).
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Driver Installation

1.

Insert the Device Drivers & Utilities + User’s Manual
disc into the computer’s DVD drive.

Click the message “Tap to choose what happens
with this disc.”

Click Run autorun.exe.

Click Install Drivers (button), or Option Drivers
(button) to access the Optional driver menu.

Figure4 - 1- Drivers Installer Screen 1

Check the driver installation order from Table 4 - 1,
on page 4 - 3 (the drivers must be installed in this
order) which is the same as that listed in the Drivers
Installer menu below.

Click to select the driver you wish to install, (you
should note down the drivers as you install them).
Follow the instructions for each individual driver
installation procedure as listed on the following
pages.

Figure4 - 2 - Install Drivers

. |
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Win 8.1 Driver - System Required Page # Win 8.1 Driver (Other / Options) Page #
Chipset Page 4 -6 PC Camera Module (No driver required) Page 6 - 2
Video (VGA) Page 4 -6 Wireless LAN Module Page 6 - 11
LAN Page 4 -6 Bluetooth & WLAN Combo Module Page 6 - 16
CardReader Page 4-6 Intel® Rapid Storage Technology Page 6 - 21
Touchpad Page 4-6 Intel® Smart Connect Technology Page 6 - 22
Airplane Page4-7 Free Fall Data Protection Page 6 - 27
Hot Key Page 4 -7 3G/4G Module Page 6 - 31
MEI Driver Page 4 -7 ;I;r;usirt:d(i Platform Module (No driver Page 6 - 41
Audio Page4-7 Wireless Display (No driver required) Page 6 - 47

Table4 - 1- Driver Installation

All drivers provided are for Windows 8.1.
Notethat you need toinstall both the WLAN & Bluetooth driversfor the WLAN & Bluetooth Combo modules.

. |
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Manual Driver Installation

Click Browse CD/DVD (button) inthe Driversinstall-
er application and browse to the executable file in the
appropriate driver folder.

Windows Update

After installing all the drivers make sure you enable
Windows Updatein order to get all the latest security
updatesetc. (all updateswill includethelatest hotfixes
from Microsoft). See “Windows Update” on page 4 -
8 for instructions.

Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if itisnot listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Go tothe Control Panel).

2. Double-click Device Manager (Hardware and
Sound > Devices and Printers > Device
Manager).

3. Double-click the device you wish to update/reinstall
the driver for (you may need to click “+” to expand
the selection).

4. Click Driver (tab) and click the Update Driver or
Uninstall button and follow the on screen prompts.
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User Account Control

If aUser Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow theinstallation procedure as direct-
ed.

Windows Security Message

If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or “Install” to continue the
installation procedure.

Y ou will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

Drivers & Utilities

New Hardware Found

If you see the message “New Har dwar e Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the installation proce-
dure.

4

Driver Installation General Guidelines

The driver installation procedure outlined in this Chapter
(and in Chapter 6 Options & Modules), are accurate at
the time of going to press.

Drivers are always subject to upgrade and revision so
the exact procedure for certain drivers may differ slight-
ly. As a general guide follow the default on screen in-
structions for each driver (e.g. Next > Next > Finish)
unless you are an advanced user. In many cases a re-
start is required to install the driver.

Make sure any modules (e.g. WLAN or Bluetooth) are
ON before installing the appropriate driver.

Driver Installation 4 - 5
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Driver Installation Procedure

Insert the Device Drivers & Utilities+ User’s Manual
disc and click Install Drivers (button).

Chipset

1. Click Llnstall Chipset Driver > Yes.
2. Click Next > Accept > Install.

3. Click Finish.

Video (VGA)

1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.

3. Click Finish to restart the computer.

Note: After installing the video driver go to the Dis-
play/Display Settings control panel to adjust the vid-
€0 Settings to the highest resolution.

LAN

Note: If the computer enters a deep sleep mode during
installation, you will be prompted to plug in a network
cable, and click OK, to continue installation. If a net-
work cable is not available, restart the system and re-
install the LAN driver.

1. Click 3.Install LAN Driver > Yes.
2. Click Next > Install.
3. Click Finish.

CardReader
1. Click 4.Install Cardreader Driver > Yes.
2. Click Finish.

Touchpad

1. Click 5.Install Touchpad Driver > Yes.

2. Click Next.

3. Click the button to accept the license agreement
and click Next.

4. Click Finish > Restart Now to restart the com-
puter.
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Airplane

Note: Do not use Update Driver in Device Manager to
install the Airplane Mode driver.

1. Click 6.Install AirplaneDriver > Yes.

2. Click Next.

3. Click Finish to restart the computer.

Hot Key
1. Click 7.Install Hotkey AP > Yes.
2. Click Next.

3. Click Finish to restart the computer.

MEI Driver

1. Click 8.Install MEI Driver > Yes.

2. Click Next.

3. Click the check box to accept the license and
then click Next.

Click Next.

5. Click Finish.

E

Drivers & Utilities

Audio

1. Click 9.Install Audio Driver > Yes.
2. Click Next.

3. Click Finish to restart the computer.

Note that after installing the audio driver the system
will not return to the Drivers Installer screen. To in-
stall any of the optional drivers listed overleaf, gject
the Device Drivers & Utilities + User’s Manual disc
and thenreinsert it (or double-click thedisciconinMy
Computer), and click Option Drivers (button) to ac-
cess the optional driver menu.
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4
Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc. (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

1.
2.

3.

Go to the Control Panel.

Click Windows Update (System and Security/
Security).

Click Check for updates (button).

The computer will now check for updates (you
need to be connected to the internet).

Click Install now (button) to begin checking for the
updates.

Click Install updates (button) to install the
updates.

Optional Drivers

Seethepagesindicatedin Table 4 - 1, on page 4 - 3for
the driver installation procedures for any modules in-
cluded in your purchase option.

Figure4 - 3 - Option Drivers

Note that you need to install both the WLAN & Blue-
tooth driversfor Intel and 3rd party WLAN & Blue-
tooth Combo modules.
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Chapter 5: BIOS Utilities "

Overview BIOS Screens

This chapter gives a brief introduction to the computer’ s built-in software: i e e B
screens  pictured on

. these pages are intend-
If your computer has never been set up, or you are making important changesto the BESEERIREREE IRE

system (e.g. hard disk setup), then you should review this chapter first and note the B FSEeNIE S R
original settings found in Setup. Even if you are abeginner, keep arecord of the set-  JHEISES
tings you find and any changes you make. This information could be useful if your

- BIOS versions are sub-
system ever needs servicing. ject to constant change

and revision, therefore
Thereis one general rule: Don’t make any changes unless you are sure of what you VSISl lE]

. . . : screens may appear
aredoing. Many of the settings are required by the system, and changing them could slightly _ different _from

cause it to become unstable or worse. If you have any doubts, consult your service  BEFSEE IS T
representative. pages.

. |
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BIOS Settings
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Opti-
mized Defaults with
<F3>.

UEFI Boot & POST

When UEFI Boot is en-
abled, then the prompts
to press F2 or F7 will
not appear. However
you can still press F2 to
enter the setup, or F7 to
choose the preferred
boot device, if you press
the key immediately the
system boots up.

The Setup Utility

Each time you turn on the computer the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).

Asthe POST proceeds, the computer will tell you if thereisanything wrong. If there
isaproblem that prevents the system from booting, it will display asystem summary
and prompt you to run Setup.

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can't get into Setup without rebooting.

The Aptio Setup Utility tells the system how to configure itself and manage basic
features and subsystems (e.g. port configuration).

To enter Setup, turn on the computer and press F2 (give the system a few seconds
to enter Setup). If the Boot L ogo is enabled the F2 on screen will be highlighted to
illustrate that the system is processing the request during the POST (or press F7 for
boot options). If you get a*“Keyboard Error”, (usually because you pressed F2 too
quickly) just press F2 again.

If the computer is aready on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.

To see the boot options press F7 and choose your preferred boot device.

5 - 2 The Setup Utility
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Failing the POST
Errors can be detected during the POST . There are two categories, “fatal” and “non-
fatal”.

Fatal Errors

These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
distributor/supplier as soon as possible.

Non-Fatal Errors

This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) and you can then press F7 (the F7 on screen
will be highlighted to illustrate that the system is processing the request) for boot
options.

Press F2 (give the system a few seconds to enter Setup; the F2 on screen will be
highlighted to illustrate that the system is processing the request) to run the Setup
program and try to correct the problem. If you still get an error message after you
change the setting, or if the “cure” seems even worse, call for help.
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4

Setup Menus

The Setup menus
shown in this section are
for reference only. Your
computer's menus will
indicate the configura-
tion appropriate for your
model and options.

Figure5-1
Navigation Menu

Setup Screens

The following pages contain additional advice on portions of the Setup. Along the
top of the screen is a menu bar with menu headings. When you select a heading, a
new screen appears. Scroll through the features listed on each screen to make chang-
esto Setup.

Instructions on how to navigate each screen are in the box at the bottom right side of
the screen.

If these tools are confusing, press F1 to call up aGeneral Help screen, and then use
the arrow keysto scroll up or down the page.

Theltem Specific Help onthe upper right side of each screen explainsthe highlight-
ed item and has useful messages about its options.

If you see an arrow p next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.
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Main Menu

Aptio Setup Utility — Copyright (C) 2014 American Megatrends Inc.

System Date

Figure5-2
Main Menu

System Time & Date (Main Menu)

The hour setting uses the 24-hour system (i.e., @@ = midnight; 13 = 1 pm). If you
can change the date and time settingsin your operating system, you will aso change
these settings. Some applications may also alter data files to reflect these changes.
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SATA Port # (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of a optical Device/
HDD on the computer’s SATA Ports.

System/Extended Memory: (Main Menu)
Thisitem contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

MB Series/ BIOS Revision / KBC/EC firmware Revision
This item contains information on the BIOS version etc., and is not user configu-
rable.
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Advanced Menu

Aptio Setup Utility — Copyright (C) 2014 American Megatrends Inc.

Figure5- 3

p Advanced Chipset Control
Advanced Menu

Advanced Chipset Control (Advanced Menu)
The sub-menu here alows you to change the device installed in the Combo mSA-
TA/3G Slot.
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4

UEFI Boot

When UEFI Boot is en-
abled, then the prompts
to press F2 or F7 will
not appear. However
you can still press F2 to
enter the setup, or F7 to
choose the preferred
boot device, if you
press the key immedi-
ately the system boots

up.

Intel Smart Connect Technology (Advanced Menu)

Smart Connect isatechnology that makes checks on web applicationsthat are open
even when the computer isin sleep mode, and thus allows updates to be made with-
out the need to turn the computer on. The sub-menus here allow you to enable/dis-
able the technology (I SCT Configuration).

SATA Mode (Advanced Menu)
The SATA (Serial ATA) control is configured to operatein AHCI (Advanced Host
Controller Interface) mode.

Boot Logo (Advanced Menu)

Use this menu item to enable/disable the Boot L ogo screen at system startup if you
have not enabled UEFI Boot. If you disable the Boot L ogo you will not see the F2
Enter Setup or F7 Boot Options prompts on the screen, however you can still press
these keys, while the boot screen is displayed, to perform the Enter Setup or Boot
Option functions.

Power On Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.
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Combo Sot
(Advanced Menu > Advanced Chipset Control) 3[,1’:
Select which deviceisinstalled in the Combo slot from this menu option. Select the
appropriate device installed in the slot from the menu, and then save the changed
BIOS settings. You will then need to shutdown the system and remove the AC/ [ s et sicie Bl
DC adapter. Y ou should then plug the AC/DC adapter back in again and restart the gg:gcgilsvggﬁ g:]e ifaf/oﬁ
computer to have the system recognize the changes made. have included it in your

purchase configuration.

Combo Slot Support

Aptio Setup Utility — Copyright (C) 2012 American Megatrends Inc.

Combo slot [Storage device]

Figure5-4
Advanced Chipset

Combo slot:
Storage device ContrOI
3G device (Advanced Men u)
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Security Menu

Aptio Setup Utility — Copyright (C) 2014 American Megatrends Inc.

4

Security Menu

The changes you make
here affect the access
to the Setup utility itself,
and also access to your
machine as it boots up
after you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in your
software OS.

Secure Boot Mode [Standard]

Secure Boot Mode
Standard
Custom

Figure5-5
Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Aptio Setup Utility. This will not affect
access to the computer OS (only the Aptio Setup Utility).
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Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Set User Password (Security Menu)

Y ou can set a password for user mode access to the Aptio Setup Utility. Thiswill
not affect access to the computer OS, (only the Setup utility) unless you choose to
set a Password on Boot (see below). Many menu items in the Aptio Setup Utility
cannot be modified in user mode.

Note: You can only set the user password after you have set the supervisor pass-
word.

Password on boot: (Security Menu)

Specify whether or not a password should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is“Disabled”.

Security Menu 5 - 11

BIOS Utilities

N2
2

Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled’), NEVER
forget your password.

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
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Secure Boot Control (Security Menu)

Secure Boot prevents unauthorized operating systems and software from loading
during the startup process. Secur e Boot Control isavailable asamenu optionif you
have enabled UEFI Boot (see “UEFI Boot (Boot Menu)” on page5 - 15). En-
abling Secure Boot will bring up the Secur e Boot M ode menu to enable you to con-
figure Secure Boot as Standar d (with afixed secure boot policy) or Custom (which
enables you to make changes to the Key M anagement database).
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TPM Configuration (Security Menu)
This sub-menu will allow you to enable/disable Trusted Platform Module (TPM)
support. Press Enter to access the Security Device Support menu and select Enable

to support TPM 2.0 aslong as UEFI Boot is enabled (see “ Trusted Platform Mod-
ule” on page 6 - 41 for details).

Aptio Setup Utility — Copyright (C) 2014 American Megatrends Inc.

Security Device Support [Enable]

Figure5-6
Security Device
Support
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Boot Menu

Aptio Setup Utility — Copyright (C) 2014 American Megatrends Inc.

. oot
Figure5-7 -
Boot Menu

Boot Option #1 [Windows Boot Manager]

2NZ
Z &

BIOS Screens

Note that the BIOS
screens pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-
ject to constant change
and revision, therefore

your computer’'s actual A . .
A When you turn the computer on it will look for an operating system (e.g. Windows

slightly different from 7) from the devices listed in this menu, and in this priority order. If it cannot find
LRSSl the operating system on that device, it will try to load it from the next device in the
pages. order specified in the Boot Option Priorities. Item specific help on the right is
available to help you move devices up and down the order.

|
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Boot Option Priorities (Boot Menu)

Press Enter to access the menu, use the arrow keys to move up and down the menu,
and press Enter to select a device from the Boot Option # list (the selected device
will be highlighted in white).

UEFI Boot (Boot Menu)

Enable/disable UEFI Boot from this menu. The Unified Extensible Firmware Inter-
face (UEFI) specification provides a clean interface between operating systems and
platform firmware at boot time. In contrast to BIOS, UEFI defines a set of standard
boot and runtime services. The Network Stack and Launch CSM (Compatability
Support Module - for legacy BIOS compatibility) items will be enabled as options
under UEFI Boot.

BIOS Utilities
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Exit Menu

Aptio Setup Utility — Copyright (C) 2014 American Megatrends Inc.

Flgure 5 - 8 Save & Exit
Exit Menu

Save Changes and Reset

Click Save Changes and Reset to save al changes made. Choosing to Discard
Changes, or Exit Discarding Changes, will wipe out any changes you have made
to the Setup. Y ou can also choose to restore the original Setup defaults that will re-
turn the Setup to its original state, and erase any previous changes you have madein
aprevious session.

. |
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Chapter 6: Modules & Options %

/ \Y

i Wireless Device
OverVIGW Operation Aboard
This chapter contains information on the following modules, which may come with Aircraft
your computer, depending on the configuration purchased. If you are unsure please RS EEA T
contact your service representative. electronic transmission

. devices aboard aircraft
» PC CameraModule * FreeFall Data Protection is usually prohibited.
* WirelessLAN Module » 3G/4G Module Make sure the WLAN &
» Bluetooth & WLAN Combo Module ¢ Trusted Platform Module Bluetooth  module(s)
+ Intel® Rapid Storage Technology ~ « Wireless Display b OAF.F (Ior theMSfterT}
* Intel® Smart Connect Technology 'ySOl'Jn argﬂ;‘ﬂge thg Ci)m'_

puter aboard aircraft
(see

)-

. |
Overview 6 - 1
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PC Camera Module

When the PC Camera application is run the LED indicator to the left of the camera
will beilluminated in red (see @ Figure 1 - 2 on page 1 - 7). Note that you need to
use the Camer a app in Windows 8 to take pictures and capture video. Usethe Fn +
F10 key combination (see “ Function/Hot Key Indicators’ on page 1 - 13) to tog-

gle power to the PC Camera module.

6 - 2 PC Camera Module



PC Camera Audio Setup

If you want to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1.
2.
3.

Go to the Control Panel.

Click Sound (Hardware and Sound) and click Recording (tab).
Right-click hold and release Microphone (Realtek High Definition Audio) and
make sure the item is not disabled.

Double-click Microphone (or select Properties from the right-click menu).

Modules & Options

Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to

the level required.
Click OK and close the control panels.

Right-click

Figure6-1
Audio Setup for PC
Camera

PC Camera Module 6 - 3
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Camera App

1. Runthe Camera app from the Start screen by clicking on the Camera app icon

Figure6- 2 2. The camera interface will display two buttons on the right side of the screen.

Camera App
Buttons

4

Exposure

Use the slider to adjust
the Exposure level.

3. The upper button is used to record video, and the lower button is used
to take still pictures.

4. Right-click on the screen to bring up menu buttons at the bottom of the screen.
5. These buttons enable you to access the camera roll (where captured pictures and
video are displayed), set the timer (the time period before capture begins; 3
seconds, 10 seconds or Off) and set the exposure level using the slider to obtain
the best results.
Camera Options

Camera roll Timer Exposure

6 - 4 PC Camera Module
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Camera Options
The Camera Options settings may be accessed as follows:

1.

2.

Run the Camera app from the Start screen by clicking on the Camera app icon

While the camera app is running access the Charms Bar (e.g. click Use the
Windows logo key == + C key combination).

Click Settings and then click Options.

You can adjust the Photo Aspect Ratio, select the Microphone, Hide/Show grid
lines and turn Location Info on or off from the Options panel.

Figure6- 4
Camera Options

PC Camera Module 6 - 5
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Taking Pictures/Capturing Video
1. Runthe Camera app from the Start screen by clicking on the Camera app icon

2. Right-click the screen and select the timer if you require a countdown before
capture.

3. Click the appropriate icon to take a picture or start video capture (if video capture

begins a timer will appear in the bottom corner of the screen).

To stop video capture click the main window again (or click the stop icon ).

Captured photos and videos will be saved to a Camera Roll folder within the

Pictures folder.

ok

Figure6-5
Pictures - Camera
Roll

6 - 6 PC Camera Module



Modules & Options

Camera Roll

1. Runthe Camera app from the Start screen by clicking on the Camera app icon
2. Right-click on the screen to bring up menu buttons at the bottom of the screen.
3. Click Camera Roll.

4. Click the arrows - / -(on either side of the screen) to browse through the

captured photos/video, and back to the Camera app.

Editing Photos

1.

e

©No O

PC Camera Module 6 - 7

Clicking on a captured photo will bring up an app bar with a series of buttons. Figure6 - 6

Edit Buttons
(for Still Photos)

The Camera button will take you back to the home screen of the camera app.
Click Delete to remove any photo from the camera roll (you will be asked to click
Delete again to confirm the deletion).

The Open With button will allow you to select a program with which to open the
photo.

You can click Set as Lock screen to set the photo as the lock screen picture.
Clicking Slide Show will create a slide show of photos/video in the camera roll.
Click Rotate to rotate the picture through 90 degrees.

Use the handles to Crop any captured picture, and click Apply to make the
changes (you can change the Aspect ratio by clicking the button and selecting an
aspect ratio from the menu). You can Save a copy (create another copy of the
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9.
10
Figure6-7
Editing Tools
11.

6 - 8 PC Camera Module

photo with the edited changes), Update original (which changes the original
picture permanently) or Undo any changes.
Click the Edit button to bring up a full suite of tools to edit the photo.

. Click on the menu headings on the left, and then click on the tool on the right to

edit the photo as required.
Edit Menu Basic Fixes Light Color  Effects

203

Temperature

Q

Rotate

Saturation

Q

Color enhance

Retouch

After the editing process is completed right-click on the photo to Save a copy
(create another copy of the photo with the edited changes), Update original

(which changes the original picture permanently), Undo any changes or Cancel
the editing.
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Editing Photos
1. Clicking on a captured video will bring up an app bar with a series of buttons.

Figure6- 8
Edit Buttons
Trim (for Video)

2. Click Delete to remove any video from the camera roll (you will be asked to click
Delete again to confirm the deletion).

3. The Open With button will allow you to select a program with which to run the

Video.

Clicking Slide Show will create a slide show of photos/video in the camera roll.

5. Click Trim to edit the video. Use the round buttons at either end of the slider to
adjust the video length and click Save a copy to save the changes made.

»

Figure6-9
Trim Video
(for Video Files)
Click to select and move therounded buttonsto edit the video.

PC Camera Module 6 - 9
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Video File Size

Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (goto My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to aremovable medium e.g. CD, DVD or USB Flash
drive.

Note that the Windows 8.1 system requires a minimum of 16GB (32-bit) or 20GB
(64-bit) of free space on the C: drive system partition. In order to prevent system
problems it is recommended that you move any large sized captured video fileto a
location other than the C: drive.

6 - 10 PC Camera Module
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Wireless LAN Module

SAC
If you haveincluded an I ntel® or 3rd Party WL AN modulein your purchase option _ /ﬂ\ _
make sure that the module is on (i.e. the system is not in Air plane M ode) beforein- JrEIess DEvice

X X Operation Aboard
stalling the driver. Aircraft

Make sure you install the driversin the order indicated in Table 4 - 1, on page 4 - 3. The use of any portable
electronic transmission

. : devices aboard aircraft
Note that you need to install both the WLAN & Bluetooth drivers for the WLAN R

& Bluetooth Combo modules. Make sure the WLAN &

Bluetooth module(s)
are OFF if you are using
the computer aboard
aircraft by putting the
system in to Airplane
Mode (see

).

Wireless LAN Module 6 - 11
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3rd Party 802.11b/g/n Driver Installation

1. Makesurethemoduleison and the system isnot in Airplane Mode,
and then insert the Device Drivers & Utilities + User’s Manual disc into
the DVD drive.

Click Option Drivers (button).

Click 1L.Install WLAN Driver > Yes,

Click Next.

Click Finish to restart the computer.

The operating system is the default setting for Wireless LAN control in
Windows (see page 6 - 13).

ok wN

Intel® WLAN Driver Installation

1. Makesurethemoduleison and the system isnot in Airplane Mode,

and then insert the Device Drivers & Utilities + User’s Manual disc into

the DVD drive.

Click Option Drivers (button).

Click 1L.Install WLAN Driver > Yes.

ICIis(t:gliln the check box to agree to the End User License Agreement and click
nstall.

Click Finish.

The operating system is the default setting for Wireless LAN control in

Windows (see page 6 - 13).

o0 WD

. |
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WLAN Configuration in Windows

Y ou can configure a wireless connection using one of the following options, how-
ever make sure the Wireless LAN module is turned on (and not in Airplane Mode)
before configuration begins.

Charms Bar
1. Go tothe Charms Bar.

2. Select Settings and then click the WiFi icon (it should read Available under the
icon and Airplane mode should be Off).
3. Alist of available access points will appear.

(© Networks
l") Airplane mode
) oft Figure6 - 10
Available 67 Brightness WiFi Settings
(Charms Bar) &
Networks

On

2 ¢

Motifications Power Keyboard

.IIII CPhone

al RD113-A5US-RTe6U-2....

al RDT13
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Double-click an access point to connect to it (or click it and click Connect).

Enter a network security key (password) if required, and click Next.

You can choose to find other devices or not.

When you are connected to the network access point it will display Connected

[ Connected |

8. Select any connected network and click Disconnect to disconnect from a
connected access point.

No A

(© Networks (© Networks

Airplane mode Airplane mode

Off

Figure6- 11
Networks
Connected /
Disconnect

On

.I“l CPhone

RD113-ASUS-RTE6U-2....
all

all RD113

9. You can click the Airplane Mode button to turn the mode (including Bluetooth) On
or Off.
10. Alternatively you can click the WiFi button to turn just the WiFi On or Off.

6 - 14 Wireless LAN Module
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Desktop Mode

1.

Noogkwd

Switch to the Windows Desktop (click the app or use the Windows logo key == +
D key combination).

Click the wireless icon [l in the notification area of the taskbar.

A list of available access points will appear.

Double-click an access point to connect to it (or click it and click Connect).

Enter a network security key (password) if required, and click Next.

You can choose to find other devices or not.

Select any connected network and click Disconnect to disconnect from a
connected access point.

(© Networks

Airplane mode

(© Networks off Figure6 - 12
Windows Desktop
Airplane mode Taskbar Notification
on Area WLAN
Connection

.|||| CPhone

RD113-ASUS-RT66U-2....
all

| RD113
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Bluetooth & WLAN Combo Module

If your purchase option includes the Combination Wireless LAN & Bluetooth
module (either Intel® or 3rd Party) then install the driver as instructed overleaf.

MN\Z
2§
Wireless Device

Operation Aboard
Aircraft

Make sure that the module ison (i.e. the systemis not in Airplane M ode) beforein-
The use of any portable stalling the driver.

electronic transmission
devices aboard aircraft
is usually prohibited.

e
Make sure the WEAN & Bluetooth Data Transfer
Bluetooth module(s)
are OFF if you are using
the computer aboard
aircraft by putting the
system in to Airplane

Mode (see

Note that the transfer of data between the computer and a Bluetooth enabled device is supported

in one direction only (simultaneous data transfer is not supported). Therefore if you are copying
a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from
the Bluetooth enabled device to your computer until the file transfer process from the computer
has been completed.

).

6 - 16 Bluetooth & WLAN Combo Module



3rd Party Bluetooth (V4.0) Combo Driver Installation

1.

OO0k wWN

Make surethe moduleison and the system isnot in Airplane Mode,
and then insert the Device Drivers & Utilities + User’s Manual disc into
the DVD drive.

Click Option Drivers (button).

Click 2.Install Combo BT Driver > Yes.

Click Next.

Click Finish to restart the computer.

See “Bluetooth Configuration in Windows” on page 6 - 18 for configura-
tion instructions.

Intel Bluetooth Combo Driver Installation

1.

NookwdN

Bluetooth & WLAN Combo Module 6 - 17

Make surethe moduleison and the system isnot in Airplane Mode,
and then insert the Device Drivers & Utilities + User’s Manual disc into
the DVD drive.

Click Option Drivers (button).

Click 2.Install Combo BT Driver > Yes.

Click Next > Next.

Click in the check box to accept the license and click Next.

Click Next > Finish.

See “Bluetooth Configuration in Windows™ on page 6 - 18 for configura-
tion instructions.

Modules & Options

4

High Speed Bluetooth
Data Transfer

The Combination Wire-
less LAN & Bluetooth
module supports high
speed data transfer. How-
ever to achieve such
transfer speeds, both de-
vices must support
high speed data trans-
fer.

To obtain high speed
data transfer make sure
that both the WLAN and
Bluetooth modules are
powered on.

Check your Bluetooth
compatible device’'s doc-
umentation to confirm it
supports high speed data
transfer.
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Bluetooth Configuration in Windows

N\ A/

7£l< Y ou can configure a Bluetooth connection as below, however make sure the Blue-

Bluetooth Headset tooth moduleis on (or the system is not in Airplane Mode) before configuration.
Stereo Setup

Desktop Mode
To setup a Bluetooth 1. Switch to the Windows Desktop (click the App or use the Windows logo key 2@ +
headset to support ste- D key combination).
reo audio see page 2. Click the notification area of the taskbar and double-click the Bluetooth icon [g3§ (or
: click and select Show Bluetooth Devices).
3. The Bluetooth item in PC and Devices will appear.
OR
Charms Bar
1. Go tothe Charms Bar.
2. Select Settings and then click Change PC Settings.
3. Select the Bluetooth item in PC and Devices.

Figure 6 - 13 O E 0:

Bluetooth Taskbar Available Brightness
Icon & Change PC
Settings (Charms =]

Bar -Settings) Notifications Keybaard

‘ \ Change PC settings
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4. Make sure that Bluetooth is turned on and a list of discovered devices will appear.

5. Double-click the device you want to pair with the computer and click Pair.
Figure6- 14

PC and Devices -
Bluetooth
6. On first connection the computer will provide you with a pairing code to be entered
onto the device.

Figure6 - 15

Enter the Passcode

7. Enter the code into your Bluetooth enabled device and click Yes on the computer
to complete the pairing.
8. Select a device and click Remove Device to disconnect from any device.

Bluetooth & WLAN Combo Module 6 - 19
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To Make your Computer Discoverable to Bluetooth Devices

1. Switch to the Windows Desktop (click the app or use the Windows logo key == +
D key combination).

2. Click the notification area of the taskbar, click the Bluetooth icon and click
Open Settings.

3. Click Options, and make sure that Allow Bluetooth devices to find this
computer check box (Discovery) has a check inside it.

4. Make sure that the Alert me when a new Bluetooth device wants to connect
check box (Connections) has a check inside it, if you want to be notified when a
Bluetooth device wants to connect.

Figure6 - 16
Bluetooth Settings

. |
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Intel® Rapid Storage Technology

Install the Intel® Rapid Storage Technology to support your AHCI mode SATA
drive.

IRST Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD
drive.

Click Option Drivers (button).

Click 3.Install IRST Driver > Yes.

Click Next.

Click in the check box to accept the license and click Next.

Click Next > Next > Next.

Click Finish to restart the computer.

Run the Intel® Rapid Storage Technology app from the Apps screen.

N>R~ WN

.|
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Intel® Smart Connect Technology

Intel® Smart Connect Technology periodically, and briefly, wakes the computer
from Sleep mode in order to update information for certain applications (e.g. to get
mail from Microsoft Outlook) as required. These updates can therefore be made
T M e T without having to turn the computer on, and applications will be up to date when the
St M) G (Son computer resumc_esfrom Sleep mode (makg surethat Intel Smart Connect Technol-
nect Technology your ogy is enabled (it is enabled by default) in the BIOS - see “Intel Smart Connect
system will need to have | Technology (Advanced Menu)” on page5 - 8).

the it bled in th L .
BI%é??eeeS:geGS _'g)_ ® | Notethat th_eappllcatlons need to be on and running when the computer enters
Sleep mode in order to get updates.

Z

Intel® Smart Connect
Technology System
Requirements

In addition only certain

Intel WLAN modules . .
support this feature, | INt€I® Smart Connect Technology Driver Installation

Check with your distrib- & 1. Insert the Device Drivers & Utilities+ User’s Manual disc into the DVD
utor/supplier for de- drive.

talls. 2. Click Option Drivers (button).

Make sure that I ntel Smart Connect Technology is enabled in the BIOS -
see“Intel Smart Connect Technology (Advanced Menu)” on page 5 - 8.
Click 4.Install ISCT Driver > Yes.

Click Next.

Click in the check box to accept the license and click Next.

Click Next > Install > Finish.

Click Yesto restart the computer.

© N U A

.|
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Intel® Smart Connect Technology Configuration

\ A/
1. Access the Intel(R) Smart Connect Technology application from the Apps menu. 7£l<
2. The Keep Data Fresh ON is enabled by default (if you wish to turn it off click the Wireless Device
OFF button to do so). Operation Aboard
3. You can select to have the system update open application data every 15, 30 or Aircraft
60 minutes.

. . . . L . The use of any portable
4. Click Save to retain the settings (in order to update any applications, they will need electronic  transmission

to be on and running when the computer enters Sleep mode). = e

5. Note the sidebar warning about the use of Intel(R) Smart Connect Technology is usually prohibited.
aboard aircraft and make sure your wireless LAN module is off during air travel. Make sure the WLAN,
Bluetooth and 3G/4G

module(s) are OFF if

you are using the com-

puter aboard aircraft by

putting the system in to

Airplane Mode (see

)-

Figure6 - 17
iSCT Basic
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6. Click Customize Schedule to customize the update frequency, and the hours and

ﬁ days when the updates will occur.
. 7. Bear in mind that the more often you set the system to update, the more power is
ISCT & System consumed, and this may be a consideration if the system is battery powered.

Power

Note that Intel Smart
Connect will turn off
when it detects a low
battery level, and will

not run if the system is
Shut Down or is in Hi-
bernate mode.

It is recommended that
the system be left
plugged-in if left for an
extended period.

Figure6- 18
iSCT Customize
Schedule

.|
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8. Click the Help icon and select Help to access the menu.

Intel WLAN Modules

If your purchase option
includes an Intel WLAN
module, (with Intel's
PROSet Wireless Con-
nection  Utility in-
stalled), Intel® Smart
Connect Technology

will search for WiFi net-
works around you that
you have previously ac-
cessed.

If no known WiFi net-
works are found, your
computer will not update
again until it recognizes
a known WiFi network.

Figure6 - 19
iSCT Help
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Remote Wake
Remote Wake allows you to wake the computer remotely from another device such
as aphone, tablet or another PC. Thiswill allow you to accessfiles on the computer.

A link to a list of applications and usage is supplied if you click Learn More and
thelink provided. An application must support thisfeature and you will need to reg-
ister any devices. Check any particular application for more information on this fea-
ture, and you will need to have the application loaded on any device from which you
want to connect to the system. A list of compatible applications is provided if you
click the link provided.

LED Power Indicator & Intel® Smart Connect
The LED power indicator will blink as indicated in the table below when Intel®
Smart Connect is enabled (Intel® Smart Connect is enabled in the BIOS by de-

fault).
Icon Color Description
Table6- 1 Orange DC Power is Plugged In
Power LED Indicator Green The Computer is On
Blinking Green The Computer is in Sleep Mode
Slow (20 second intervals) The Computer is in Sleep Mode and *Intel Smart
Blinking Green Connect is Enabled

.|
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Free Fall Data Protection

(Optional) 4

The Free Fall Data Protection sensor and HDD Protect Utility will help protect your ~ Sensitivity

hard disk drive, in the event that the computer is accidentally dropped, by parking | Adiustment& Power
the HDD read/write heads away from the platter to avoid scratching the surface of SEMIi, SElss
the hard disk. If you want to install Free Fall Data Protection then follow the pro- | Note that you can adjust
cedure outlined on the following pages to install the driver, and then configure the | the sensitivity level of the

. S HDD Protect Utility by
sensitivity from the application. means of the slider at the

) . . bottom of the screen,
Free Fall Protection Driver Installation however it will take a few
seconds for adjustments

1. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD A
drive, to come into effect.

2. Click Option Drivers (button). If the system is in a pow-
3. Click 5.Install Freefall Protection > Yes. Greeviitg sEs {6 Wil

. also take a few seconds
4. Cl!Ck Next > Next. for the system to imple-
5. Click Install. ment HDD protection.
6. Click Finish.
7. Click Yesto restart the computer.

. |
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HDD Protect Utility Configuration
1. Accessthe HDD Protect Utility from the Free-Fall Sensor Utility Start screen, or
by right-clicking the icon in the notification area of the taskbar and selecting Show.

Figure6 - 20
Free Fall Data
Protection Access
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2. The Free Fall Protection Data Protection can be enabled or disabled by clicking the
icon in the notification area of the taskbar, or by clicking Enable/Disable in the HDD
Protect Utility. and then clicking OK.

3. The taskbar icon will be orange when data protection is ON, and blue when
it is OFF.

( } ( } Figure6- 21

Free Fall Data
Protection Enabled/
Disabled
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4. Adjust the sensitivity level by means of the slider at the bottom of the screen.

Figure6 - 22
HDD Protect Utility
(Sensitivity)

5. If the computer is accidentally dropped the HDD heads will be parked temporarily
to avoid damage (the icon will switch to an exclamation mark when the heads
are parked).

6. This should take only a few seconds and the computer will be ready for use soon
after.

Figure6 - 23
HDD Protect Utility
(Disk Heads Parked)

. |
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3G/4G Module S

SN
If you have included an optional UM T S/H SPA+ based 3G Module (Universal Mo- /Zl\

bile Telecommunications System or High Speed Packet Access) module or LTE nggfiﬁzi ii‘g;fd

(Long Term Evolution) 4G module (see“ Communication” on page D - 4 for spec- Aircraft
ification details) in your purchase option, you do not require a driver/application
. . . . . . The use of any portable
installation for Windows. Follow the instructions overleaf to install the USIM card RS SEEEE i
(which will be provided by your service provider), and then use the Charms Bar B CEVES el e -1
Wirelessicon to access the 3G/4G network in the same manner asthe WLAN. is usually prohibited.
Make sure the WLAN &
ﬁ Bluetooth module(s)
LS are OFF (or the system
Important Notice is in Airplane Mode) if
you are using the com-
puter aboard aircraft
(see

If your purchase option includes both Wireless LAN and 3G/4G modules, then the appro-
priate antennas will be installed. Note that In order to comply with FCC RF exposure com-
pliance requirements, the antenna must not be co-located or operate in conjunction with
any other antenna or transmitter.

Important Notice - 3G/4G & Bluetooth/Wireless LAN Modules

)-

In order to comply with FCC regulations you should NOT operate the 3G/4G module and
the Bluetooth/Wireless LAN modules at the same time as this may disrupt radio frequency,
and cause interference. When the 3G/4G module is powered on, make sure that the Blue-
tooth/Wireless LAN modules are powered off.
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3G/4G Module USIM Card Installation for Model B Computers

\ o/

ZAS Follow the instructions below to install the USIM card (which will be provided by

Power Safety your service provider).
Warning

Turn the computer off, and turn it over.

Slide the latch @ in the direction of the arrow.

Slide the latch @ in the direction of the arrow, and hold it in place.

turned off the power, and Slide the battery out in the direction of the arrow @.

disconnected all peripher- Insert the USIM card @ as illustrated below until it clicks fully into position, and

als and cables (including replace the battery.
telephone lines).

Before you undertake any
installation procedures,
make sure that you have

aorNE

USIM Card Orientation

Note that the USIM card’s o 9

readable side (with the
gold-colored contacts)
should face upwards as il-

lustrated. 9 a

Figure6 - 24
Battery Removal &
USIM Card Insertion
Model B
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3G/4G Module USIM Card Installation for Model A Computers

Follow the instructions below to install the USIM card (which will be provided by
your service provider). In normal circumstances you should not remove the bottom
cover of the computer as this can void your warranty. However in the case of M odel
A computersit is necessary to remove the bottom cover to insert the 3G/4G USIM
card. If you are not comfortable with this then ask your distributor/supplier for as-
sistance.

Before you begin you will need:

» A small crosshead or Phillips screwdriver
* A small regular slotted (flathead) screwdriver
e Anantistatic wrist strap

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo-
nents.

Please make surethat you review each procedure beforeyou perform it.
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1. Turn off the computer, turn it over.
A 2. Remove the SD card cover 1 and screws @ - @ from the bottom case.

Power Safety

Warning
(2] (6]

Before you undertake any e
installation procedures,
make sure that you have
turned off the power, and 9 6
disconnected all peripher-

als and cables (including
telephone lines).

USIM Card Orientation

Note that the USIM card’s
readable side (with the
gold-colored contacts) @ @
should face upwards as il-

lustrated.

Figure6 - 25
Bottom Case Screw 1
Removal
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3. Carefully separate the bottom case 15 from the top case in the direction of the

arrow at point @0 - @.

4. The battery will be visible at point @®.

15
® d
(16 .
Figure6 - 26
Bottom Case
Removal
(16
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5. Remove screws @ - @ from the battery.
6. Lift the battery 21 off the computer in the direction of the arrow €.

®

Figure6 - 27 ®

Battery Removal

D .

7. Insertthe USIM card 22 until it clicks fully into position, and replace the battery,
bottom case and screws.

Figure6 - 28
USIM Card
Installation

22
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8. If you need to remove the USIM card 23 push it in until it is released.

Figure6 - 29
& USIM Card Removal

9. Reverse the process to insert the battery (do not forget to replace all the screws).
10. Reattach the bottom cover with the top case at point @ in the direction of the

arrow €.

11. Snap together the sides of the bottom cover and top case and replace the
corresponding screws.

(25) Figure6 - 30
Bottom Cover
® Replacement
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3G/4G Module PIN
Code & Power-Saving

Note that there may be
some issues when a/4G
PIN Code is set for 3G
modules in Windows, if
Mobile Broadband has
been turned off, and the
system has resumed
from a power-saving
state. See

Figure6 - 31
Networks
Mobile Broadband

3G/4G Configuration in Windows

Y ou can configure a 3G/4G connection as below, however make sure the systemis
not in Airplane Mode before configuration begins.

Charms Bar

1. Go tothe Charms Bar.

2. Select Settings and then click the WiFi icon (it should read Available under the
icon and Airplane mode should be Off).

3. Alist of available access points will appear under Mobile Broadband.

* i > Cl)"

Dt

Available 67 Brightness

2 O

Notifications Power Keyboard

Change PC settings

\/
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Any 3G/4G service provider (connection information is usually stored on the USIM
card) will appear under Mobile Broadband.

Double-click any connection icon under Mobile Broadband (or click and then click
Connect).

Figure6 - 32
Mobile Broadband

(Connect) a

6. The system will connect to your network.

7. A Connected will appear alongside the 3G/4G connection (click the connection to
view the timer which indicates your connected time for the current session).

|
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- 8. You can then access the internet, download e-mail etc. as per any internet
2§ connection.

Wireless Device 9. To disconnect you can select the connection and click Disconnect [E2e].

Operation Aboard
Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.

Make sure the system is
in Airplane Mode if you
are using the computer
aboard aircraft.

Figure6 - 33
Mobile Broadband 10. You need to either use Airplane Mode, or to turn the Mobile Broadband module
(Disconnect) off aboard aircratft.
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Trusted Platform Module

(Optional)

The TPM security chip allowsyou to create and manage digital certificatesfor user
and platform authentication. This type of security is usually administered within
large enterprises and organi zations, and therefore requires implementation by a sys-
tem administrator before users can access security features.

Make sure you have administrator’ s rights to your computer, and have a Windows
password enabled for full security protection. In addition Make sure you prepare
aremovablemedia (e.g. aUSB flash drive) to stor e passwor dsetc. befor e begin-
ning the TPM initialization process.

Before setting up the TPM functions you must enable and initialize the security plat-
form.
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Enabling & Activating TPM

Restart the computer.

Enter the Aptio Setup Utility pressing F2 during the POST/startup.

Use the arrow keys to select the Security menu.

Select TPM Configuration and press Enter to access the sub-menu.

Press Enter to access the TPM Support menu and select Enable in Security
Device Support.

You will then need to press F4 to save the changes and restart the computer.

grwONPE

o

Aptio Setup Utility — Copyright (C) 2014 American Megatrends Inc.

Security Device Support [Enable]

Figure6 - 34
Security Device
Support (Enabled)

. |
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TPM Management in Windows
Y ou can manage your TPM settings from within Windows:

1. Go tothe Control Panel.
2. Click BitLocker Drive Encryption (System and Security).
3. Click TPM Administration.

Figure6 - 35 a

BitLocker Drive
Encryption
(TPM
Administration)
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4. The TPM Management window allows you to configure the TPM within Windows.
As TPM is usually administered within large enterprises and organizations, your
system administrator will need to assist you in managing the information here.

b Figure6 - 36

Trusted Platform
Module (TPM)
Management on
Local Computer
Administration
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TPM Actions

1. Click Prepare the TPM and follow the instructions in the Wizard to prepare the
TPM (this will probably require a restart of the computer and confirmation of the
setting changes after restart by pressing the appropriate F key).

2. After the restart the TPM will be prepared and you can then use the Actions menu
to Turn TPM off, Change Owner Password, Clear TPM or Reset TPM Lockout.

3. A wizard will help take you through any setup steps.

Figure6 - 37
TPM Actions Menu

. |
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BitLocker

BitLocker Drive Encryption can be used in conjunction with the TPM to encrypt
data on the disk. Access the Microsoft BitL ocker Drive Encryption control panel
applet from the Windows control panel (System and Security).

1. Click Turn on Bit Locker.
2. Follow the on-screen instructions to setup BitLocker, and make sure you have a
removable media (e.g. a USB flash drive) to store saved recovery keys etc.

Figure6 - 38
BitLocker Drive
Encryption

. |
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Wireless Display uses your Wireless LAN module/WLAN Bluetooth Combo mod-
ule (you need to make surethat your video adapter/display deviceiscompatible
with your particular WL AN/Combo module) in conjunction with a compatible
video adapter/display device (purchased separately) to allow you to display the
contents of the notebook display on another display (e.g. HDTV), without the need
to have cables stretching across a room.

Y ou can use the wireless display to play games, browse the internet, display videos
or photo slide shows on your TV/externa display without using HDMI or A/V ca
bles.

Before configuring Wireless Display you will need to set up your compatible
adapter with your display/speakers. Connect the adapter usingan HDMI or A/V ca
ble and turn on the display (or in the case of speakers connect them to the wireless
speaker adapter with the cables provided with the adapter), and then set the display
to the appropriate input channel (see the documentation supplied with your compat-
ible adapter/display for full details).

Note that no driver or application is required for wireless display in Windows 8.1.

Modules & Options

4

Compatible
Adapters

For a list of compatible
adapters check the vid-
eo adapter/display de-
vice documentation, or

with  your
supplier.

distributor/ a
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Wireless Display Configuration

Note that no driver or application is required for wireless display in Windows 8.1.
Go the Charms Bar, select Devices.

Click Project.

Click Add a wireless display.

PR

Figure6 - 39
Add a Wireless
Display
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5. The system will then search for compatible display devices (this may take up to
60 seconds so allow time for this to complete).

Figure 6 - 40
Searching For
J Devices

6. Double-click any detected display device in the list.
7. You may then need to input a pin number for the device to which you are
connecting.
8. Click Next.
Figure6 - 41
Enter PIN

.|
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9. The display will then connect (for specific settings for your display see the
documentation supplied with your compatible adapter/display for full details).

10. To disconnect from the display you can select it in PC and Devices > Devices and
click Remove Device > Yes; or go to the Project menu (Charms Bar > Devices)
and click Disconnect.

Figure6 - 42

b Remove Device/ < >

Disconnect

S

Remove device
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Chapter 7: Troubleshooting

Overview

Should you have any problemswith your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’'t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautionsin the preface.
If al elsefails, talk to your service representative. Y ou should also make a record of what happened and what
remedies you tried.

Of course, if something goeswrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you' ve tried everything, and the system still won't cooperate, try turning it off
for afew minutes and then rebooting. Y ou will lose any unsaved data, but it may start working again. Then call
your service representative.

. |
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Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working.

Power - Isthe computer actually plugged into aworking electrical outlet? If plugged into apower strip,
make sure it is actually working. Check the LED Power & Communication Indicators (see“LCD Panel
Open - Model A” on pagel-7 & “LCD Panel Open - Model B” on page 1 - 8) to see the computer’s
power status.

Connections - Check all the cables to make sure that there are no loose connections anywhere.

Power Savings - Make sure that the system is not in Hiber nate or Sleep mode by pressing the keys config-
ured in your Power Options (see “ Power-Saving States” on page 3 - 7), the Fn + F12 key combination, or
power button to wake-up the system.

Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
NEss.

Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive.
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Backup and General Maintenance

» Always backup your important data, and keep copies of your OS and programs safe, but close to hand.
Don't forget to note the serial numbersif you are storing them out of their original cases, e.g. inaCD wal-
let.

* Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with
your OS, or buy the more powerful dedicated programs to do so.

» Write down your passwords and keep them safe (away from your computer). Thisis especially important if
you choose to use a Super visor password for the BIOS (see “ The Setup Utility” on page5 - 2).

» Keep copiesof vital settingsfiles such as network, dialup settings, mail settings etc.(even if just brief notes).

N2
2

Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-
ranty.
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Viruses

» Ingtal an Anti-Virus program and keep the definitionsfile (the file which tells your program which viruses
to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tionsfile updates are usually downloadable directly from the internet.

» Becareful when opening e-mail from sources you don’'t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

» Keepa“Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic
information which allows you to startup your computer) handy. You may refer to your OS's documentation
for instructions on how to make one, and many Anti-Virus programs will also provide such adisk (or at
least instructions on how to make one).
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Upgrading and Adding New Hardware/Software

Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are
doing, otherwise you will risk severely damaging your system.

Don’'t open your computer or undertake any repair or upgrade work if you are not comfortable with what
you are doing.

Read the documentation. We can assume, since you are reading this that you are looking at the computer’s
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by
the installation of new hardware and/or software. Always refer to the documentation of any new hardware
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

When installing a new device always make sure the device is powered on, and in many cases you will need
to restart the computer. Always check that all the cables are correctly connected.

Make sure you have installed the drivers for any new hardware you have installed (latest driver filesare
usually available to download from vendor’s websites).
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» Thoroughly check any recent changes you made to your system as these changes may affect one or more
system components, or software programs. If possible, go back and undo the change you just made and see
if the problem still occurs.

» Don't over complicate things. The less you have to deal with then the easier the source of the problem may
be found; Example - if your computer has many devices plugged into its ports, and a number of programs
running, then it will be difficult to determine the cause of aproblem. Try disconnecting all of the devices and
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and

removing devices and restarting where necessary) will often find the source of a problem, although this may
be time consuming.
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Problems and Possible Solutions

Problem Possible Cause - Solution

You turned on the power but it doesn't | Battery missing / incorrectly installed. Check the battery bay, make sure the
work. battery is present and seated properly (the design of the battery only allows it to
go in one way). Make sure there’s nothing interfering with the battery contacts.

The battery LED power indicator ,is | Low Battery. Plug in the DC power source. If the computer doesn’t start up
blinking orange. immediately, turn it off then on again.

You are losing battery power too quickly. | The system is using too much power. If your OS has a Power Options scheme
(see “Power Plans” on page 3 - 5) check its settings. You may also be using a
peripheral device/lUSB device that is drawing a lot of power.

Actual battery operating time is shorter | The battery has not been fully discharged before being recharged. Make sure
than expected. the battery is fully discharged and recharge it completely before reusing (see
pages 3 - 14 to 3 - 21).
Power Options have been disabled. Go to the Control Panel in Windows and
re-enable the options.

A peripheral device/lUSB device is consuming a lot of power. Turn off/fremove
the unused device to save power.

. |
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Problem

Possible Cause - Solution

The computer feels too hot.

Make sure the computer is properly ventilated and the Vent/Fan intakes are not
blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn
it off for an hour. Make sure the computer isn't sitting on a thermal surface (see
“Overheating” on page 1 - 24). Make sure you're using the correct adapter.

Make sure that your notebook is completely powered off before putting it into a
travel bag (or any such container). Putting a notebook which is powered on in a
travel bag may cause the Vent/Fan intakes to be blocked.

Nothing appears on screen.

The system is in a power saving mode. Toggle the sleep/resume key
combination, Fn + F4 (see “Configuring the Power Buttons” on page 3 - 9).

The screen controls need to be adjusted. Toggle the screen control key
combinations Fn + F8/F9. If you're connected to an external monitor, make sure
it's plugged in and turned on. You should also check the monitor’s own
brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key
combination, Fn + F7. If an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

No image appears on the external
monitor | have plugged in and powered
on.

You haven't installed the video driver and configured it appropriately from the
Control Panel. See Appendix C for instructions on installing and configuring
the video driver.
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Problem

Possible Cause - Solution

You forget the boot password.

If you forget the password, you may have to discharge the battery of the CMOS.
Contact your service representative for help.

AN
Ik

Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.

The sound cannot be heard or the volume
is very low.

The volume might be set too low. Check the volume control in the Volume
Control Panel in the Windows notification area, or use the key combination Fn
+ F5 and F6 (see “Function/Hot Key Indicators” on page 1 - 13) to adjust.

The CD/DVD cannot be read.

The CD/DVD is dirty. Clean it with a CD/DVD cleaner kit.

The CD/DVD tray will not open when
there is a disc in the tray.

The CD/DVD is not correctly placed in the tray. Gently try to remove the disc
using the eject hole (see “Loading Discs” on page 2 - 3).

The DVD regional codes can no longer
be changed.

The code has been changed the maximum 5 times. See “DVD Regional
Codes” on page 2 - 5.

Unwelcome numbers when

typing.

appear

Num Lock is turned ON (see “Function/Hot Key Indicators” on page 1 - 13).
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Problem

Possible Cause - Solution

| am sliding my finger up and down on the
right side of the Touchpad to scroll a
Window and the Touchpad does not
respond.

There are different Touchpad versions available on this computer, and this
version requires tapping/holding to scroll. Either tap repeatedly, or hold the
finger down, at the top or bottom right of the Touchpad (depending on the
scrolling direction required) to scroll the window.

work.

4

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will
detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not

The system freezes or the screen goes
dark.

The system’s power saving features have timed-out. Use the AC/DC adapter,
press the sleep (Fn + F4) key combination, or press the power button if no LEDs
are lit.

The system never goes into a power
saving mode.

Power Options features are not enabled. Go to the Windows Power Options
menu and enable the features you prefer (see “Power-Saving States” on
page 3 - 7). Make sure you have enabled Hibernate mode from the control
panel.

The Wireless LAN/Bluetooth modules
cannot be detected.

The modules are off as the computer is in Airplane Mode. Go to the Charms
Bar and select Settings and then click the WiFi icon (Airplane mode should be

off).
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Problem

Possible Cause - Solution

The PC Camera module cannot be
detected.

The module is off. Press the Fn + F10 key combination in order to enable the
module (see “Function/Hot Key Indicators” on page 1 - 13). Run the camera
application to view the camera picture.

The Wireless LAN/Bluetooth modules
cannot be configured.

The driver(s) for the module(s) have not been installed. Make sure you have
installed the driver for the appropriate module (see the instructions for the
appropriate module in “Modules & Options” on page 6 - 1).

A file cannot be copied to/from a

connected Bluetooth device.

The transfer of data between the computer and a Bluetooth enabled device is
supported in one direction only (simultaneous data transfer is not
supported). If you are copying a file from your computer to a Bluetooth enabled
device, you will not be able to copy a file from the Bluetooth enabled device to
your computer until the file transfer process has been completed

| cannot obtain high speed Bluetooth data
transfer.

To obtain high speed Bluetooth data transfer take into account the following:

» To achieve high speed transfer speeds, both devices must support high
speed data transfer (i.e both the computer and the Bluetooth compati-
ble device you are connecting to).

* Check your Bluetooth compatible device's documentation to confirm it
supports high speed data transfer, and for configuration information.
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Problem

Possible Cause - Solution

| have used Update Driver in Device
Manager (Unknown device > Other
Devices) to try and install the Airplane
Mode driver. Windows encountered a
problem in attempting to update the driver,
and a yellow exclamation mark appears
in Device Manager against the Unknown
device.

It is very important that the drivers are installed in the order indicated in Chapter
4 (which is the numbered installation order on the Device Drivers & Utilities +
User’s Manual disc). This issue can occur when drivers are manually installed,
and not in the correct order.

If you have attempted to Update Driver from the Device Manager control panel
and have encountered problems, then use the method below to correct this:

To correct this problem:

1. Go tothe Programs and Features (Programs) control panel in
Windows.

2. Select any installed Airplane Mode driver item (e.g. Insyde Airplane
Mode HID Mini-Driver), and click Uninstall/Change to uninstall the
current driver.

3. Restart the computer.

4. Insert the Device Drivers & Utilities + User’'s Manual disc and click
Install Drivers (button).

5. Double-click the Airplane Driver item in the menu.

6. Follow the instructions to install the correct driver (you will need to
restart the computer as part of the installation process).
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Problem Possible Cause - Solution

| have connected a Bluetooth Mouse but | This is an issue with some mouse models and the Intel Wireless 7260 WLAN
it loses the Bluetooth connection and | and Bluetooth combo module series. To resolve this issue do the following:

no longer responds after a short period of
inactivity. Go to the Device Manager control panel in Windows.

Click the arrow alongside Bluetooth to expand the menu if required.
Double-click Intel(R) Wireless Bluetooth(R) 4.0 + HS Adapter.
Click the Power Management tab.

Make sure that the check box alongside “allow the computer to turn
off this device to save power” doesn’t have a check alongside it.

Click OK and close the control panel.

agrwbhE

o

Intel(R) Wireless Bluetooth(R) 4.0 + HS Adapter Prope... |

General | Advanced | Driver | Details E\rerrt

9 Intel{R) Wirsless Blustocth(R) 4.0 = H5 Adapter

QG

low the computer to tum off this device to save power:

Figure 7 - 1 - Device Manager (Bluetooth)
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Problem

Possible Cause - Solution

When using a Bluetooth headset the
audio appears to be mono and not
stereo.

This is a common issue with Bluetooth headsets. To resolve this issue do the
following (you will need to repeat this procedure after every boot up, restart,
or when the system resumes from hibernation):

Go to the Devices & Printers control panel in Windows.
Double-click the Bluetooth headset.
Click Connect to complete the stereo connection.

Go to the Sound control panel in Windows.

Right-click (in the Playback tab) the Bluetooth Stereo Audio device
(the default device is Headset).

Click Connect to complete the stereo connection.

NEOWDNE
Py}
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3G/4G Module PIN Code & Power-Saving

Note that there may be someissueswhen aPIN Codeis set for a3G/4G module (if you are unsure of your module
version contact your distributor/supplier) in Windows, if Mobile Broadband has been turned off, and the system
has resumed from a power-saving state. To prevent any issuesit isrecommended that you ssimply do not en-
ableaPIN for a 3G/4G module. The following provides instructions for disabling the PIN code.

Disabling a PIN code for a 3G/4G Module

1. Go tothe Charms Bar.
2. Click Change PC Settings.

6"

* I‘a) ‘0-
67

Available Brightness

2 o

Notifications Power Keyboard

Change PC settings )

Figure 7 - 2 - Change PC Settings

3G/4G Module PIN Code & Power-Saving 7 - 15



Troubleshooting

Click Network.

Click the broadband connection under Mobile Broadband.

Scroll down to Security and click Remove PIN.

Enter the current PIN number and click OK.

It is recommended that you do not Enable a PIN for a 3G/4G module.

-

NooM®

-
-

Figure 7 - 3 - Disable PIN
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Resolving the “Insert a SIM” issue with the 3G/4G Module (Windows 8.1)

1. If a PIN was set for the 3G/4G module, you have then switched Mobile broadband off (or put the system in
Airplane Mode) in Networks, and the system has just resumed from a power-saving state the following error
may occur.

On resuming from the power-saving state the standard procedure would be to go to Networks in the Charms
Bar and turn on Mobile broadband.

Go to the Charms Bar.

Select Settings and you will then note that the WiFi icon will read Unavailable.

Standard procedure would be to click the connection and enter the PIN number to unlock the connection.

In this instance you will note that the Mobile broadband connection will read Insert a SIM.

In this case you will need to restart the computer.

After system restart you can then connect to the Mobile Broadband as normal.

To fully resolve this issue it is recommended that you do not Enable a PIN a 3G/4G module.

n
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Appendix A: Interface (Ports & Jacks)

Overview

The following chapter will give aquick description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.
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Notebook Ports and Jacks

ltem

Description

Card Reader

The card reader allows you to use some of the latest digital storage cards. Push the card into the
slot and it will appear as a removable device.

DC-In Jack

Plug the supplied AC/DC adapter into this jack to power your computer.

External Monitor (VGA)
Port

This port allows you to connect an external monitor, or Flat Panel Display, to get dual video or
simultaneous display on the LCD and external monitor/FPD.

HDMI-Out Port

The HDMI-Out (High-Definition Multimedia Interface) is an audio/video connector interface for
transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or
Flat Panel Display etc. as a display device by means of a HDMI cable. Note that HDMI carries
both audio and video signals.

Headphone-Out Jack

Headphones or speakers may be connected through this jack. Note: Set your system’s volume to
a reduced level before connecting to this jack.
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Item Description
Microphone-In Jack Plug an external microphone in to this jack to record on your computer.
RJ-45 LAN Jack This port supports LAN (Network) functions.

Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

USB 2.0/1.1 Port The USB 2.0 compatible port (USB 2.0 is fully USB 1.1 compliant) is for low-speed peripherals
such as keyboards, mice or scanners, and for high-speed peripherals such as external HDDs,
digital video cameras or high-speed scanners etc. Devices can be plugged into the computer, and

USB 3.0 Port unplugged from the computer, without the need to turn the system off (if the power rating of your
USB device is 500mA or above, make sure you use the power supply which comes with the
device).

3.0

The USB 3.0 ports are denoted by their blue color; and the USB 2.0 port is colored black.
USB 3.0 will transfer data much faster than USB 2.0, and is backwards-compatible with USB 2.0.

.|
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Appendix B: Control Center

Overview

The following chapter will give a quick description of the functions of the Control Center. The Control Center
givesquick accessto frequently used controls, power management features and enables you to quickly turn mod-
ules on/off. Click the Control Center iconsto toggle the appropriate function, or hold the mouse button down
and movethedial control where applicable. Certain functionswill automatically be adjusted when a power mode
is selected. The Control Center in Windows 8.1 works under the Desktop App and not under the Start screen.

4

Control Center Access

To run the Control Center press
the Fn + Esc key combination or
double-click the icon in the
notification area of the taskbar. ﬂ
Close the Control Center by
clicking the close icon in the
top right of the panel (move the

cursor onto the top right corner
of the panel to highlight it).

Figure B - 1 - Control Center

Control CenterB - 1



Control Center

Power Modes
Y ou can set a Power M ode by clicking the appropriate icon at the top of the Control Center. Each power
mode will affect the Power Conservation Mode, Airplane Mode, Power Plan and PC camera power etc.

You can click a Control Center icon to set an overall power mode and then click individual iconsin the
Control Center to power on/off the Touchpad and PC camera.

Modes Quiet Power Saving Performance Entertainment
Icon
Power Plan Balanced Power Saver High Performance Balanced
Power Conservation Mode Balance Energy Star Performance Balance
PC Camera ON OFF ON ON
TouchPad ON ON ON ON
Airplane Mode OFF ON OFF OFF

Table B - 1- Power Modes
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Control Center Menus
The Control Center contains 2 menu headings (System Program & Device) under the Power Modes. Click
the menu headings and then click any of the buttons outlined on the following pages.

Figure B - 2 - Control Center Menus
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Power Status (System Program) /
The Power Statusicon will show whether you are currently powered by the battery, or by the AC/DC adapter
plugged in to aworking power outlet. The power status bar will show the current battery charge state.

Brightness (System Program)
The Brightness icon will show the current screen brightness level. You can use the slider to adjust the screen
brightness or the Fn + F8/F9 key combinations, or use the Fn+ F2 key combination to turn off the LED backlight
(press any key to turn it on again).

Volume (System Program)
The Volume icon will show the current volume level. Y ou can use the slider to adjust the Volume or the Fn +
F5/F6 key combinations, or use the Fn+ F3 key combination to mute the volume.

Fan Speed (System Program)

Y ou can set thefan speed to M aximum (full power), Automatic or Custom from this menu item. The fan speed
will adjust itself automatically to control the heat of the CPU. However you can adjust the setting to maximum
if you prefer. Select Custom and click on the sliders to adjust the settings to your preference, however these set-
tings can be overridden by the system, as a safety precaution, if it requires heavier use of the fan.

4

Custom Settings

Click Save to retain customized settings, or Reset to select default settings.
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Power Conservation (System Program)

This system supports Ener gy Star power

management features that place computers (CPU, hard drive, etc.) into alow-power sleep modes after a desig-
nated period of inactivity (see “ Power Conservation Modes’ on page 3 - 12). Click either the Perfor mance,
Balanced or Energy Star button.

Sleep Button (System Program)
Click either the Hiber nate or Sleep buttons to have the computer enter the selected power-saving mode when
the Fn + F4 key combination is pressed (see “ Power-Saving States” on page 3 - 7).

Display Switch (System Program)
Click the Display Switch button to access the menu (or use the 3§ + P key combination) and select the appro-
priate attached display mode.

Time Zone (System Program)
Clicking the Time Zone button will access the Date and Time Windows control panel. ﬂ

Desktop Background (System Program)
Clicking the Desktop Background button will alow you to change the desktop background picture.

TouchPad/PC Camera (Device)
Click either of these buttons to toggle the TouchPad or camera module' s power status. The icon will appear

. |
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dimmed when it is disabled. Note that the power status of the cameramoduleis a so effected by the Power M ode
selected (see Table B - 1, on page B - 2).

Caps Lock/Scroll Lock/ Number Lock/Airplane Mode
Click the button to toggle the appropriate lock mode and Airplane Mode.
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Appendix C: Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features’ on
page 1 - 36.

Intel Video Driver Installation
Make sure you install the driversin the order indicated in Table 4 - 1, on page 4 - 3.
1. Click 2.Install VGA Driver > Yes.

2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Note: After installing the video driver go to the Display control panel to adjust the
video settings to the highest resolution.

Dynamic Video Memory Technology

Intel® DVMT automatically and dynamically alocates as much (up to 1748MB)
system memory (RAM) as needed to the integrated video system (the video driver
must beinstalled). DVMT returns whatever memory is no longer needed to the op-
erating system.

Intel Video Driver Installation C - 1

4

Video Card Options

Note that card types,
specifications and driv-
ers are subject to contin-
ual updates and
changes. Check with
your distributor/supplier
for the latest details on
video cards supported.

DVMT Notes

DVMT is not local video
memory.

DVMT will not function
in MS-DOS. DOS uses
the legacy memory indi-
cated.
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Intel® HD Graphics Control Panel

Advanced video configuration options are provided by the Intel®@ HD Control Pan-
el. To access the control panel see below and overleaf:

1. Click the Intel® HD Graphics Control Panel icon in the Apps screen.

FigureC-1
Apps Screen
Intel® HD Graphics
Control Panel

(seeover)
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OR

2. Right-click the Desktop and select Graphics Properties from the menu.

OR

3. Click Advanced settings in the Screen Resolution control panel in Windows.

4. Click the Intel(R) HD Graphics Control Panel tab and click Graphics Properties
(button).

5. Double-click the Intel(R) HD Graphics control panel in the Windows Control
Panel.

FigureC- 2
Intel® HD Graphics
Control Panel
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Y ou may make changesto any of the graphics properties by clicking the appropriate
menu panel and adjusting the settings from the menus.

FigureC- 3
Intel® HD Graphics
Control Panel
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Sub-Menus
Some of the menu panelswill also have sub-menus (in the top left corner of the menu
alongsidetheicon ) to display further configuration options.

FigureC-4
Intel® HD Graphics
Control Panel
Sub-Menus
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Display
Z \ Click either Display Settings or Color Settings to make display adjustments, in-
Multiple Display cluding configuration for any attached external displays.
At least one other dis-
play must be attached in < \;

order to view multiple
display selection op-
tions.

FigureC-5
Intel® HD Graphics
Control Panel
Display Settings
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Click the Display menu at the top of the screen to display the sub-menus. The M ul-
tiple Displays menu allows you to configure the display mode of any attached dis- Z
plays (see” Attaching Other Displays’ on page C - 17). Multiple Display
At least one other dis-
play must be attached in
order to view multiple
display selection op-
tions.

Audio Settings

Any attached active dis-
plays must have audio
capacity to allow audio
configuration.

FigureC-6

Intel® HD Graphics

Control Panel
Display Settings -
Multiple Displays
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The Custom Resolutions sub-menu allows you to adjust the display (or any at-
tached display) to any width, height, refresh rate, color depth and underscan percent-
age of your choice. Note that incorrect settings can cause system instability and even
possible component damage, so thisis adjusted at your own risk.

FigureC-7
Intel® HD Graphics
Control Panel
Display Settings -
Custom
Resolutions
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3D

This menu allows you to choose how 3D images are displayed. Performance Qual-
ity displaysthe most detail, Balanced M ode provides better computer performance
with good quality and Custom allows you to configure the Anisotropic Filtering
and Vertical Sync and features to your preferences. Click Apply to save changes.

FigureC-8
Intel® HD Graphics
Control Panel 3D
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Options and Support
Hot Key Manager in Optionsand Support allowsyou to create hot keysfor open-
ing the application, rotating the display, scaling etc. Click Apply to save changes.

FigureC-9
Intel® HD Graphics
Control Panel
Options and
Support
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Click the Options menu at the top of the screen to display the sub-menus. The In-
formation Center provides details on System Information, the Built-1n Display Z
and any attached displays.

Preferences
Go to the Preferences
sub-menu in Options to
configure the preferences
for the Intel® HD Graphics
Control Panel.

Make sure you Enable
Tray Icon to display the In-

tel® HD Graphics Control
Panel icon in the notifica-
tion area of the taskbar (as
below).

FigureC- 10

Intel® HD Graphics
Control Panel
Options -
Information Center
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FigureC- 11
Intel® HD Graphics
Control Panel -
Video
(Color
Enhancement)

Video

The Video Profiles menu allows you to brighten or darken movies, or to switch to
vivid colors. The Preview image will display a sample image using the current set-
tings. You can Save Profile and name the Profile to recall the settings at any time.
Click Apply to save changes (select Color Enhancement, | mage Enhancement,
Image Scaling or Gamut M apping from the menu).
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Click the Video menu at the top of the screen to display the sub-menus.The Image
Enhancement menu allows you to adjust the Sharpness, Skin Tone Enhance-
ment, Noise Reduction, Contrast Enhancement and Film M ode Detection etc.
Click Apply to save changes.

FigureC - 12
Intel® HD Graphics
Control Panel -
Video
(Image
Enhancement
Basic)
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Turn Image Scaling on, and use the sliders to adjust the scaling.

FigureC- 13
Intel® HD Graphics
Control Panel Video

Image Scaling
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Power

There are two separate menus to adjust the power settings for whenever the comput-
er isPlugged In or On Battery. Maximum Battery Life will reduce graphics per-
formance for power saving, Balanced will provide full graphics performance when
required and minimize power consumption when inactive, and Maximum Perfor -
mance will give top graphics performance but requires more power.

FigureC- 14
Intel® HD Graphics
Control Panel -
Power

.|
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Display Devices & Options

Note that you can use external displays connected to the HDMI-Out port and/or ex-
ternal monitor port. See your display device manual to see which formats are sup-
ported.

4
Attaching Displays

When you first attach an external display you may find that the desktop does not occupy
the full screen area. Use either the display’s auto adjust/configure controls, or the Intel(R)
HD Graphics Control Panel to configure the full screen display.

Display Mode Description
Single Display One of the connected displays is used as the display device (PC
screen only or Second screen only).
TableC-1 _ _ _
C Display Modes Clone/Duplicate _Both connected displays output the same view and may be configured
independently

Extended / Extend B‘_oth connected displays are treated as separate devices, and act as a
virtual desktop

A number of connected displays are combined into a single

Collage o : : .
9 unified higher resolution for larger screen sizes
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Attaching Other Displays

. e
To Clone Displays: _ .
; ) ; ; Multiple Display

1. Attach your external display to the HDMI-Out port/external monitor port, and turn it on.
2. Go to the Intel(R) HD Graphics Control Panel control panel and click Display >

Multiple Displays (sub-menu). play must be attached in
3. Click Clone from the Select Display Mode menu. order to view Multiple
4. Click Apply, and OK to confirm the settings change. Display selection op-
5. Select the displays from the Select One or More Active Displays menu. tions.

At least one other dis-

FigureC- 15
Display > Multiple
Displays (Clone)
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4

Display Settings
Extended Desktop

You can have different
Colors, Screen Area
and Monitor Refresh
Rates for each display
device provided your
monitor can support
them.

You can drag the moni-
tor icons to match the
physical layout of your
displays. Icons and pro-
grams may also be
dragged between the
displays.

FigureC - 16
Display > Multiple
Displays (Extended)

To Enable Extended Mode;:

Attach your external display to the HDMI-Out port/external monitor port, and turn it on.
Go to the Intel(R) HD Graphics Control Panel control panel and click Display >

1.
2.

Multiple Displays (sub-menu).
Click Extended from the Select Display Mode menu.
Click Apply, and OK to confirm the settings change.

Click the appropri-
ate monitor icon
and drag it to match
the physica ar-
rangement you
wish to use (e.g. the
secondary display
may be extended
left/right/above/be-
low the primary dis-
play).
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To Enable Collage Mode:

1. Attach your external displays to the external monitor port and HDMI-Out port, and turn 4
them on.
2. Go to the Intel(R) HD Graphics Control Panel control panel and click Display > Collage Mode
Multiple Displays (sub-menu). Collage mode is used to
3. Click Collage from the Select Display Mode menu. combine a number of
4. Click Enable. displays into a single
5. Click Vertically or Horizontally to arrange and displays as required. unified higher resolution
6. Click Apply, and OK to confirm the settings change. for larger screen sizes,.

FigureC- 17
Display > Multiple
Displays (Collage)
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4

Windows Logo Key
= + P Key
Combination

You can use the 58 + P
key combination to
quickly bring up the Sec-
ond Screen menu.

You can also use the
Display Switch button
in the Control Center to
access the menu and
select the appropriate
attached display mode.

You can also use the Fn
+F7 key combination to
quickly access the Sec-
ond Screen menu in
Windows.

FigureC- 18
Second Screen
(Devices)

Attaching Other Displays - Devices (Charms Bar)

Y ou can configure attached displays from Devices (in the Charms Bar).

Attach your external display to the HDMI-Out port/external monitor port, and turn it on.
Go the Charms Bar, select Devices.

Click Project (you may need to click Second Screen).

Click on any one of the options from the menu to select PC screen only,
Duplicate, Extend or Second screen only.

PR
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Configuring an External Display In Windows

1.

2.
3.
4

Attach your external display to the HDMI-Out port/external monitor port, and turn it on.
Go to the Screen resolution control panel (see page 1 - 30) in the Desktop app.
Click the Detect button.

The computer will then detect any attached displays.

FigureC - 19
Screen Resolution
Multiple Displays

Attaching Other Displays - Devices (Charms Bar) C - 21



Video Driver Controls

5. You can configure the displays from the Multiple Displays menu.

FigureC- 20
Screen Resolution
Multiple Display
Options

» Duplicate these displays - Shows an exact copy of the main display desktop on

the other display(s)
» Extend these displays - Treats both connected displays as separ ate devices
» Show desktop only on 1/2 - Only one of your displaysis used.

.|
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HDMI Audio Configuration

HDMI (High-Definition Multimedia I nterface) carries both audio and video signals.
In some cases it will be necessary to go to the Sound control panel and manually
configure the HDMI audio output as per the instructions below.

1.
2.
3.

Go to the Control Panel.

Click Sound (Hardware and Sound) and click Playback (tab)

Depending on your display, the playback device may be selected, however in some
cases you may need to select the audio device and click Set Default (button).
Double-click the device to access the control panel tabs illustrated overleaf.

4

Volume Adjustment

The sound volume level
can be set using the vol-
ume control in the Set-
tings menu in the
Charms Bar.

FigureC- 21
Sound - HDMI
Device (set Default)
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FigureC - 22
HDMI Device
Properties

5.
6.

Adjust the HDMI settings from the control panel tabs.
Click OK to close the Sound control panel.
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HDMI Notes
» Connect adevice with HDMI support to the HDMI-Out port BEFORE attempt- A
ing to play audio/video sources through the _device. Other Applications
*To play audio sources through your external display’s (TV or LCD) speakers you . .
will need to go to the audio configuration control panel on the display and con- If you are using a third

party application to play
DVDs etc. from any at-
tached DVD device,
you will need to consult

figure the audio input accordingly (see your display device manual).

HDMI Video Configuration

1. Connect an HDMI cable from the HDMI-Out porlt to your extgrnal display. the application’s docu-
2. Configure your external display as per the instructions in “Attaching Other mentation to see the
Displays” on page C - 17. appropriate audio con-
3. Set up your external display (TV or LCD) for HDMI input (see your display device figuration (the applica-
manual). tion must support digital
4. You can now play video/audio sources through your external display. to analog translation).

.|
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Appendix D: Specifications
e

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your distributor/supplier for details.

.|
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Specifications

Intel® Core™ i7-5500U (2.4GHz)
4M L3 Cache, 14nm (14 Nanometer),
DDR3L-1600MHz, TDP 15W

Intel® Core™ i5-5200U (2.2GHz)
3M L3 Cache, 14nm (14 Nanometer),
DDR3L-1600MHz, TDP 15W

Intel® Core™ i3-5010U (2.1GHz)
3M L3 Cache, 14nm (14 Nanometer),
DDR3L-1600MHz, TDP 15W

Intel® Core™ i3-5005U (2.0GHz)
3M L3 Cache, 14nm (14 Nanometer),
DDR3L-1600MHz, TDP 15W

Intel® Pentium® 3805U (1.9GHz)
2M L3 Smart Cache, 22nm (22
Nanometer), DDR3L-1600MHz, TDP 15W

Intel® Celeron® 3755U (1.70GHz)
2M L3 Smart Cache, 22nm (22
Nanometer), DDR3L-1600MHz, TDP 15W

Intel® Celeron® 3205U (1.70GHz)
2M L3 SmartCache, 22nm (22
Nanometer), DDR3L-1600MHz, TDP 15W

For Model A Only:

14.0"/ 35.56cm HD (1366 * 768), HD+
(1600 * 900) 16:9 3.6mm or 3.0mm Thick
Backlit Panel

For Model A Design | Only:
Multi Touch Screen

For Model B Only:

15.6"/ 39.62cm HD (1366 * 768), FHD
(1920 * 1080), 16:9 3.8mm Thick Backlit
Panel

Dual Channel DDR3L

Two 204 Pin SO-DIMM Sockets
Supporting DDR3L 1600 MHz Memory
Modules (real operational frequency
depends on the FSB of the processor)
Memory Expandable up to 16GB
Compatible with 2GB, 4GB or 8GB Modules

Intel® HD Graphics 5000

(Integrated with i7-5500U / i5-5200U/ i3-
5010U/ i3-5005U CPUSs)

Dynamic Frequency

Intel Dynamic Video Memory Technology
up to 1.7MB

Microsoft DirectX®11.1 Compatible

Intel® HD Graphics

(Integrated with Pentium® 3805U /
Celeron® 3755U/ Celeron® 3205U
CPUs)

Dynamic Frequency

Intel Dynamic Video Memory Technology
up to 1.7MB

Microsoft DirectX®11.1 Compatible

For All Models:

One Changeable 9.5mm(h) Super Multi/
Blu-ray Combo Optical Device Drive with
SATA Interface (Factory Option)

One Changeable 2.5" / 7.0 mm (h) HDD/
SSD with SATA (Serial) Interface

See over
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MSATA SSD (Solid State Drive) with
SATA (Serial) Interface (Factory Option
for computers with i7-5500U, i5-5200U
& i3-5010U CPUs)

For Model A Only:
Dummy Optical Device Drive (Factory
Option)

For Model B Only:

Dummy Optical Device Drive (Factory
Option) or Caddy Bay for 2.5" / 7.0mm (h)
HDD / SDD (Factory Option)

High Definition Audio Interface
Built-In Microphone
2 * Built-In Speakers

Built-in TouchPad with Multi-Gesture and
Scrolling Functionality

Eor Model A:
A4 Size Isolated Keyboard

EFor Model B:
Full Size Isolated Winkey Keyboard with
Numeric Keypad

For Model A:
One USB 2.0 Port

For Model B:
Two USB 2.0 Ports

Specifications

For All Model CPUs:
Two Mini-Card Slots:

Slot 1 for Half Size Mini-Card WLAN
Combo Module with PCle & USB Interfaces

Two USB 3.0 Ports

One External Monitor Port

One HDMI-Out (High-Definition
Multimedia Interface) Port (with HDCP)
One Headphone-Out Jack

One Microphone-In Jack

One RJ-45 LAN Jack

One DC-In Jack

Embedded Multi-In-1 Card Reader

- MMC/ RS MMC

- SD/ Mini SD / SDHC/ SDXC

- MS/ MS Pro/ MS Duo

Note: Some of these cards require PC
adapters that are usually supplied with
the cards.

For i7-5500U / i5-5200U/ i3-5010U CPUs:
Slot 2 for Full Size Mini-Card mSATA
SSD with SATA Interface

OR

Slot 2 for LTE or UTMS/HSPA (3G/4G)
Module + Mini-Card interface adapter for
M.2 3042 Card with USB interface
(Factory Option)

For i3-5005U, Pentium® 3805U /
Celeron® 3755U/ Celeron® 3205U CPUs:
Slot 2 for LTE or UTMS/HSPA (3G/4G)
Module + Mini-Card interface adapter for
M.2 3042 Card with USB interface
(Factory Option)
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Built-In 10/100/2000Mb Base-TX
Ethernet LAN

Intel® Wireless-N 7260 (2*2 802.11 b/g/n)
Half Mini-Card PCle WLAN + Bluetooth
Combo Module (Factory Option)

Intel® Dual Band Wireless-AC 3160
(1*1 802.11 a/c) Half Mini-Card WLAN +
Bluetooth Combo Module (Factory Option)

(802.11b/g/n) Half Mini-Card WLAN +
Bluetooth V4.0+LE Combo Module
(Factory Option)

(802.11b/g/n) Half Mini-Card WLAN
Module (Factory Option)

3G UTMS/HSPA+ M.2 3042 Card Module
(Factory Option)

OR

4G LTE M.2 3042 Card Module (Factory
Option)

For Model A:

300K / 1.0M HD Video Camera Module
with USB interface (Factory Option)

For Model B:

1.0M HD Video Camera Module with
USB interface (Factory Option)

Supports Wake on LAN

Supports Wake on USB

Supports Wake on RTC Alarm (AC Mode
Only

For All Models:

Full Range AC/DC Adapter
AC input 100 - 240V, 50 - 60Hz,
DC Output 19V, 2.1A (40 Watts)

Eor Model A:

Removable 6 Cell Smart Lithium lon
Battery Pack 48WH

OR

Removable 4 Cell Smart Lithium lon
Battery Pack 44WH (Factory Option)
OR

Removable 4 Cell Smart Lithium lon
Battery Pack 32WH (Factory Option)

For Model B:

Removable 4 Cell Smart Lithium-lon
Battery Pack 32WH

OR

Removable 4 Cell Smart Lithium-lon
Battery Pack 44WH

Security (Kensington® Type) Lock Slot
BIOS Password

Trusted Platform Module 2.0 (Factory
Option)

Painted Style (For some Model designs)
IMR (Injected Molded Resin) LCD Back
Covers (For some Model A Designs)
Intel® Smart Connect Technology
Shipping Mode

Windows® 8.1 (64-bit)

LED Indicators - Power/Suspend, Battery,
HDD/ODD, Airplane Mode, Camera
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One 64Mb SPI Flash ROM
AMI BIOS

Temperature
Operating: 5°C - 35°C
Non-Operating: -20°C - 60°C

Relative Humidity
Operating:
Non-Operating:

20% - 80%
10% - 90%

For Model A Only:

340mm(w) * 242mm(d) * 26.5mm(h)
(Height excluding battery area)

2.15 kg *Barebone System with 32WH
Battery & ODD

For Model A Design Il (with Touch
Screen):

340mm(w) * 242mm(d) * 28mm(h)
(Height excluding battery area)
2.35kg *Barebone System with 32WH
Battery & ODD

For Model B:

374mm (w) * 258.5mm (d) * 12 - 24.7mm (h)
2.1kg *Barebone System with 32WH
Battery and ODD

*A barebone system does not include the HDD,
RAM, adapter, power cord and factory option
modules (weight tolerance within +/- 5%).

Specifications
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